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IINNTTRROODDUUCCTTIIOONN  

 

A Brief History of Automotive Emissions Controls 

In 1960, the California Motor Vehicle Pollution Control Board is established. Its primary function 
is to test and certify devices for installation on cars for sale in California. Also in 1960, the US 
Federal Motor Vehicle Act of 1960 is enacted which requires federal research to address 
pollution from motor vehicles. 

In 1961, the first automotive emissions control technology in the USA, PCV (Positive Crankcase 
Ventilation), is mandated by the California Motor Vehicle State Bureau of Air Sanitation to control 
hydrocarbon crankcase emissions. PCV withdraws blow-by gases from the crankcase and re-burns them 
with the fresh air and fuel mixture in the cylinders. In 1966, auto tailpipe emission standards for 
hydrocarbons and carbon monoxide are adopted by the California Motor Vehicle Pollution Control Board. 
They are the first of their kind in the USA. In addition, the California Highway Patrol begins random 
roadside inspections of vehicle smog control devices. 

In 1967, the California Air Resources Board is created from the merging of the California Motor 
Vehicle Pollution Control Board and the Bureau of Air Sanitation and its Laboratory. Enacting 
legislation is the Mulford-Carrell Air Resources Act, signed into law by governor Ronald Reagan. 
Additionally, the US Federal Air Quality Act of 1967 is enacted, which allows the State of 
California a waiver to set and enforce its own emissions standards for new vehicles based on 
California's unique need for more stringent controls. 

In 1988, the California Clean Air Act is signed by Governor Deukmejian, which sets forth the 
framework for how air quality will be managed in California for the next 20 years. Also in 1988, 
the CARB adopts regulations (OBD II) effective on 1994 model cars requiring that they be 
equipped with on-board computer systems to monitor emission performance and alert owners 
when there is a problem. 

In 1990, the US Clean Air Act Amendments of 1990 are signed into law by President George 
Bush. They rely largely on elements of the California Clean Air Act, and require a number of new 
programs aimed at curbing urban ozone, rural acid rain, stratospheric ozone, toxic air pollutant 
emissions and vehicle emissions, and establishes a new, uniform national permit system. 

Source: www.arb.ca.gov. 

http://www.arb.ca.gov/
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What is EFILive? 

EFILive is a PC based, OBD II Scan Tool and Tuning Tool that has been designed by EFI (Electronic 
Fuel Injection) tuning experts to be used by anyone who needs to diagnose, monitor and tune high 
performance engines.  

The EFILive Scan Tool provides real time logging of critical engine performance data, including, but not 
limited to, RPM, throttle position, spark advance, knock retard, long and short term fuel trims, fuel 
injector pulse widths and duty cycles, commanded air/fuel ratio and oxygen sensor voltages. 

The EFILive Tuning Tool  can edit calibration 
data and save the changes to your PCM 
permanently. Over 180 generic and 
enhanced parameters provide complete 
coverage of the vehicle’s performance data. 
And over 350 PCM (Powertrain Control 
Module) calibrations can be edited. 

Using bidirectional controls, the Scan Tool 
will perform diagnostic checks usually found 
only in expensive OEM (Original Equipment 
Manufacturer) scan tools. The Scan Tool 
can perform the cylinder balance test and 
the crank position sensor relearn. 
Additionally, it can control auxiliary systems 
such as the electric fans, air conditioner, idle 
control, evap canister purge and vent 
solenoids, along with many others. 

For dynamometer use, the Scan Tool can lock the torque converter clutch and hold the automatic 
transmission in any gear. This prevents unwanted and dangerous transmission kick downs when 
performing wide-open throttle dynamometer runs. 

The Scan Tool is also a full featured generic scan tool that will log real time generic data, display and 
clear emissions related trouble codes and display the test results of onboard monitoring systems such as 
O2 monitoring and the system readiness tests. As a generic scan tool, EFILive is compatible with almost 
all GM OBD II vehicles. 
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Fundamentals of GM OBD II EFI Engines: 

Below is a list of the important components for OBD II engine operation: 

 Vehicle Speed Sensor (VSS) 

 RPM Sensor 

 Intake Air Temperature Sensor (IAT) 

 Engine Coolant Temperature Sensor (ECT) 

 Throttle Position Angle Sensor (TPS) 

 Exhaust Gas Oxygen Sensor (HO2S) 

 Manifold Air Flow Sensor (MAF) 

 Manifold Absolute Pressure Sensor (MAP) 

 Barometric Pressure Sensor (BARO) 

 Knock Sensor (optional) (KS) 

 Powertrain Control Module (PCM) 

 Air Injection Reactor (AIR) 

Cold starts 

In the "good old days”, you pulled the choke, pumped the pedal a few times and turned the key. 
Hopefully, the engine cranked, vacuum pulled some fuel from the carburettor, the points opened to send 
a spark through the distributor and the engine sputtered to life. Starting an OBD II car with a cold engine 
begins a completely different process! 

Today's cars have computers that process calibrated data points, called "tables", to control the operation 
of the engine. Different sensors provide real-time data, used by the PCM to decide which table to use 
and when. 

The reason for this computer-controlled system is first to decrease exhaust emissions, second to 
increase fuel economy and finally to increase performance and make servicing the engine simpler, in 
that order. Turning the key “wakes up” the PCM and cranks the starter. After ignition and idle 
stabilization, the engine management system is in a state called open loop. It is called open loop 
because the primary sensors in this system, the oxygen sensors, are not hot enough and will not be 
used by the PCM until they are. In addition, but unrelated to open loop, the catalytic converters (cats) 
need to be very hot to perform their exhaust cleaning function. Open loop uses pre-programmed 
information, based on the specific engine application and provides adequate performance, economy and 
emissions while the engine warms up. The mixture is usually much richer (like the choke in the "old 
days"), both to keep the engine running better and to get the cats hot. 

Most OBD II cars use heated oxygen sensors that have filaments (like a light bulb) to get them hot as 
fast as possible, and an AIR pump to blow extra air in the manifold to burn the extra gasoline to heat the 
cats quickly. Therefore, open loop rarely exceeds a few minutes of operation. In open loop, the PCM 
also uses the MAF, ECT and IAT sensors to determine how much fuel enrichment is needed to keep the 
engine running prior to reaching operating temperature. 

Once the PCM determines that the oxygen sensors are within their operating temperature and other 
conditions have stabilized, it changes mode from open loop (ignoring the oxygen sensors) to closed loop 
(using the oxygen sensors). 

To keep a warm gasoline engine running, requires about 15 parts air to 1 part gasoline. The optimum 
ratio is 14.7 to 1, but this may vary under different operating conditions and the desired performance 
demands of the engine. Restricting fuel creates a LEAN mixture and adding fuel creates a RICH mixture. 
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Fuel injectors 

OBD II engines are fuel injected individually at each cylinder. In order to vary the amount of fuel for 
different RPMs, the duration of the operation of the fuel injectors needs to be precisely controlled. Since 
the fuel pressure is constant (from the pressure created by the fuel pump) and the nozzle in the injector 
is fixed, the only way the PCM can control the amount of fuel is to turn the injector on and off. (Of course 
as the MAP changes, so will the pressure in the cylinder; this information is compensated for.) Fuel 
injectors can be measured by their "duty cycle", which indicates the percentage of time that they are 
injecting fuel. A duty cycle of 50% means that the injector is supplying fuel at 50% of its capacity. To 
keep good control and to prolong the life of the injectors, 80% is the recommended maximum 
sustainable duty cycle. The actual operation of the injector happens EXTREMELY fast, in the order of a 
few milliseconds (thousandths of a second). The duration of this fuel flow is called the injector pulse 
width. 

Short Term Fuel Trim 

With the information from the sensors, the PCM knows the conditions in the engine, how much air is 
flowing and therefore, the desired load to be placed on the engine. But how does the PCM know the 
amount of fuel to inject? This is the main function of the oxygen sensors. The oxygen sensors generate a 
small electric current, with voltage varying from around 0.1 to 0.95 volts. Less voltage indicates a lean 
condition and more voltage indicates a rich condition. They measure the difference between the amount 
of oxygen in the exhaust and the amount of oxygen in the atmosphere. 

Since the PCM knows the amount of air and fuel entering the engine and, from the oxygen sensors, the 
amount of oxygen remaining after combustion, it can determine if the combustion process was rich or 
lean. This is a direct feedback system and enables the PCM to "Close the Loop"! 

Because the feedback from the oxygen sensors can only be applied “after the fact”, it causes the PCM to 
“chase its tail” to achieve the correct combustion. This chase can be observed clearly in the oxygen 
sensors’ output, which under everyday driving conditions looks like a wave. 

 

The combustion process is constantly oscillating between rich and lean. As long as this process 
continues to change from rich to lean in a timely manner, the PCM “knows” that the combustion is within 
acceptable limits. If the oxygen sensor voltage stays high or low for too long, then the PCM adjusts the 
amount of fuel delivered by the injectors. This adjustment is called the Short Term Fuel Trim (STFT) 
correction. 

Long Term Fuel Trim 

The main function of the PCM is to store and maintain calibration tables. Most tables are static, they are 
set in the factory and do not change. The Long Term Fuel Trim (LTFT) correction table is different; it is 
modified by the PCM in response to the changing STFT correction. 

For example, if the oxygen sensor voltage stayed low due to a lean combustion process, then the PCM 
would increase the STFT correction. If the correction does not bring the combustion process into 
acceptable limits then the PCM will increase the STFT correction even further. If that process continues 
and the STFT reaches its pre-determined upper limit, then the PCM records that; the particular 
conditions under which the engine is currently operating, require a longer-term correction to be applied. 
The PCM will then increase the LTFT correction and reset the STFT correction back to zero, and the 
whole process begins again. 
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What happens if the LTFT correction reaches its upper or lower limit? The PCM will set a Diagnostic 
Trouble Code (DTC) to alert the driver that the engine is operating outside of acceptable limits and the 
PCM can no longer compensate. 

The LTFT corrections are stored in a table made up of 23 cells. There are 16 cells for most driving 
conditions, with 7 additional cells for things like WOT (full throttle) and other conditions. Each cell 
contains a LTFT correction for a specific engine operating condition. The LTFT correction is used by the 
PCM to increase or decrease the injector base pulse width in an attempt to keep the combustion process 
at the desired level. 

You may have heard that the PCM “learns”, or “tunes” itself for changing conditions. The LTFT correction 
is the information that the PCM learns and stores. It can also be reset (by disconnecting the vehicle’s 
battery or by using a scan tool), causing the PCM to have to relearn the LTFT corrections. The PCM 
relearns each cell’s value as and when the engine operating conditions require the PCM to use those 
cells. 

Here is how it operates; the following table is an example of a LTFT correction table. 
 

MAP v’s RPM 0-899 900-1399 1400-2199 2200+ 

0-36 kPa (0) 1.5% (1) 1.6% (2) -0.5% (3) -3.0% 

37-56 kPa (4) 2.0% (5) 1.5% (6) 3.7% (7) -1.2% 

57-76 kPa (8) 3.0% (9) 3.6% (10) -2.8% (11) -1.0% 

77+ kPa (12) 2.1% (13) 1.0% (14) -3.8% (15) -2.0% 

The 16 squares represent the LTFT cells, 0 through 15. The PCM knows the RPM and the MAP, 
therefore it can lookup the required cell for the current MAP/RPM engine condition. For example, for an 
engine speed of 1500 RPM and a manifold pressure (MAP) of 50 kPa, the corresponding fuel trim cell 
that the PCM would use is cell# (6). The value contained in cell# (6) is the percentage correction that 
should be applied to the PCM’s base fuel schedule. In this example, the injectors’ base pulse width will 
be increased by 3.7%. 

Spark knock 

As with the fuel tables, for the ignition there are spark tables. (Older cars had weights and springs in the 
distributor to advance the spark timing because as the engine turns faster the spark needs to fire 
sooner.) The spark tables are fixed data points that use all of the above sensors to determine the best 
time to fire the spark plug, to get the most power with the least pollution. 

However, one very important ignition factor must be taken into account – spark knock, and pre-ignition. 
These conditions may be caused by: 

 The spark plugs firing too soon, which could be caused by having too much advance calibrated 
into the spark table(s). 

 Malfunctioning sensors may cause the PCM to incorrectly calculate too much spark advance. 

 Excessive combustion chamber temperatures; a lean fuel mixture will cause high combustion 
temperatures. 

 Bad or low grade fuel. 

 An ignition source other than the spark plug, like carbon build-up in the combustion chamber, 
which may begin to glow and become a source of premature ignition. 
 

 
Pre-ignition is caused by an ignition source other than the spark plug. The PCM 
cannot directly control pre-ignition by retarding the spark advance. 

In these cases there may begin to be spark knock, which can quickly progress to the point of causing 
serious engine damage if not corrected quickly. There are acoustic sensors (microphones) in OBD II 
engines that constantly listen for the beginnings of spark knock and retard the timing (make the spark 
plug fire a little bit later in the cycle). This process is called knock retard. While this reduces power, it 
protects the engine. The PCM is programmed to return to full advance gradually. 
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Adaptive Spark 

Some PCMs can adapt the spark advance for varying octane fuels. In a way, it is sort of like a short-term 
knock retard (called the high-octane adaptive spark), where if the PCM encounters excessive spark 
knock, it presumes a less-than-optimum grade fuel is being used. 

The LS1/LS6 PCM uses a sliding scale to determine the optimum spark advance for the current spark 
knock conditions. Two adaptive spark tables are programmed into the PCM, a high-octane spark table 
that defines the upper bound of the adaptive spark and the low-octane table that defines the lower bound 
of the adaptive spark. The PCM never uses one or the other table exclusively, rather it calculates a blend 
of the two tables based on the high-octane adaptive spark. The higher it’s value, the closer the spark 
advance is to the high-octane spark table. The lower it’s value, the closer the spark advance is to the low 
octane spark table. The PCM increases the high-octane adaptive spark during knock-free operation and 
decreases its value when spark knock is detected. This has the effect of increasing or decreasing the 
overall spark advance based on the short-term spark knock. The adaptive spark usually recovers to 
100% within a few minutes once the spark knock is eliminated. 

Those familiar with LS1/LS6 tuning may be familiar with the "low octane spark table" and may have 
heard that if the PCM “drops down” to the low octane spark table that it can be "reset" by adding fuel or 
restarting the car. That is not the case. What most people observe is this, a tank full of low-octane gas 
can cause significant spark knock, causing the high-octane adaptive spark to move towards the low 
octane spark table. Once the tank is filled with high-octane fuel, the knock is eliminated and the PCM 
rapidly moves the high-octane adaptive spark back to 100%. 

Modifications 

All of this should work correctly for many hundreds of thousands of miles, as long as you don't choke off 
the air, plug an injector, foul an oxygen sensor or have any other set of abnormal conditions. The system 
is also designed to compensate for normal wear and different driving conditions. However, if you add a 
turbo, change the camshaft, remove the cats (for off road use only), use a larger MAF, add nitrous, or 
make other significant modifications, outside the ability of the PCM to compensate, you would have a 
very unhappy car! This is where one must actually reprogram the PCM, changing the calibrations of the 
fuel, spark and other miscellaneous tables. The EFILive Tuning Tool can accomplish this. 

Additional note about “cheating” an Emissions Test 

Another interesting aspect of OBD II (actually the reason it exists) is its use in testing the emissions 
(pollution) produced by the automobile. The MIL is an all too familiar sign of problems in the system. If it 
is illuminated the car will fail an OBD II emissions test. Knowing that most scan tools can turn off this 
indicator, people have wondered if this can be used to "cheat" and get through the emission test. One 
reason why you can't do this (or just pull the PCM fuse) is that emissions testing stations not only check 
the MIL, but also the System Readiness Tests’ status. Multiple drive cycles may be needed to get all 
supported System Readiness Tests to indicate “Ready”. By then any MIL illuminating condition will have 
reappeared. Also any modifications that cause the MIL to illuminate, even if technically there is no fault in 
the system, will cause an immediate failure. 
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What is OBD II? 

Adopted by CARB (California Air Resources Board) in 1985 for 1988 and later vehicles, OBD I (On 
Board Diagnostics, Generation 1) was designed to monitor emissions related components and alert 
owners to failures. 

OBD I suffered from a number of problems: 

 It may not have detected components that contributed towards increased emissions until the 
component had failed. 

 Some emissions related systems were not being monitored. 

 Nearly all manufacturers implemented it differently. 

 Trouble codes were non-standard. 

 Scan tool support was proprietary; workshops had to purchase multiple and usually incompatible 
scan tools. 

In 1988 CARB adopted OBD II (On Board Diagnostics, Generation 2) for some 1994 and 1995 vehicles, 
and for all 1996 and newer vehicles. 

Some of the goals of OBD II are to: 

 Reduce emissions due to early and reliable detection of component or system malfunction. 

 Monitor all emissions related components and systems. 

 Enforce more stringent performance criteria for determining component or system malfunctions. 

 Use a MIL (Malfunction Indicator Lamp) to alert the driver to any detected emissions related 
failure. 

 Standardize DTCs (Diagnostic Trouble Codes) and freeze frame data, to assist the service 
technician in faultfinding and repair. 

 Provide standardized, real-time engine data. 

 Detect malfunctions before emissions exceed 1.5x the legislated limits. 

 Detect malfunctions within 1 or 2 driving cycles. 

In the United States, vehicle manufacturers are required to provide an 8 year or 80,000 mile warranty on 
the catalytic converter and PCM (Powertrain Control Module), and a 2 year or 24,000 mile warranty on 
other emissions control components. 

Additionally, if your state or local jurisdiction requires an EPA-approved Vehicle Inspection and 
Maintenance program (I/M), you may be eligible for a GM Performance Warranty, presuming the 
following three conditions are met (see your Owner’s Manual for additional details): 

1. Vehicle has been properly maintained in accordance with OEM maintenance schedule.  
2. Vehicle fails an EPA approved I/M test under the emission warranty period.  
3. Failure results, or will result, in vehicle owner having to bear penalty or sanctions under local, 

state or federal laws.  

This warranty includes a list of parts and includes non-GM parts as long as they are labelled "Certified to 
EPA Standards". 
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OBD II Standards 

The OBD II specification is made up of many standards, most of which are published by the SAE. 

EFILive meets the SAE J1850 VPW, J1978, J1979 and J2012 standards for scan tools. 
EFILive meets the SAE J2190 standard as implemented in GM’s PCMs. 
 

 
For GM’s LS1/LS6 engine management system, EFILive also supports: 

 Enhanced (manufacturer specific) parameters.  

 Bidirectional controls.  

 EFILive specific DMA (Direct Memory Access) parameters.  
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Conventions used in this document 

 
Potential danger 

  
 

 
Important information 

  
 

 
Helpful information 

  
 

 
Menu choices, for example File->Properties 

  
 

A->B A series of actions that should be followed. 
  

 

 
Keyboard shortcuts, for example Alt+Enter 

  
 

[ ] Toolbar icon – image will be the actual toolbar icon. 

  
 

[Name] Name is the caption on a user interface item such as a button or a tab page. 
  

 
$01…$FF Hexadecimal values are displayed, prefixed with a $ symbol. Hexadecimal 

values belong to the base-16 number system. They are commonly used to 
display values from digital computer systems. 

  
 

<install_folder> This means the folder in which you installed EFILive. If you installed EFILive in 
the default folder on C drive then it will be C:\Program Files\EFILive\V7. 

  
 

<data_folder> This means the folder named My Documents\EFILive\V7. 
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Contacting EFILive Support 

Before reporting any problem that you may experience with EFILive, make sure you are using the latest 
version. To determine which version of EFILive you are using, select the following menu option: 
 

 
Help->About 

The latest version may be downloaded from EFILive’s web site www.efilive.com/downloads. If you are 
running the latest version and are still having difficulty, then please contact us at support@efilive.com 

Please include the following information: 

 An email address where you may be contacted. 

 The error report that was displayed by the Scan Tool. If no error report was displayed, please 
manually generate a report – see below for instructions on manually producing an error report. 

 For the most recently connected vehicle: 
o Model year (i.e. 2002). 
o Model (i.e. Corvette). 
o Engine type (i.e. LS1). 

 The type of interface cable being used. 

 The type of USB to serial converter (if one is required). 

 A brief description of the problem. 

 The actions required to reproduce the problem. 

 Any other information that you believe may be helpful. 
 

 
EFILive’s Scan and Tuning Tool is officially supported for use on engines and 
transmissions listed on our web site here: 

 http://www.efilive.com/supvehicle 

However, please send any issues that you may have with non-supported GM engines. 
There is no guarantee that we can resolve those issues, but we may be able to offer 
some assistance. 

How to manually produce an error report. 
 

 
File->Generate error report 

  

 
Ctrl+G 

1. Click on the [Copy] button. (Or click on the [Save] button to save the error report in a text file so 
that you can copy the file to another computer that has email access.) 

2. Paste the error report into an email (Ctrl-V) and send to support@efilive.com along with the other 
information. 

The EFILive Users’ Forum 

EFILive provides a moderated forum where you can post questions or comments for other EFILive 
users. The EFILive user community has many qualified and experienced scan tool users. 
You can browse the forum here: http://forum.efilive.com/ without registering. 
If you want to post a question or comment then you must register. Registration is free.

http://www.efilive.com/downloads
mailto:support@efilive.com
mailto:support@efilive.com
http://forum.efilive.com/
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RREEQQUUIIRREEMMEENNTTSS  

PC/Laptop 

Configuration Recommended Minimum
1 

CPU type Pentium class CPU (Includes 
AMD and Cyrix) 

Pentium class CPU (Includes 
AMD and Cyrix) 

CPU speed 800MHz or faster 500MHz 

Free
2
 memory 64Mb or more 32Mb 

Free
3
 hard disk space 100Mb or more 100Mb 

I/O port
4
 2 x USB 1.1 or 2.0 USB 1.1 

Pointing device Mouse, trackball, touch pad, etc. 

Keyboard Standard PC keyboard 

Screen Standard PC Screen 

Operating System Win2K, WinXP Win98, WinMe 

 
1
 PC configurations that are below the recommended configuration may not support the full features of 

EFILive. For example, a 230MHz Pentium may not be able to update all the gauges on the default 
dashboard while logging real time data at 10 frames per second. In such cases you can reconfigure 
EFILive, see Appendix-G How to optimize data logging. 

2
 Free memory means memory that is not already in use by Windows. 

3
 Free hard disk space means space that is not already in use by Windows. 

4
 Two USB ports are only required if you are upgrading from FlashScan V1 to FlashScan V2, otherwise 

only one USB port is required. 
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Tutorials 

EFILive Tutorials are available via the Help menu in both the Scan Tool; and Tuning Tool Software 
packages. 

 

 
Help->Tutorials 

Most tutorials are Adobe PDF documents and can be found in the folder: 
\Program Files\EFILive\V7\Docs\Tutorials 
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OBD II cable 

Cable type Support 
AutoTap AT1 V2.x Scan Tool only. 

AutoTap AT123 V2.x Scan Tool only. 

AutoTap ATU Scan Tool only. 

EFILive FlashScan V1 Scan Tool and Tuning Tool. 

EFILive FlashScan V2 Scan Tool and Tuning Tool. 

AutoTap, AT1, AT123, ATU and VIA are products of B&B Electronics Mfg Co. 
www.autotap.com 
www.vehicleinterface.com 
 

http://www.autotap.com/
http://www.vehicleinterface.com/
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Vehicle 

Vehicle/Powertrain Features 
GM LS1/LS2 
and compatible controllers  
 
Duramax LB7/LLY controllers 
 
Allison transmission controllers 
 

 Display and clear diagnostic trouble codes 

 EPA test results 

 Generic PIDs 

 Enhanced PIDs 

 DMA PIDs 

 Bidirectional controls 

 Learned fuel trim cells 

 Miscellaneous calibration data 

 Scan modes: 
o General 
o Dynamic 
o Stream-Slow 
o Stream-Fast 

 

GM Custom 
SAE J1850 VPW 

EFILive provides user level configuration files that may be 
edited, so that EFILive can log most OBD II compliant GM 
vehicle’s enhanced parameters. 

If you know the vehicle’s enhanced parameters’ PID 
numbers and SLOT details, then you can create a 
configuration to support that GM vehicle. 
 

Ford Not supported. 
 
 

DaimlerChrysler Not supported. 
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SSEETTUUPP  GGUUIIDDEE  

Connecting and starting 

Location of the OBD II connector 

The OBD II connector is located in the passenger compartment within reach of a technician seated in the 
driver’s seat. 
Access to the connector does not require any special tools for the removal of any instrument panel 
cover, connector cover or any barriers that may be obscuring the connector. 

 

 

 

 
Left hand drive Right hand drive 

Connecting your FlashScan V2 USB interface cable 

If your computer is fitted with a USB port, connect the FlashScan interface cable as shown in this 
diagram.  

If your computer is not fitted with a USB port then you cannot use that computer with a FlashScan 
interface cable. 

 

 

WARNING 

The RJ45 connector used on FlashScan’s OBDII cable is 
the same size as a standard network cable plug. Never 
connect the OBDII cable directly to your computer’s 
network socket. You will almost certainly damage your 
PC’s network connection. 

And never connect FlashScan directly to a network 
cable, you may damage the FlashScan interface. 
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Connecting your FlashScan V2 interface for black-box logging 

To record data directly to your FlashScan interface, connect it to your vehicle like this. 

 

 

 
The initial release of FlashScan V2 does not support black box logging. Black box logging 
will be made available free of charge via Internet download, when it is available for 
FlashScan V2. 

 



EFILive V7 Scan Tool for GM Vehicles 

support@efilive.com - 25 - www.efilive.com 

Connecting your FlashScan V1 USB interface cable 

If your computer is fitted with a USB port, connect the FlashScan interface cable as shown in this 
diagram. 

 

If your computer is not fitted with a USB port then you cannot use that computer with a FlashScan 
interface cable. 

Connecting your FlashScan V1 interface for black-box logging 

To record data directly to your FlashScan interface, connect it to your vehicle like this. 
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Connecting your AutoTap USB interface cable 

If your computer is fitted with a USB port, connect the interface cable as shown in this diagram. 

 

If your computer is not fitted with a USB port then you should use one of the serial (9-pin RS232) 
interface cables shown below. 

 

Connecting your AutoTap serial (9-pin RS232) interface cable 

If your computer is fitted with a standard 9-pin RS232 serial COM port then connect the interface cables 
as shown in this diagram. 

 

 

 
Never connect the OBD II cable directly to your computer’s RS232 serial COM port. 
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Using a USB to RS232 Serial converter 

If, like most modern Pentium laptops, your computer is not fitted with a standard 9-pin RS232 serial 
COM port, you will require an additional USB (Universal Serial Bus) to RS232 serial converter cable. 
 

 
A USB to serial converter will not work with EFILive FlashScan. FlashScan draws it’s 
operating power from the USB connection. Apart from the protocol complexities, serial 
ports do not provide power to operate the FlashScan unit. 

Select your USB converter cable carefully. Note that some converters are better then others. EFILive 
recommends the Edgeport USB to serial converter cables. 

 

 

 
Never connect the OBD II cable directly to the USB to serial converter. 

 

 
If the OBD II interface is left connected to the OBD II connector for a significant length of 
time (i.e. overnight), the OBD II interface may drain the battery, even if it is not connected 
to a laptop or being used by EFILive. 

We recommend unplugging the OBD II interface when not in use for extended periods. 
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Starting the EFILive Scan Tool 

The Scan Tool can be used in two modes: 

1. Connected – when a connection exists to an OBD II vehicle. 
2. Disconnected  - when no connection exists to an OBD II vehicle. 

When the Scan Tool is disconnected, functions that require a connection are disabled. 

We recommend that the first time you use the Scan Tool you should make at least one successful 
connection to the OBD II vehicle. That way the Scan Tool can gather information about the vehicle, 
including the VIN, which parameters are supported, and which onboard modules are available. The 
information will be saved and used by the Scan Tool if and when you choose to use it when not 
connected to a vehicle. 

There are three simple ways to start the Scan Tool: 

 Double click on the EFILive Scan Tool icon on the Windows desktop that looks like this: 
 

 
 

 Click on Windows Start button, then select: Programs->EFILiveV7->Scan Tool 
 

 Double click on any *.efi (logged data file). 
The Scan Tool will start automatically, and display the selected log file. 
 

 
You may start multiple instances of the Scan Tool. Additionally, you may even load the 
same log file into different windows. 

  

 
We recommend starting only one copy of the Scan Tool when also using the EFILive 
Tuning Tool with data being linked between them. You may have multiple instances of the 
Tuning Tool open and they will all link to the single instance of the Scan Tool. 

  

 
You cannot have multiple instances of the Scan Tool connected to a vehicle at the same 
time via the same interface cable. 
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Starting the Scan Tool for the first time 

The first time you run the Scan Tool you will see the following message. 

 

The Scan Tool needs to know at least the first 4 characters of the vehicle’s VIN so that it can load the 
appropriate set of enhanced PIDs. Because no connection has yet been made to the vehicle, you should 
supply the VIN or select the platform that best matches your vehicle. 

When you make a connection to a vehicle, that vehicle’s VIN will replace the Operating system and VIN 
that you may have selected. The Scan Tool will remember the last used Operating system and VIN and 
will use them the next time it is started. 

To properly configure the transmission PIDs, the Scan Tool also needs to know if the vehicle has an 
automatic or manual transmission, select Automatic or Manual as appropriate. 

EFILive uses the engine displacement and vehicle weight when evaluating calculated PIDs such as 
{CALC.POWER_RW} “Rear Wheel Horsepower”. Those PIDs will only be as accurate as the information 
entered here. 
 

 
Each time you save a log file, these settings are embedded into the log file. If you change 
any of these settings, you must re-save the log file, which embeds the new values into the 
log file. 
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To connect to the vehicle 

 
File->Connect 

[ ] Connect 

 
Ctrl+F3 

Registering the interface for use with EFILive 

When EFILive connects to a vehicle the interface is checked to determine if it is registered. If the 
interface is not registered, EFILive will ask you if you want to register the interface. 

 

You may choose not to register the interface, but you cannot log or monitor data, nor use bidirectional 
controls with an unregistered interface. 
 

 
If you are using a FlashScan interface cable, registration is not required while it is 
connected to the PC. However, until you successfully register your FlashScan cable, the 
Tuning Tool (not the Scan Tool) will default to “Demo Mode” with limited access to most 
calibrations, if the FlashScan cable is not connected. 

See page 56 for instructions on how to register your interface for use with EFILive. 
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To start monitoring data 

[ ] Start monitoring data 

 
Ctrl+M 

To start recording data 

[ ] Start recording data 

 
F3 

All logged data will be displayed in the [Data (F9)] tab page. It shows each PID’s current, minimum, 
maximum and average values. 

Some PIDs will be displayed in the [Dashboard (F10) - A] virtual dashboard as analog or digital gauges. 

Some PIDs will be charted in the [Dashboard (F10) - B] virtual dashboard on charts. 

By default, no data is displayed in the [Dashboard (F10) - C] virtual dashboard. That is a “scratch” area 
for you to “try out” different gauge and chart settings so you don’t have to disturb the default virtual 
dashboards. 

To pause logging 

[ ] Pause data 

 
Ctrl+Space 

  

 
If, while data logging, the cables are disconnected or the ignition is switched off, the 
Scan Tool will pause data logging. When the cables are reconnected or the ignition is 
switched back on, it will reinitialise the connection to the vehicle and continue data 
logging. 

  

 
Disconnecting the FlashScan cable from the PC while data logging may cause the USB 
subsystem to terminate the USB connection. The Scan Tool may not be able to recover 
when the FlashScan interface is reconnected. In that case, you will need to re-establish 
the connection and restart data logging. 

During data logging, the pause button toggles the Scan Tool from Record mode to Monitor mode each 
time it is pressed. 

During playback the pause button will pause or resume playback. 

To stop logging 

[ ] Stop data 

 
F4 
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To disconnect from vehicle 

 
File->Disconnect 

[ ] Disconnect 

 
Ctrl+F4 

  

 
If the link between EFILive and the vehicle is not disconnected properly, the interface 
cable may continue to communicate with the PCM via the class 2 data bus, even when 
the ignition is switched off. 

To exit from the Scan Tool  

 
File->Exit 

 
Alt+F4 

Exiting from the Scan Tool while data logging is active will terminate data logging. 
 

 
If, while data logging, the Scan Tool is terminated incorrectly (for example: a power 
failure) then the currently recording log file can usually be recovered, see Appendix-D. 

Exiting from the Scan Tool while bidirectional controls are active will terminate bidirectional controls and 
return the vehicle’s PCM to its default calibrations. 
 

 
If, while using bidirectional controls, the Scan Tool is terminated incorrectly (for example: 
a power failure) the bidirectional controls will not be released until the interface cable is 
disconnected from the vehicle or the vehicle’s ignition is switched off. 
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HHOOTTKKEEYYSS  QQUUIICCKK  RREEFFEERREENNCCEE  

Main Display Hotkeys 

Hotkey Description 
  

F1 Help 

F2 Keyboard only inspect 

F3 Start data logging 

F4 Hide and disable the Control Panel if it is visible, 
Otherwise, stop data logging. 

F5 Show and activate the LS1 control panel 

F6 Show and activate the Allison control panel 

F7 Show onboard information window [OBD II (F7)] tab page. 

F8 Show PID selection table [PIDs (F8)] tab page. 

F9 Show parameter table [Data (F9)] tab page. 

F10 Show virtual dashboard [Dashboard (F10)] tab page 

F11 Show maps [Maps (F11)] tab page 

F12 Show console window [Console (F12)] tab page 

  

Shift+F1 Retrieve all test results 

Shift+F2 Validate PIDs 

Shift+F3 Validate Modules 

Shift+F4 PCM info 

Shift+F5 System readiness tests results 

Shift+F6 Specifically monitored systems tests results 

Shift+F7 O2 sensors tests results 

Shift+F8 Diagnostic trouble codes 

Shift+F9 History freeze frame data 

Shift+F10 Clear emissions related trouble codes 

Shift+F11 Clear trouble codes for all modules 

Shift+F12 Not used 

  

Shift+Ctrl+F1 Display miscellaneous calibration information 

Shift+ Ctrl+F2 Display long term fuel trim cells 

Shift+ Ctrl+F3 Display auto transmission adaptive shift cells 

Shift+ Ctrl+F4 Display Allison transmission adaptive shift cells 

Shift+ Ctrl+F5  

Shift+ Ctrl+F6 Display Idle air control panel 

Shift+ Ctrl+F7 Display cylinder balance test 

Shift+ Ctrl+F8 Display CKP Learn (Crank position sensor error learning) 

Shift+ Ctrl+F9 Change VIN 

Shift+ Ctrl+F10 Oil life reset 

Shift+ Ctrl+F11  

Shift+ Ctrl+F12  
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Main Display Hotkeys (cont’d) 

Hotkey Description 
  

Ctrl+A Select all data in current control 

Ctrl+C Copy selected text to clipboard 

Ctrl+D Edit vehicle/customer details 

Ctrl+E Export logged data to *.csv (Microsoft Excel format) 

Ctrl+F Resize dashboard to fit current screen 

Ctrl+G Generate error report 

Ctrl+I Display/Edit log file info and comments 

  

Ctrl+N New log file 

Ctrl+O Open existing log file 

Ctrl+P Print 

Ctrl+Alt+P Print all 

Ctrl+S Save log file 

Ctrl+T Save console text 

Ctrl+V Paste text from clipboard to current edit box 

Ctrl+X Cut selected text 

Ctrl+Y Show profile window 

Ctrl+Z Undo last change to the current edit box 

Ctrl+Ins Display Windows Notepad 

  

Alt+F4 Exit the Scan Tool 

Alt+Enter Open the Scan Tool properties editor 

Ctrl+Enter Open the Map properties editor 

Ctrl+Alt+C Enter new Controller type 

Ctrl+Alt+V Enter new VIN and other vehicle information 

  

Ctrl+Alt+Enter Edit data filter settings and select current filter 

Ctrl+Alt+F Apply/remove currently selected data filter 

  

Ctrl+Alt+Q Re-order PIDs on the [Data (F9)] tab page in custom order. 

Ctrl+Up Move current PID up one place in the [Data (F9)] tab page. 

Ctrl+Down Move current PID down one place in the [Data (F9)] tab page. 

  

Shift+Del Clear console text 

  

Ctrl+Space Pause/Resume data logging 

Ctrl+F2 Fetch chart inspector 

Ctrl+F3 Connect 

Ctrl+F4 Disconnect 

  

Ctrl+PgUp Read black-box logged data from FlashScan 

Ctrl+PgDn Configure FlashScan for black-box logging 

Ctrl+F10 Start the EFILive Tuning Tool 

Ctrl+F11 Display FlashScan V2 Control Panel 

  

Ctrl+1 Set highlighted PIDs to priority 1 

Ctrl+2 Set highlighted PIDs to priority 2 

Ctrl+3 Set highlighted PIDs to priority 3 
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Dashboard Hotkeys 

Hotkey Description 
  

A Show dash page A 

B Show dash page B 

C Show dash page C 

  

Ctrl+W Tile charts to cover entire dashboard 

  

Ctrl+Alt+N Zoom none 

Ctrl+Alt+Z Zoom 1:1 

Ctrl+Alt+I Zoom in 

Ctrl+Alt+O Zoom out 

Ctrl+Alt+S Zoom selected data 

Ctrl+Alt+A Zoom all data 

  

Shift+Ctrl+N New dash page 

Shift+Ctrl+O Open dash page 

Shift+Ctrl+S Save dash page 

Shift+Ctrl+T Save dash page with a new name 

 

Map Hotkeys 

Hotkey Description 
  

A Show map page A 

B Show map page B 

C Show map page C 

D Show map page D 

E Show map page E 

F Show map page F 

G Show map page G 

H Show map page H 

I Show map page I 

J Show map page J 

  

Shift+Ctrl+C Copy selected map cells and labels to clipboard  

Shift+Ctrl+M Open a new map 

Shift+Ctrl+R Replot current map 

  

Ctrl+, Show cells’ minimum value 

Ctrl+. Show cells’ maximum value 

Ctrl+= Show cells’ count value 

Ctrl+- Show cells’ average value 
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Record/Playback Hotkeys 

Hotkey Description 
  

Ctrl+Q Mute/Unmute audible gauge alarms 

Ctrl+R Re-plot charts 

Ctrl+M Start monitoring data 

F3 Start recording data 

F4 Stop data logging or playback 

Ctrl+L Playback recorded log file at selected speed 

Ctrl+Space Pause/Resume data logging or playback 

Home Move chart inspector to first frame 

PgUp Move chart inspector to previous note 

Ctrl+Left Move chart inspector backward multiple frames 

Left Move chart inspector backward one frame 

Right Move chart inspector forward one frame 

Ctrl+Right Move chart inspector forward multiple frames, or if playing back, playback 
at full speed 

PgDn Move chart inspector to next note 

End Move chart inspector to last frame 

Ctrl+Del Delete selected chart data. 

  

0..9 Search forward through log file for matching note number. 

Ctrl+0..9 Search backward through log file for matching note number. 
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LS1 Control Panel Hotkeys 

Hotkey Description 
F4 Deactivate and hide the control panel 

F5 Show and activate the control panel 

  

Ctrl+F6 Select Engine tab page 

Ctrl+F7 Select Transmission tab page 

Ctrl+F8 Select Spark/Fuel tab page 

  

Engine tab page hotkeys 

M Check/Uncheck MIL 

K Check/Uncheck Skip shift lamp 

C Check/Uncheck CC inhibit 

U Check/Uncheck A/C clutch 

W Check/Uncheck Fan low 

H Check/Uncheck Fan high 

I Check/Uncheck A.I.R sol 

P Check/Uncheck A.I.R pump 

F Check/Uncheck Fuel pump 

S Check/Uncheck Purge sol 

V Check/Uncheck Vent sol 

O Check/Uncheck Closed loop 

L Check/Uncheck Fuel learn 

Z Zero fuel trims 

  

Transmission tab page hotkeys 

G Check/Uncheck Gear 

1 Select 1
st
 gear 

2 Select 2
nd

 gear 

3 Select 3
rd

 gear 

4 Select 4
th
 gear 

A Toggle shift solenoid A 

B Toggle shift solenoid B 

W Check/Uncheck TCC PWM 

T Check/Uncheck TCC solenoid 

S Check/Uncheck 3-2 solenoid 

P Check/Uncheck PCS current 

R Check/Uncheck Reverse lockout 

K Check/Uncheck Skip shift 
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LS1 Control Panel Hotkeys (cont’d) 

Spark/Fuel tab page hotkeys 

  

D Check/Uncheck Delta spark control 

S Check/Uncheck Absolute spark control 

F Check/Uncheck Fuel control 

  

Shared hotkeys 

Y Select [Y] for current control 

N Select [N] for current control 

U Uncheck all 

+  Increase PCS current by 10mA 

 Increase Spark by 0.1 degree 

 Increase AFR by 0.1 

-  Decrease PCS current by 10mA 

 Decrease Spark by 0.1 degree 

 Decrease AFR by 0.1 

Shift+= 
(aka Shift++) 

 Increase PCS current by 100mA  

 Increase Spark by 1.0 degree 

 Increase AFR by 1.0 

Shift+-  Decrease PCS current by 100mA  

 Decrease Spark by 1.0 degree 

 Decrease AFR by 1.0 

 



EFILive V7 Scan Tool for GM Vehicles 

support@efilive.com - 39 - www.efilive.com 

Allison Control Panel Hotkeys 

Hotkey Description 
F4 Deactivate and hide the control panel 

F6 Show and activate the control panel 

  

M Check/Uncheck MIL 

T Check/Uncheck TCC engage 

  

G Check/Uncheck Gear 

5 Select 5
th
 gear 

4 Select 4
th
 gear 

3 Select 3
rd

 gear 

2 Select 2
nd

 gear 

1 Select 1
st
 gear 

  

C Check/Uncheck Clear all TAP cells 

G Check/Uncheck Clear all Garage TAP cells 

A Select all 

U Unselect all 

S Clear selected cells 

P Preset all TAP cells 

  

U Uncheck all 

M More info 
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Idle Air Control Hotkeys 

Hotkey Description 
  

F4 A/C on/off 

F5 Fan low on/off 

F6 Fan high on/off 

+ Increase idle speed 

- Decrease idle speed 

F9 Select RPM to control idle speed 

F10 Select IAC to control idle speed 

F11 Select ETC to control idle speed 

F12 Select IAC/98 to control idle speed 

Alt+M More info 

Escape Close window 

 

Cylinder Balance Test Hotkeys 

Hotkey Description 
  

F3 Start test 

F4 Abort test 

+ Increase idle speed 

- Decrease idle speed 

F10 Select IAC to control idle speed 

F11 Select ETC to control idle speed 

F12 Select IAC/98 to control idle speed 

Alt+P Print results of cylinder balance test 

Alt+M More info 

Escape Close window 

 

Crank Position Sensor Relearn Test Hotkeys 

Hotkey Description 
  

F3 Start test 

Alt+M More info 

Escape Close window 
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MMEENNUUSS  

File 

 

Connect 

Searches for a supported OBDII interface cable and connects to it. Once a connection has been 
made to the OBDII cable, EFILive will attempt to connect to the vehicle. 

Disconnect 

Disconnects EFILive from the OBDII interface cable. 
 

 
You MUST disconnect the Scan Tool software from the OBDII interface cable prior to 
performing any action in the Tuning Tool software that requires connecting to the OBDII 
interface cable. 

New 

New log file 

Clears currently loaded log file data. 
You may not change which PIDs are selected while data exists in the Scan Tool. Before 
attempting to change any PID selections, you need to select this option to clear the data. 
You may add or remove calculated PIDs without first clearing data. 

New PID selection 

Clears the selected PIDs so that no PIDs are selected. This option is only available when no 
logged data exists. Use the “New log file” option to clear logged data prior to using this option. 

New dashboard 

Clears the currently loaded dashboard 

New dashpage 

Clears the currently displayed dashpage 

Open 

Open log file 

Opens and displays previously recorded log files. 

Open PID selection 

Opens and loads a new PID selection file. 

Open dashboard 

Opens and displays a new dashboard file 

Open dashpage 
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Opens and displays a new dashpage file in the currently display dashpage. 

Open map 

Opens and displays a new map file in the currently displayed map page. 

Save 

Save log file 

Saves the current data using the most recently used log file name. 

Save PID selection 

Saves the current list of selected PIDs. 

Save dashboard 

Saves the dashboard layout and associated dashpages. 

The dashboard will need saving if you: 

 Add or remove any gauge, status or chart. 

 Move or resize any gauge, status or chart. 

Save dashpage 

Saves the currently displayed dashpage. 

Save as… 

Save log file as 

Saves the current data with a new filename. 

Save PID selection as 

Saves the current list of selected PIDs with a new filename. 

Save dashboard as 

Saves the dashboard layout and associated dashpages with a new filename. 
 

 
Always save dashboards in the My Documents\EFILive\V7\VDash folder. The 
Scan Tool expects virtual dashboard files (*.vdb) to be in that folder and may not 
correctly display the dashboard if they are not. 

Save dashpage as 

Saves the currently displayed dashpage with a new filename. 
 

 
Always save dashpages in the My Documents\EFILive\V7\VDash folder. The Scan 
Tool expects virtual dashpage files (*.vdp) to be in that folder and may not correctly 
display the dashboard or dashpage if they are not. 

Recent log files 

Displays a list of the most recently used log files. 
The list can be cleared at any time by selecting File->Recent files->Clear file list. 
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Export… 

Opens the export window that allows you to export the current data, or any subset of the current 
data. 

The exported file format is compatible with Microsoft Excel and any other application that can read 
*.csv (comma separated values) formatted files. 

Select Controller 

The target controller must be correctly identified before attempting to connect. 

This option is automatically displayed when EFILive attempts to connect. EFILive ignores the 
controller selection, if you are attempting to connect to FlashScan only (i.e. not to a vehicle). 
 

 
If you have previously elected to hide the controller selection window when connecting 
to a vehicle, EFILive will use the most recent controller selection, which may not be 
correct for the target vehicle. In that case, you are responsible for selecting this menu 
option prior to connecting to each different controller. 

Enter VIN 

You may use this option to enter various details about a vehicle that would otherwise be known to 
EFILive if a vehicle was connected. EFILive uses the information that you entered to configure PID 
data. 

Generate error report 

Usually, when the Scan Tool detects an error, the error report window will be displayed. The error 
report window provides details about why the error occurred and information that the EFILive support 
team can use to help diagnose the problem. 

Sometimes the EFILive support team may ask you to “generate an error report”, even though the 
Scan Tool has not detected any error. Use this option to take a 'snapshot' of the program and the 
conditions related to its operation that can be sent to EFILive support to aid in diagnosing trouble. 

Save console text 

Saves a copy of the console text buffer. You can choose to save the *.rtf (rich text) format which 
preserves the font and color settings or in *.txt (plain text) format which does not. 

Print… 

Prints the information that is currently displayed on the screen. If the report contains no data then the 
preview is not displayed and nothing is printed. 

Print all… 

Prints the information contained in all the checked items in Properties->Printing. 
Any item that contains no data is skipped; if all items contain no data then the preview is not 
displayed and nothing is printed. 
 

 
Both print options will first display the report on the screen for you to review. Once you 
have reviewed the report on the screen, you may choose to: 

 Send the report to the printer. 

 Save the report for printing later. 

 Discard the report completely. 
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Display/Print saved reports… 

If you have previously saved any reports then use this option to view and/or print them. 

Exit 

Stops data logging and disables bidirectional controls, if either is active, then exits. 
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Edit 

 

Undo 

Undoes the most recent change that you have made to any text field. A text field is any area of the 
Scan Tool where you can edit text data. 

Select all 

Selects all text in the current text field. 

Clear all 

Clears the console display – if the console display has focus. The console display has focus if the 
cursor, a small vertical line, is flashing in the console display. If the console display does not have 
focus you can set focus by clicking in it. 

Cut 

Copies any selected text to the clipboard and then deletes the selected text. 

Copy 

Copies any selected text to the clipboard. 

Copy with labels 

Copies the selected map cells and their labels to the clipboard. 
 

 
If you intend to paste the data into a matching Tuning Tool calibration table, it is a 
good idea to use this option to copy the labels as well. 
When you “Paste with labels” the data into the Tuning Tool calibration table, 
EFILive will automatically align the data so that the cells with matching labels are 
updated. 

Copy and fill 

Copies selected MAP cells to the clipboard and fills any empty cells with the average value of its 
surrounding cells. The “smoothness” of the fill can be controlled with the “smoothing weight” setting 
in the MAP property editor. 

Copy and fill with labels 

Copies the selected map cells and their labels to the clipboard and fills any empty cells with the 
average value of its surrounding cells. 

Paste 

Copies the contents of the clipboard into the current text field. 

Default customer details 

Opens the default Vehicle/Customer details window. These details are embedded into the log file 
when it is first saved. To alter the information once it has been embedded in a log file, use the Edit-
>Log file information option. 
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Log file information 

You can add comments to the current data. These comments are embedded in the log file and can 
be viewed any time a log file is loaded. 

You can also change the gross vehicle mass (GVM). The GVM is used in calculated PIDs that 
require the vehicle’s weight. 

Open Notepad 

Opens Windows Notepad for taking notes. Unlike Log file information (above), Windows Notepad 
can be opened at any time, including while the Scan Tool is logging data. You are responsible for 
saving and organizing the files created by Windows Notepad. 

Properties 

The Properties window is where you can customize most of the Scan Tool parameters - see the 
Properties Configuration section. 
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View 

 

Customize toolbars 

Hide or show selected toolbars and/or tool-tip display 

Onboard information window 

Displays the [OBD II (F7)] tab page. 

Show PID selection 

Displays the [PIDs (F8)] tab page. 

Show parameter table 

Displays the [Data (F9)] tab page. 

Show virtual dashboard 

Displays the [Dashboard (F10)] tab page. 

Show maps 

Displays the [Maps (F11)] tab page. 

Console window 

Displays the [Console (F12)] tab page. 

Profiler window 

Displays the Profiler window. 
The Profiler window provides real time information about the status of the connection to the vehicle. 

 Scan mode (in title bar) 

 Frames per second will be displayed in: 
o Red when fps is less than 1. 
o Yellow when fps is 1 or greater but less than 5. 
o Green when fps is 5 or more. 

 Time remaining in the current log file will be displayed as hh:mm:ss and will be: 
o Red when less than 1 minute remains. 
o Yellow when 1 or more minutes but less than 10 minutes remain. 
o Green when 10 or more minutes remain. 
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Info 

 

Retrieve all test results 

Will retrieve various PCM information and the test results for all onboard monitored systems. A 
summary of the results will be displayed in the [OBD II (F7)] tab page on the [Summary] sub page. 

Validate PIDs 

Will query the connected vehicle to determine which PIDs are supported and which are not. 
Unsupported PIDs are marked with a cross through their icon on the [OBD II (F7)] tab page [PIDs] 
sub page. 

Validate modules 

Will query the connected vehicle to determine which modules can be detected. Detected modules 
are displayed on the [OBD II (F7)] tab page [MODs] sub page. 

PCM info 

Displays the PCM’s internal calibration part numbers. For US domestic vehicles, these numbers can 
be checked on this web site calid.gm.com/vci. 

System readiness tests results 

Displays the system readiness tests’ status. 

Specifically monitored systems test results 

Displays the specifically monitored systems tests’ results. 

O2 sensors tests results 

Displays the oxygen sensors tests’ results. 

Diagnostic trouble codes 

Retrieves and displays diagnostic trouble codes from all modules listed in the [OBD II (F7)] tab page 
[MODs] sub page. 

History freeze frame data 

Retrieves and displays any history data associated with DTC’s. 

Clear DTCs 

This option clears all trouble codes and emissions test results from the PCM. 

 
This option will reset all the EPA System Readiness Tests’ status to “Not Ready”. 

Clear DTCs for listed modules 

This option clears trouble codes from all modules listed in the [OBD II (F7)] tab page [MODs] sub 
page. 

http://calid.gm.com/vci
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Dashboard 

 

Fit dashboard/maps to window  

If you change the Scan Tool window size you can use this option to automatically reposition and 
resize the gauges, status and charts to fill the new dashboard size. 
 

 
If you would like the gauges to “maintain their aspect ratio” then check this checkbox: 
Properties->Options->Maintain dashboard aspect ratio at and specify the aspect 
ratio (between 0 and 1) that you want to use. Experiment with different values until you 
find one that suits the screen size. 

The dashboard’s aspect ratio is defined as: (dashboard height) / (dashboard width). 

Mute alarms 

Mutes and un-mutes ALL audible gauge alarms. 

Lock dashboard 

Locks or unlocks the dashboard. Each time the Scan Tool is started, and each time a new 
dashboard is loaded, this option defaults to checked. Before you can move or resize any items you 
must uncheck this option. See previous section: Moving and Resizing Items. 

Snap to grid 

Causes items to snap to the specified grid size when they are moved or resized. 

Size all to grid 

Resizes all items to their nearest grid coordinates. 

Align all to grid 

Moves all items to their nearest grid coordinates. 

Recall installation defaults 

Restores the selected dashboard to its original installation default settings. The associated *.pid files 
are also restored. 

Filter settings 

Edit data filters and select current data filter. 

Add note 

Add “Note 0” to the current frame. 

Use the toolbar icon/drop down list to add notes other than “Note 0”. You can customize each note’s 
description on the [Notes] tab page in the Property editor. 

Delete note 

Delete notes from the current frame. 
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Charting 

 

Zoom none 

Set chart magnification to normal. 

Zoom 1:1 

Set chart magnification so that one frame of chart data is represented by one pixel on the screen. 

Zoom in 

Increase chart magnification. 

Zoom out 

Decrease chart magnification. 

Zoom selected 

Increases or decreases chart magnification to display the charts’ selected area as the full width of 
the chart display. 

Zoom all 

Shows the entire log file in the chart display. 
 

 
The chart magnification level affects chart display speed, and therefore overall 
performance. Zoom in to display less data points and faster chart display speeds. 
Zoom out to display more data points but slower chart display speeds. 

Tile charts 

Arrange charts so that they completely fill the dashboard. 
This option is only available if and only if the currently displayed dashpage contains only charts. 

Keyboard only inspect 

When you move the mouse over the charts, the chart inspector (the vertical line that shows the 
current frame) follows the mouse. If you are using the arrow keys for fine control over the chart 
inspector, check this option to prevent mouse movements from accidentally changing the chart 
inspector position. 

Fetch chart inspector 

If you scroll the charts so that the chart inspector is no longer visible, and Keyboard only inspect is 
checked, then use this option to bring the chart inspector back into visibility. 
If Keyboard only inspect is not checked, then just move the mouse over the charts to “fetch” the 
chart inspector. 
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Calibration 

 

These tools are designed for LS1/LS6 engines only. Some parameters may work on Duramax PCMs but 
are not guaranteed to be accurate. 

Miscellaneous calibration information 

Displays miscellaneous calibration information, for LS1/LS6 only such as: 

 Engine size 

 Transmission type 

 Differential ratio 

 4WD status 

 Speed limiter 

 OBD II compliance 

 Location of O2 sensors 

 MAF/ESC component test results 

 Fan type 

 Fan on/off temperatures 

 PCM memory test results 

Long term fuel trim cells 

Displays the long-term learned fuel trim cells, for LS1/LS6 only. 

Auto transmission adaptive shift cells 

Displays the learned transmission adaptive shift cells, for LS1/LS6 only. 

Some vehicle calibrations are configured to alter the transmission line pressures in order to achieve 
the desired shift times. This table shows those learned values. If they are all zero then adaptive shift 
is probably turned off in the PCM 

Allison transmission adaptive shift cells 

Displays the learned transmission adaptive shift cells, for Allison transmissions only. 

The Allison transmission is configured to alter the transmission line pressures in order to achieve the 
desired shift times. This table shows those learned values. 
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Bidirectional 

 

LS1/LS6 Control panel… 

Provides bidirectional controls for various auxiliary systems on the LS1/LS6 engines. 

Allison Control panel… 

Provides bidirectional controls for the Allison transmission. 

Idle air control… 

You can adjust parameters to observe what changes they make to the idle speed. (LS1/LS6 non-
ETC only) 

Cylinder balance test… 

Sequentially disables each injector while monitoring the associated drop in RPM. The relative 
strength of each cylinder is displayed. (LS1/LS6 non-ETC only) 

CKP learn… 

Performs a crank position sensor relearn. 

A relearn is necessary anytime that the physical relationship between the crank and the crank 
position sensor is disturbed, or if the PCM is replaced. (LS1/LS6 only) 

Change VIN… 

Changes the VIN stored in your PCM. 

Oil life reset… 

Changes the oil life indicator stored in your PCM. 
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FlashScan 

 

Read logged data from FlashScan 

Retrieves logged data from the FlashScan interface. 

Program selected PIDs into FlashScan 

Configure the FlashScan interface for black-box logging. 

Start EFILive Tuning Tool 

Starts the EFILive Tuning Tool, or activates the Tuning Tool window if it is already started. If the 
Tuning Tool window is minimized then this option will not show the window, you need to activate it 
manually. 

FlashScan V2 Control Panel 

Displays the FlashScan V2 Control Panel, used to calibrate the 5V A/D input voltages. 
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Window 

 

Small (800x600)  

Sets the Scan Tool window to the same size it would be maximized on an 800x600 screen. 

Medium (1024x768) 

Sets the Scan Tool window to the same size it would be maximized on a 1024x768 screen. 

Large (1152x864) 

Sets the Scan Tool window to the same size it would be maximized on a 1152x864 screen. 

Extra large (1280x1024) 

Sets the Scan Tool window to the same size it would be maximized on a 1280x1024 screen. 
 

 
The Scan Tool will not set the window size to larger than the current screen resolution. 
If an attempt is made to set the window size larger than the current screen then the 
Scan Tool will simply maximize the window. 

Fit to tuning tool 

Resizes the window to fit in the top x% of the screen. X is defined in Properties->Options->Scan 
Tool startup options->Size. 
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Help 

 

Help contents 

Displays this document. 
 

 
The Scan Tool looks for this document called <install_folder>\Doc\EFILiveV7Scan.pdf. 
It must exist, and Adobe Acrobat Reader must be installed on the computer, for the 
Help menu option to succeed. 

You can download the latest version of this document (EFILiveV7Scan.pdf) here: 
www.efilive.com/downloads 

You can download the free Adobe Acrobat Reader here: 
Get Adobe Reader 

Tutorials 

Lists all *.pdf documents in the folder: Program Files\EFILive\V7\Docs\Tutorials. 
New and updated tutorials will be published from time to time and made available here: 
http://www.efilive.com/download.aspx. 
Download them and place them in the tutorials folder and they will appear in the Tutorials menu. 

EFILive home page 

Opens the computer’s default browser and attempts to navigate to EFILive’s home page at 
www.efilive.com. 

EFILive online forum 

Opens the computer’s default browser and attempts to navigate to EFILive’s forum page at 
http://forum.efilive.com/. 

Register EFILive 

Opens the registration window where you can add or change registration details. 
 

 
Do not attempt to alter the license details of both the Scan Tool and Tuning Tool at the 
same time. 

About 

Displays version information about the Scan Tool, connection data, and programming credits. 

 

http://www.efilive.com/downloads
http://www.adobe.com/products/acrobat/readstep2.html
http://www.efilive.com/download.aspx
http://www.efilive.com/
http://forum.efilive.com/
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RREEGGIISSTTEERRIINNGG  YYOOUURR  IINNTTEERRFFAACCEE  CCAABBLLEE  

Entering your license details 

In the past, EFILive had been copied and illegally distributed via the Internet. To protect our investment 
in EFILive (and ultimately yours too), we require you to enter a registration key, supplied by EFILive, 
which activates the EFILive software. The registration key prevents un-authorized use of the EFILive 
software and hardware. 

EFILive can store up to five separate interface cable licenses. If you have upgraded from an AutoTap 
interface cable to a FlashScan interface cable, or if you have purchased more than one FlashScan 
interface cable, then you will have multiple EFILive registration keys. You should enter all registration 
keys into the License Manager. 

The registration details are “case sensitive”, which means you must use exactly the same capitalization 
when entering the details. 

 

The order in which you enter the license details is not important. EFILive will always use the license that 
matches the connected cable. If no cable is connected, EFILive will use the license that provides the 
most functionality. For example, if you had an EFILive Standard license for your AutoTap cable and an 
EFILive Personal Scan&Tune license for your FlashScan cable, then EFILive would use the EFILive 
Personal Scan&Tune license if no cable was connected. 
 

 
EFILive will not check the license details when you enter them. If any details are incorrect, 
you will not be informed immediately. EFILive will silently ignore all invalid licenses when 
searching for a valid license. 

Serial number: is the serial number of your interface cable. The serial number must be exactly 12 digits 
long. If your interface has more or less digits, then either add or remove leading zeros (000123456789) 
to make it exactly 12 digits. 



EFILive V7 Scan Tool for GM Vehicles 

support@efilive.com - 57 - www.efilive.com 

RoadRunner serial: is the RoadRunner serial number if you are using a RoadRunner real-time 
emulator. If you are not licensed to use a RoadRunner real-time emulator then leave this field blank.  

Type: is the license type. You must specify the correct license type that you purchased, or the license 
will be ignored. 

Issue date: is the date the license was issued by EFILive. It must match the date printed on your blue 
License Registration Card. 

Key: is the 4-part, 16 letter registration key. All characters must be uppercase letters; no digits or 
punctuation characters are allowed. Any characters other than uppercase letters will be rejected. 
 

 
If your license details have been emailed to you, highlight the license details in the email and 
press Ctrl+C. Then click the [Paste] button in the License Manager window. 

Changes that you make to the license details will not take effect until the next time you attempt to 
connect to a vehicle 
 

 
The license key information that you enter is stored in a text file called: My 
Documents\EFILive\V7\User Configuration\License.txt 
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SSCCRREEEENN  DDIISSPPLLAAYYSS  

Main window 

    

The Scan Tool’s main window consists of three distinct sections: 

 Menu and toolbars. (The record/playback toolbar at the bottom of the window is part of the Menu 
and Toolbars section.) 

 The tab pages, where most of the scan tool data is displayed. 

 The status bar that displays the status of the Scan Tool. 

Menu and Toolbars 

 

The main menu and toolbars can be rearranged or hidden to suit the display preference. To move the 
main menu or any of the toolbars, grab the menu or toolbar’s handle with the mouse and drag it to a new 
position. 
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Tab pages 

 

Each tab page in the main window provides different data about the vehicle. The tab pages and their 
functions are explained in the next few sections. 

 OBD II (F7) has sub pages: Summary, PIDs, MODs, PCM, SRT, SMS, O2, DTC and FF. 

 PIDs (F8) 

 Data (F9) 

 Dashboard (F10) 

 Maps (F11) 

 Console (F12) 

Viewing multiple tab pages simultaneously 

You may drag any tab page (except the [OBDII (F7)] tab page) off the main window. The tab page 
will float in its own window. To replace the tab page into the main window, either close the floating 
window or drag its title bar to the blank tab page area (next to the existing tabs) in the main window. 

If you leave a tab page floating when you close the Scan Tool, it will be repositioned, floating in the 
same place and with the same size when you restart the Scan Tool. 
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Status Bar 

 

The status bar provides feedback about the state of the Scan Tool and its connection to the vehicle. 

It has three sections: 

1. A connection indicator: 
This section will display the COM port connection settings (such as Com1: 115200,8,N,1) when 
a successful connection has been made to the vehicle, otherwise it displays: Not connected. 
 
If a USB virtual com port (i.e. AutoTap ATU) cable is detected then the Scan Tool will display the 
virtual COM port number followed by the term “USB”. 
 
If a native USB (i.e. FlashScan) is detected then the Scan Tool will display the USB device name 
followed by USB. For FlashScan cables you should see the text: EFILive FlashScan FSP : 
USB. 
 
USB connections operate thousands of times faster than RS232 serial ports. Their speeds are 
measured in millions of bits per second (Mbps) instead of thousands or bits per second (Kbps) 

2. The current VIN, transmission and operating system details: 
When the Scan Tool first starts (before any connection to a vehicle has been made) it sets the 
current VIN and operating system to the VIN and operating system that was most recently used. 
When a connection is made to a vehicle, the current VIN and operating system is updated to the 
VIN and operating system detected in the vehicle. 
 
When the current VIN is updated, the Scan Tool searches for and loads the matching 
vehicle/customer details. 
 

 
EFILive does not automatically detect the transmission type. It is up to you to tell 
EFILive. You can set this transmission type using the Edit->Default customer 
details menu option. 

3. Tips and explanations: 
When the mouse is positioned over many of the onscreen items, a brief description of that item’s 
function is displayed in this area. 

The color of the status bar indicates the state of the link between the Scan Tool and the vehicle. 
 

Grey The Scan Tool is not connected to the vehicle. 
The Scan Tool may be connected to the FlashScan interface cable. 

 

Blue The Scan Tool is connected to the vehicle but not currently sending or receiving data. 

 

Yellow The Scan Tool is sending or receiving data but not recording. 

 

Red The Scan Tool is sending or receiving data and recording the received data. 
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[OBD II (F7)]  
On Board Diagnostics 

Summary 

 

The summary sub page displays the following details: 

 Supported parameters available: 
This shows how many PIDs have been validated as supported for the connected vehicle. If no 
vehicle is connected, then the Scan Tool uses the current VIN to look up the validated set of 
PIDs for that VIN, and displays that value instead. If the Scan Tool has not previously been 
connected to a vehicle with a similar VIN, then the Scan Tool will most likely display only a 
handful of PIDs (mostly calculated PIDs) as supported. 
To see an accurate list of supported PIDs, make sure you are connected to a vehicle. 

 Validated modules available: 
This shows how many modules have been detected for the connected vehicle. If no vehicle is 
connected, then the Scan Tool uses the current VIN to look up the detected set of modules for 
that VIN, and displays that value instead. If the Scan Tool has not previously been connected to 
a vehicle with a similar VIN, then it will not display any modules. 

 System readiness test (EPA) will show: 
o Not checked yet if the Scan Tool has not yet queried the PCM for the tests’ status. 
o Complete if ALL supported tests are ready. 
o Incomplete if ANY supported test is not ready. 

 Specifically monitored tests will show: 
o Not checked yet if the Scan Tool has not yet queried the PCM for the tests’ results. 
o Passed if ALL SMS tests passed. 
o Failed if ANY SMS test failed. 

 O2 sensor tests will show: 
o Not checked yet if the Scan Tool has not yet queried the PCM for the tests’ results. 
o Passed if ALL O2 tests passed. 
o Failed if ANY O2 test failed. 

 
Starting in 2004, some GM vehicles no longer report the O2 Sensor test 
results under “O2 sensor test results”. Instead, they are reported under the 
“Specifically Monitored Systems” (SMS) test results. 

 Diagnostic trouble codes will show: 
o Not checked yet if the Scan Tool has not yet queried the PCM for DTCs. 
o Not detected if DTCs were not detected. 
o Detected if ANY DTCs were detected. 
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 History freeze frames will show: 
o Not checked yet if the Scan Tool has not yet queried the PCM for freeze frame data. 
o Not detected if freeze frame data was not detected. 
o Detected if ANY freeze frame data was detected. 

 Scan mode Stream-Slow  will show: 
o Not checked yet if the Scan Tool has not yet queried the PCM for scan mode support. 
o Supported if Stream-Slow scan mode is supported. 
o Not supported if Stream-Slow scan mode is not supported. 

 Scan mode Stream-Fast  will show: 
o Not checked yet if the Scan Tool has not yet queried the PCM for scan mode support. 
o Supported if Stream-Fast scan mode is supported. 
o Not supported if Stream-Fast scan mode is not supported. 

 Maximum dynamic packets will show: 
o Not checked yet if the Scan Tool has not yet queried the PCM for dynamic packet 

support. 
o The maximum number of dynamic packets that the PCM supports. 
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 MODs - Modules 

 

Most modern vehicles have multiple, onboard computer systems that control various safety, performance 
and luxury features. Each module is assigned a unique ID according to the SAE J2178-1 specification. 

 $00-$1F Powertrain controllers  
o $00-$0F Integration/Manufacturer Expansion 
o $10-$17 Engine controllers 
o $18-$1F Transmission controllers 

 $20-$3F Chassis controllers 
o $20-$27 Integration/Manufacturer Expansion 
o $28-$2F Brake controllers 
o $30-$37 Steering controllers 
o $38-$3F Suspension controllers 

 $40-$C7 Body controllers 
o $40-$57 Integration/Manufacturer Expansion 
o $48-$5F Restraints 
o $60-$6F Driver information/Displays 
o $70-$7F Lighting 
o $80-$8F Entertainment 
o $90-$97 Personal communications 
o $98-$9F Climate control (HVAC) 
o $A0-$BF Convenience (Doors, Seats, Windows, etc.) 
o $C0-$C7 Security 

 $C8-$CB Electric Vehicle Energy Transfer System (EV-ETS) 
o $C8 Utility connection services 
o $C9 AC to AC conversion 
o $CA AC to DC conversion 
o $CB Energy storage management 

 $CC-$CF Future expansion 

 $D0-$EF Manufacturer specific 

 $F0-$FD Off-Board Testers/Diagnostic scan tools 

 $FE-$FE All nodes 

 $FF-$FF Null node 
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Validated modules are stored in a file called <data_folder>\PIDs\<VIN>.vml, where <VIN> is the first 11 
digits of the vehicle’s VIN. When the Scan Tool first connects to a vehicle it checks for a matching 
<VIN>.vml file. If it finds one it skips the automatic module detection and uses the list of modules in the 
<VIN>.vml file. If it does not find one then it automatically detects the modules and saves the result in the 
appropriate <VIN>.vml file for future reference. 
 

 
The Scan Tool can be configured to use a passive module detection method that can 
sometimes not detect certain modules. 

If you believe the Scan Tool has not detected all modules present in your vehicle, you may 
change the detection mode to active by checking the following property: 
Properties->Options->Use active module detection, then re-validating the modules. 
Active module detection may reset some modules’ current settings, such as the radio’s 
volume and HVAC vent settings.  

Alternatively, if you know that the vehicle has a module that the Scan Tool did not detect 
and you know the module ID, you can manually add that module’s ID to the <VIN>.vml file 
in the <data_folder>\PIDs folder. 
 
If you later select to validate modules, you will be warned that any changes you may have 
made to the <VIN>.vml file will be lost. 

 

Each time the Scan Tool checks for trouble codes; all listed modules will be queried and all modules’ 
detected trouble codes will be displayed. 

The Scan Tool provides two methods for clearing trouble codes: 

 
Info->Clear emissions related trouble codes 

[ ] Clear emissions related trouble codes. 

 
Shift+F10 

 

 
The “Clear emissions related trouble codes” option will clear ALL trouble codes from the 
engine controller – not just emissions related trouble codes. However, this option does not 
clear trouble codes from any other module. 

 

 
Info->Clear trouble codes for all modules 

[ ] Clear trouble codes for all modules. 

 
Shift+F11 
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PCM – Powertrain Control Module 

 

When a connection is made to a vehicle, the following details are retrieved from the PCM: 

 VIN 

 PCM HDW Number 

 Calibration ID 

 Serial Number 

 Operating System Software 

 Engine Calibration 

 Engine Diagnostic Calibration 

 Transmission Calibration 

 Transmission Diagnostic Calibration 

 Fuel System Calibration 

 System Calibration 

 Speedometer Calibration 

 Operating System BCC 

For US domestic vehicles, these part numbers can be checked on this web site: 
http://tis2web.service.gm.com/tis2web 
 

 
For early model F and Y bodies that do not report an Operating System Software number, 
the Scan Tool will substitute a “generic” value as follows: 

19980100: 1998 F body 
19970200: 1997 Y body 
19980200: 1998 Y body 

These numbers have no significance except that they are used internally by the Scan Tool 
for configuration purposes. 

http://tis2web.service.gm.com/tis2web
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SRT – System Readiness Tests (EPA) 

 

OBD II compliant vehicles can have up to eleven systems that are monitored by the onboard electronics. 

 Catalyst 

 Heated Catalyst 

 Evaporative Purge System 

 Secondary Air System 

 A/C System Refrigerant 

 Oxygen Sensor 

 Oxygen Sensor Heater 

 EGR System 

 Misfire Monitoring 

 Fuel System Monitoring 

 Comprehensive Component Monitoring 

For each monitored system, the table shows whether the diagnostic testing of that system is supported, 
and if so, whether the test results are "Ready" or "Not Ready". If some supported tests have NOT been 
completed then some test results may be invalid. 

The status does not indicate success or failure of each test, merely whether each tests’ results are 
"Ready" or "Not Ready". 

If a system is detected to be faulty, the detected faults will be exposed as Diagnostic Trouble Codes 
(DTCs) and in the O2 tests’ results and the SMS tests’ results. 

The status of all supported tests will be set to "Not Ready" if the DTCs are cleared and/or if power is 
removed from the PCM. 

Once reset, each supported test may take one or more drive cycles to return to the "Ready" state. See 
Appendix-F for instructions on how to perform the GM drive cycle. 

Depending on the year of manufacture of the vehicle, emissions testing stations may allow zero, one or 
two of the supported tests to be in the "Not Ready" state. 
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SMS – Specifically Monitored Systems 

 

SMS test results from a year 2000 LS1/LS6 PCM. 

 

SMS test results for model year 2004 LS1/LS6 PCM 
(note the O2 sensor test results: Test ID $05) 

The vehicle manufacturer is responsible for assigning Test ID's (TID) and Component ID's (CID) for tests 
of different systems and components. The service technician will need to obtain the TID and CID 
descriptions from the vehicle manufacturer. 

Test results are requested by test ID. Only one test limit (maximum limit or minimum limit) is included in 
each result. If a particular test has both a maximum and a minimum limit then two test results are 
reported for the component.  
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The latest test results are retained, even over multiple ignition-off sequences until replaced by more 
recent test results. 

Examples of specifically monitored systems are: 

 Catalyst monitoring. 

 Evaporative system monitoring. 

Some manufacturers use these test results in place of the O2 tests’ results. 

This report was previously called "Non-Continuously Monitored Systems' Test Results". 

 

 Test ID’s and Component ID’s can be checked at GM’s web site here: 
http://si2000.ecomm.gm.com/gmspo/mode6/index.html 
Test ID’s and Component ID’s are listed under “Mode 6  Data”. 

http://si2000.ecomm.gm.com/gmspo/mode6/index.html
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O2 – O2 Sensor Test Results 

 
The O2 sensor test results for LS1/LS6 model year 2004 (and later) may be displayed via 
the SMS test results instead. (See previous section for SMS test results explanation). 

 

The O2 sensors are constantly monitored by the PCM to ensure correct engine operation. 

The test results indicate whether or not the O2 sensors are performing within specification. 

The latest test results are retained, even over multiple ignition-off sequences, until replaced by more 
recent test results. 

Sample O2 sensor output showing test IDs $01 through $09. 

 

 $01 Rich to lean sensor threshold voltage 

 $02 Lean to rich sensor threshold voltage 

 $03 Low sensor voltage for switch time calculation 

 $04 High sensor voltage for switch time calculation 

 $05 Rich to lean sensor switch time 

 $06 Lean to rich sensor switch time 

 $07 Minimum sensor voltage for test cycle 

 $08 Maximum sensor voltage for test cycle 

 $09 Time between sensor transitions 
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DTC – Diagnostic Trouble Codes 

 

If a malfunction is detected in any of the onboard vehicle electronic systems, a Diagnostic Trouble Code 
will usually be set. 

Some DTCs are considered pending (PTC) and are primarily used to assist the service technician after a 
vehicle repair, and after clearing diagnostic information, by reporting the test results after a single driving 
cycle. If the test failed during the driving cycle, the PTC associated with that test will be reported. Test 
results reported by this mode do not necessarily indicate a faulty component/system. If test results 
indicate a failure after additional driving, then the MIL will be illuminated and a DTC will be set. PTCs will 
display "P" in the status column. 

Some DTCs also save a freeze frame (snapshot) of the current operating conditions when the 
malfunction was detected. DTC's that have freeze frame data available will display "H" in the status 
column. 

The [Legend] button will display the Status legend window. 

 
Emissions related DTCs that are reported as EPA and/or EPA Pending may also be 
reported as MIL or Pending. This is because the Scan Tool first retrieves and displays all 
emissions related DTCs as legislated by CARB. Then the Scan Tool retrieves and displays 
all manufacturer enhanced DTCs including emissions related DTCs. This method of 
display offers the user the opportunity to discern which DTCs are CARB/emissions related 
and which are not. 

By default, the Scan Tool only retrieves trouble codes with a status of M, P, H or C. You can change 
which trouble codes the Scan Tool reports here: Properties->Advanced->Diagnostic trouble codes-
>Display DTC’s. 
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FF – Freeze Frame, History Data 

 

The PCM may save a freeze frame (snapshot) of some parameters' values when a diagnostic trouble 
code is set. 

The purpose of freeze frames is to allow access to PID values that were stored when a malfunction is 
detected. Being able to see the exact operating conditions of the engine at the time the malfunction 
occurred makes diagnosis easier. 

Up to six freeze frames are stored in the PCM. If more than six freeze frames are saved then the oldest 
frame is discarded first. 

Not all parameters displayed in the freeze frame snapshot are supported on all vehicles. 
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Understanding DTCs 

DTCs are composed of a letter, (one of B, C, P or U,) followed by 4 digits. The DTC can be split into 4 
groups; each one conveys a particular piece of information. 

Using the example code: P0102 “Mass or Volume Air Flow Circuit Low Input” you can see how the code 
structure is implemented: 

 

The code P0102 is: 

 A Powertrain code. 

 ISO/SAE controlled, meaning it is a generic code that is common to all vehicles. 

 It belongs to the Fuel and Air Metering system. 

 The component or section has been identified as 02. 

 

 Diagnostic Trouble Codes can be checked at GM’s web site here: 
http://si2000.ecomm.gm.com/gmspo/mode6/index.html 

http://si2000.ecomm.gm.com/gmspo/mode6/index.html
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[PIDs (F8]  
PID Selection  

PIDs – Parameters 

 

PIDs represent data attributes such as RPM, throttle position and spark advance that are available to be 
monitored or logged. See page 89 for more details. 

As there are over 200 PIDs, it is not possible to display ALL PIDs all of the time. Apart from being 
confusing, the PCM cannot send that much information quickly enough for detailed data analysis. 

The Scan Tool can request the PCM to send a useful subset of PIDs. It is up to you to select which PIDs 
you want to see. 

If you are using the Stream  scan modes, we recommend that you always select as many PIDs as you 
can fit into 24 channels of data. In these two scan modes, selecting more PIDs will not slow down the 
frame capture rate. Even if you do not need to analyse the data in those PIDs immediately, you can 
always re-plot the logged data at a later stage and display any of the logged PIDs. 
 

 
Some PIDs require multiple channels, so the number of PIDs that you may select will 
usually be less than the number of channels available. 

Common PIDs 

 RPM - Engine speed 

 VSS - Vehicle speed sensor 

 TP - Throttle position 

 MAP - Manifold absolute pressure 

 MAF - Mass air flow 

 SPARKADV - Spark advance 

 AFR - Air fuel ratio (Enhanced PID) 

 KR - Retard due to knock (Enhanced PID) 

 ECT - Engine coolant temperature 

 IAT - Intake air temperature 

 IAC - Idle air control 

 O2S11 - O2 Sensor voltage Bank 1, Sensor 1 

 O2S2 1- O2 Sensor voltage Bank 1, Sensor 1 

 FTC – Fuel Trim Cell # (Enhanced PID) 
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EFILive’s PID naming convention 

Because the Scan Tool needs to be able to identify certain PIDs, like spark advance and air fuel ratio, 
each PID is assigned a unique name. The PID name is shown in the Parameter column. By convention, 
the EFILive documentation shows PID names in curly braces like this {SAE.RPM} and {GM.KR}. 

Future versions of EFILive that may support manufacturers other than GM will have PIDs named like 
this: {FD.xxx} for Ford PIDs and  {DC.xxx} for DaimlerChrysler PIDs. 

Some PIDs may or may not be supported for the current vehicle. The Scan Tool validates the PIDs by 
querying the PCM, which indicates whether the PIDs are supported or not. PIDs that have not been 
validated by the PCM are displayed with a cross through their icon. 
 

Icon Description 

 Selected, supported PID 

 Unselected, supported PID 

 Selected, unsupported or invalid PID 

 Unselected, unsupported or invalid PID 

  

 
Calculated PIDs will be marked invalid if any of the PIDs used in the calculated PID’s 
expression are invalid or not selected.  

In the V7 Scan Tool, (unlike V5 and V6), you may select unsupported or invalid PIDs. 
However, unsupported PIDs will be displayed as N/A (meaning Not Available). The Scan 
Tool allows the selection of unsupported or invalid PIDs because it may not be connected 
to a vehicle and may not be able to determine which PIDs are supported and/or valid and 
which are not. 

Validated PIDs are stored in a file called <VIN>.vpl where <VIN> is the first 11 digits of the vehicle’s VIN. 
When the Scan Tool first connects to a vehicle it checks for a matching <VIN>.vpl file. If it finds one it 
skips the automatic PID validation and uses the list of PIDs in the <VIN>.vpl file. If it does not find one 
then it automatically validates the PIDs and saves the result in the appropriate <VIN>.vpl file for future 
reference. 

If you use the Scan Tool on more than one vehicle there is a chance that you may encounter two 
vehicles that generate matching <VIN>.vpl and <VIN>.vml file names but have differing sets of PIDs 
and/or modules. If that is the case, you will need to re-validate the PIDs each time you start the Scan 
Tool on the other vehicle. 

 
If you want to run the Scan Tool on your desktop PC it is a good idea to copy the <VIN>.vpl 
and <VIN>.vml files from your laptop to your desktop. 

You can hide/show unsupported PIDs by un-checking or checking the [Supported] check box. This 
option also hides unsupported PIDs on the [Data (F8)] tab page. 
 

 
If you load in a log file from another EFILive system, chances are you may not have a 
matching <VIN>.vpl (validated PID list) file that matches the log file’s VIN. That means the 
Scan Tool will not know which PIDs are supported and which PIDs are not for that VIN. 

If the Supported check box is checked then you will not see many of the log file’s 
parameters in the [Data (F8)] tab page. In that case, uncheck the Supported check box to 
see the parameters. 

You can display just a subset of PIDs based on the system to which the PIDs belong by selecting the 
appropriate system from the [System] drop down list box. 
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Finding the right PID 

To make it easier to locate the PID that you require, you can sort the list of PIDs by any of the columns. 
Click on the column header and the list will be sorted in that order. For example if you wanted to find the 
MAF frequency PID you would sort the PIDs via the "Units" column and then look for kHz or Hz in the 
sorted column. 
 

 
A right-click, popup menu provides a More info… option to display “more information” 
about the highlighted PID. However, not all PIDs have more information available. 

Selecting PIDs 

To select a PID, double click the PID you want to be added. To unselect a PID, double click the PID you 
want to be removed. 

To highlight multiple individual PIDs, hold down the Ctrl key while single clicking on different PIDs. To 
highlight a range of PIDs, click the first PID, then hold down the Shift key and click the last PID in the 
range. 

To add multiple PIDs, press the insert key to add all the currently highlighted PIDs. To remove multiple 
PIDs, press the delete key to remove all the currently highlighted PIDs. 

As you add and remove PIDs, you will see the values at the bottom of the PID display changing to 
indicate how many channels you have selected. Some PIDs require just one channel; some PIDs require 
multiple channels. The number of channels is indicated in the column headed: Channels. 

The maximum number of channels that may be selected is determined by the scan mode. 
 

Scan mode Channel Limit 

Single PID 96 (which is an arbitrary limit imposed by the Scan Tool) 

Dynamic 6 x Maximum dynamic packets 

Stream-Slow 24 

Stream-Fast 24 

  

 
The maximum number of dynamic packets for the currently connected vehicle is displayed 
in the [OBD II (F7)] tab page on the [Summary] sub page. 

Selecting the default display units for PIDs 

You can select one or more PIDs and right click to change the PIDs’ default display units. The default 
display units control the unit used to display the PIDs in the [Data (F9)] tab page and the data values 
that are sent to the Tuning Tool for map synchronization. 

Metric (SI) 

Check this menu item to display metric values for the PIDs in the [Data (F9)] tab page. 
SI (Metric) is used WORLD WIDE except in the USA and Liberia. However, USA auto 
manufacturers’ engineering documentation and most vehicle components are SI. 

This option does not affect the virtual dashboard’s gauges, status or charts units systems. They are 
controlled individually on a per gauge basis. 

Imperial (US) 

Check this menu item to display imperial values for the PIDs in the [Data (F9)] tab page. 
Imperial values are used in the USA and Liberia. 

This option does not affect the virtual dashboard’s gauges, status or charts units systems. They are 
controlled individually on a per gauge basis. 
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Mini toolbar 

 
Use the “minitoolbar”  to clear, open, save and save as, the PID selections. It is convenient to set up 
different sets of PID selections for various diagnostic and tuning procedures. Using the “minitoolbar”, you 
can easily save the current PID selection and load different PID selections for different tasks. 
 

 
If you name a PID (*.pid) file with the same name as a dashboard (*.vdb) file, then when 
you open that PID file, the matching dashboard will be loaded automatically. 
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 [Data (F9]  
Current PID data values 

Setting the display order of PIDs 

Use the Ctrl+Up Arrow and Ctrl+DownArrow to move the selected PID up or down in the list of PIDs. 
Some PIDs (such as {SAE.FUELSYS}) consist of more than one entry in the PID list and will not be 
separated when the PID order is manually changed. 

You may only move one PID at a time. If you have multiple PIDs selected, only the upper-most selected 
PID will be moved. 

Clicking on any column-header will sort the PIDs by the values in that column and will cause the custom 
PID sequence to be scrambled. Use the following command to restore the custom PID sequence: 

 

 
View->Custom PID sequence 

 
Ctrl+Alt+Q 

 

Priority 

PIDs can be assigned priorities that help speed up the data logging sample rate by fetching some 
parameters less often than others. For example, the engine coolant temperature is a slow moving value 
and it is not strictly necessary to log that value 10 times per second. Once per second would be ample. 

PID priorities can only be changed when the scan mode is Single PID or Dynamic. PID priorities are not 
supported for Stream scan modes. When using Stream scan modes, all PIDs are sent to the Scan Tool, 
by the PCM, as priority 1 PIDs. 

To change highlighted PIDs’ priorities either: right-click and select Priority 1, Priority 2 or Priority 3. 
Alternatively, use the Hotkeys: Ctrl+1, Ctrl+2 or Ctrl+3. 

To highlight multiple individual PIDs, hold down the Ctrl key while single clicking on different PIDs. To 
highlight a range of PIDs, click the first PID, then hold down the Shift key and click the last PID in the 
range. 

The update frequency of priority “2” and “3” PIDs can be set by changing: 
Properties->Logging->Priority 2 dynamic packets->Scan every [   ] priority 1 frames 
Properties->Logging->Priority 3 dynamic packets->Scan every [   ] priority 2 frames 

Description 

Displays a brief description of the PID’s data. 
 

 
A right-click, popup menu provides a More info… option to display “more information” 
about the highlighted PID. However, not all PIDs have more information available. 

Value 

While data logging, displays the current value of the PID. 
While viewing a previously recorded log file, it displays the value of the PID at the current frame. The 
current frame is displayed in the record/playback toolbar. 
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Calculated PIDs may show a value of N/A. This usually indicates a problem with either the 
expression or the PIDs used in the expression. Use the right-click popup menu to obtain 
More info… 

Units 

Displays the engineering (real world) units of the PID’s value. To change from metric to imperial use the 
View->Metric or View->Imperial menu options. 

Min 

While data logging, displays the minimum value observed for this PID so far. 
While viewing a previously recorded log file, it displays the minimum value of this PID for the entire log 
file. 
If you have selected a section of charted data, it displays the minimum value of the PID within the 
selected frames. 

Avg 

While data logging, it displays the average value for this PID so far. 
While viewing a previously recorded log file, displays the average value of this PID for the entire log file. 
If you have selected a section of charted data, displays the average value of the PID for the selected 
frames. 

Max 

While data logging, it displays the maximum value observed for this PID so far. 
While viewing a previously recorded log file, it displays the maximum value of this PID for the entire log 
file. 
If you have selected a section of charted data, it displays the maximum value of the PID within the 
selected frames. 

Parameter 

This is the EFILive parameter name. 

Status bar 

The status bar contains three sections: 

1. The scan mode that the Scan Tool will attempt to use when data logging starts. 
 

 
The scan mode is determined by a number of different factors, see Appendix-E 
Scan Modes section. 

2. The number of selected PIDs, and in parenthesis the breakdown of priority 1, 2 and 3 PIDs. 

3. The number of selected channels, and in parenthesis the breakdown of priority 1, 2 and 3 
channels, and the maximum number of channels available for each priority. 
The status bar will turn red if too many channels have been selected for any priority for the 
current scan mode. 
 



EFILive V7 Scan Tool for GM Vehicles 

support@efilive.com - 79 - www.efilive.com 

 
The number of channels available for priority 1 PIDs is fixed at 36. 

The number of channels available for priority 2 and 3 PIDs can be changed using: 
Properties->Logging->Priority 2 dynamic packets->Packets 
Properties->Logging->Priority 3 dynamic packets->Packets 

The only restriction is that the total number of dynamic packets (6 for priority 1, 
plus the priority 2 and 3 settings) must not exceed the Maximum dynamic 
packets value that is displayed in the [OBD II (F7)] tab page on the Summary sub 
page. 
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[Dashboard (F10)]  

Virtual dashboard A 

 

We recommend using Dash-A for gauges and status displays. You can mix and match many different 
shapes, styles and types of gauges and status items. 

There are three dash pages. You can change the display between each of the three dash pages by 
pressing the keyboard keys: A, B, and C. 

The other toolbar icons along the top edge of the dashboard are: 

 New dash page. This option clears all gauges from the current page. 

 Open a new dashpage. 

 Save current dashpage. 

 Save current dashpage with a new name. 
 

 New dashboard. This option clears all gauges from all pages. 

 Open a new dashboard (all three pages). 

 Save current dashboard (all three pages). 

 Save current dashboard with a new name (all three pages). 
 

 Edit data filters and select current data filter. 

 Apply current filter to log file data. 

 Evenly distribute charts in dashpage. 

 Select background image for dashpage. 
 

 Select dashpage A. 

 Select dashpage B. 

 Select dashpage C. 

 

 
While you can easily reposition dashboard items so that they overlap, we recommend that 
you do not. The gauges and charts have not been designed to operate when they are 
overlapped. The display will flicker noticeably and be difficult to watch. 
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Virtual dashboard B 

 

We recommend using Dash-B for charts, however you can place any type of dashboard item in Dash-B. 
 

 
If you right click in any dashboard screen that only contains charts and select Dash 
settings->Auto size charts then the Scan Tool will resize the charts so they are all the 
same size and distributed evenly in the display. 

If you have other items in a dashboard screen, then the Auto size charts feature will be 
disabled. 
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Virtual dashboard C 

Dash-C is currently used as a “scratch” area where you can create and modify gauges, charts and status 
items without interfering with Dash-A and Dash-B. 

To show some of the customization features in the Scan Tool, here are some samples of user created 
custom dashboards: 

  

 

 

Photo-realistic gauges may be designed by setting a gauge’s background to a picture (bitmap) of a “real” 
gauge. Telltale needles can be added that show the minimum and maximum values displayed in the 
gauge. 
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[Maps (F11)]  
Maps  

 

Maps display the aggregate (count, minimum, average and maximum) values of one PID in a matrix 
based on the values of two other PIDs. 

Theses maps are also known as pivot tables or histograms. 

There are ten maps. To change the display between each of the ten maps, press the keyboard keys A 
through J. 

 

The other toolbar icons along the top left edge of the map display are: 

 Clear existing map 

 Open a previously defined map 
 

 Display cell minimum values 

 Display cell maximum values 

 Display cell average values 

 Display cell count 
 

 Map property editor. 

 Replot the data in the map 

 Hide/Show cells with low cell count. 
 

 Edit data filters and select current data filter. 

 Apply current filter to log file data. 
 

 Select map pages A through J. 

The row and column labels indicate the median value for the row or column. So in the above image, the 
column headed 45, will contain the long-term fuel trim data when the MAP was between 42.5 and 47.5. 
And the row headed 1200, will contain the long-term fuel trim data when the RPM was between 1100 
and 1300. 
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[Console (F12)]  
Information and Warnings 

 

The console is the Scan Tool’s window to the outside world. It is used by the Scan Tool to display 
information and any problems or errors that are detected. 

The console text data is a valuable source of information that can help you track down problems. 

You can enter text comments into the console, just like a text editor. The console data can be saved to a 
file if required. 
 

 
File->Save console text… 

 
Ctrl+T 
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DDAATTAA  FFIILLTTEERRSS  ))  

About data filters 

Usually logged data will contain many frames of data that are distorted by environmental or operating 
conditions, or are not relevant for the diagnostic or tuning task at hand. And sometimes you may be only 
want to view data when certain conditions exist. 

Data filtering can be used to filter unwanted data from your log files. By removing the unwanted data you 
can obtain more accurate minimums, maximums and averages when you select ranges of data from the 
charts. Working with less data is also faster because EFILive does not have to re-plot 1000’s of data 
points that are not useful. 

For example, you may log a 20-minute drive around town that includes a large proportion of stationary 
idling at red traffic lights. In this instance, you may not be interested in data frames where the vehicle is 
stationary. You can easily set up a filter that filters out all frames where the VSS (Vehicle Speed Sensor) 
is zero. 

Using filters does not alter the original data; filters only hide the frames that are “filtered” out. Once you 
remove the filter, all frames of data are visible again. 
 

 
To prevent data loss EFILive prevents saving the log file while filters are active. 

 

 
You can use the “Save as…” option to save the filtered data to a new log file. 

The toolbar icons for configuring [ ], and applying/removing the currently selected filter [ ] are 

located in the toolbars on the [Dashboard (F10)] and [Maps (F11)] tab pages as shown below. 

Dashboard toolbar 

 

Map toolbar 
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Filter Properties 

Below is an example filter that includes all frames where: 

 the RPM is greater then 3000rpm AND  

 the throttle position is changing less than 1% every 100ms AND  

 the throttle position is greater than 10%. 

 

To create a new filter, click on the [New] button, enter a name for the filter and click [Ok]. You can always 
rename the filter at a later stage. 

Use the [Rename] button to rename the currently displayed filter, or the [Delete] button to delete it. 

Name: is the name of the currently selected filter. When you apply a filter to your data this is the filter 
that will be applied. 

Filter control: can be set to include or exclude the frames that pass the filter criteria listed in the 
[Filter] tab page at the bottom of the filter properties window. 

Parameter: is the PID on which you want the filter to be checked. 

Names: causes the PID names to be displayed in the drop down list along with the PID description. 

Selected: restricts the list of PIDs in the drop down list to selected PIDs only. 

Filter type: selects the comparison that you want to make. All comparisons are done in the PID’s 
units. 
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Join Using: filter items can be joined using AND or OR, the last item is not joined and always has a 
join type of None. Joins of type AND are evaluated before joins of type OR. 

Some filter types do not require any parameters, some require one parameter, some require two. 
The first parameter is a constant value against which the PID’s value will be checked. The first 
parameter is not required for the following filter types: 

 Not changing 

The first parameter is required for the following filter types: 

 Equal to 

 Not equal to 

 Less than 

 Less than or equal to 

 Greater than 

 Greater than or equal to 

 Increasing more than 

 Increasing less than 

 Decreasing more than 

 Decreasing less than 

 Changing more than 

 Changing less than 

The second parameter is a number of milliseconds that will be used to determine the rate of change 
of the parameter. This second parameter is required for the following filter types: 

 Increasing more than 

 Increasing less than 

 Decreasing more than 

 Decreasing less than 

 Changing more than 

 Changing less than 

[Add]: adds a new, blank filter item. 

[Delete]: deletes the currently selected filter item. 
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Chart data without filter 

 

Chart data with filter applied 

 

Spark advance map data without filter 

 

Spark advance map data with filter applied 
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PPAARRAAMMEETTEERR  IIDDEENNTTIIFFIIEERRSS  ((PPIIDDSS))  

Generic Parameters 

Generic parameters are part of the CARB legislated diagnostics (SAE J1979) that must be supported by 
all OBD II vehicles. The Scan Tool prefixes generic parameters with “SAE”, for example: {SAE.TP} and 
{SAE.RPM}. 

The Scan Tool will log generic parameters for all GM vehicles. 
See Appendix-B for a list of generic parameters. 

 

Manufacturer Enhanced Parameters 

Manufacturer enhanced parameters offer wider coverage and greater detail of the vehicle’s engine data. 
The Scan Tool supports enhanced parameters for GM’s LS1/LS6 and Duramax PCMs. 

EFILive is working to secure the enhanced parameters for all GM OBD II vehicles. Once the required 
enhanced data has been configured into EFILive you will be able to scan enhanced data for all GM OBD 
II vehicles. 

 

Direct Memory Access Parameters 

EFILive has an exclusive set of PIDs that we call DMA (Direct Memory Access) PIDs. These PIDs are 
not requested from the PCM as normal PIDs. Instead they are extracted directly from the PCM’s 
operating RAM (Random Access Memory). The values obtained in this manner are the PCM’s current 
operating parameters. This type of information is extremely valuable when attempting to tune the tables 
in the PCM. 

Because the values are extracted directly from the PCM’s RAM they are not only LS1/LS6 specific, they 
are also specific to each operating system within the LS1/LS6 family of PCM’s. 

You can identify DMA PIDs by their PID name, which has a “_DMA” suffix. 
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Calculated Parameters 

Another exclusive EFILive feature is the ability to derive new PIDs using arithmetic expressions based 
on the values of other PIDs. 
 

Example Calculated PIDs 

EFILive PID Name PID Description Expression to calculate the PID 

CALC.CYLAIR Air Mass Per Cylinder {SAE.MAF.gps}*15/{SAE.RPM} 

CALC.INJDC1 Injector Duty Cycle Bank 1 {GM.IBPW1}*{SAE.RPM}/1200 

   

 
EFILive’s predefined calculated PIDs are listed in the file called 
<install_folder>\Configuration\sae_generic.txt. 

We recommend that you create your calculated PIDs in a file called <data_folder>\User 
Configuration\calc_pids.txt. That file will not be overwritten if/when you upgrade EFILive. 

To create a calculated PID you need to follow these simple steps: 

1. Using any text editor open the calc_pids.txt file. 
2. Define the calculated PID by adding the following space delimited fields to the *PRN section of the 

file: 
a. A unique parameter name, which must begin with CALC. 
b. A unique PRN hexadecimal number between $F600 and $F6FF. (EFILive’s pre-defined 

calculated PIDs use the PRN range from $F500..$F5FF.) 
c. A SLOT designation. You may need to create a SLOT if an appropriate slot does not already 

exist. 

 
The SLOT designation MUST be of the form CLC-00-xxx, where xxx may be any 
number from 000 to 899. 
The 00 specifies that a calculated PID consumes 0 bits of channel data. If you 
specify any value other than 00, then EFILive will silently change it to 00 
internally. 
EFILive reserves the sequence numbers from 900 to 999 for it’s internal use. 

d. A comma separated list of units from the units defined in the SLOT. 
e. The system to which this PID belongs – you can create new systems. The systems are listed 

in the drop down list box on the [OBD II (F7)] tab page in the [PIDs] sub page. 
f. A description of the PID. 

 

 
Use double quotes around fields that contain embedded spaces or commas. 

Example: 
Parameter PRN SLOT Units System Description 
CALC.CYLAIR F600 CLC-00-1 "gpcyl,lbpcyl" Air "Air mass per cylinder" 

 

3. Add an expression under the appropriate SLOT for each of the units that you defined for the 
calculated PID: 

a. A units code which must exist in the *UNITS section in only one of the files: sae_generic.txt 
or calc_pids.txt. 

b. The lowest and highest values for this PID. These values are used as defaults when creating 
gauges and charts based on the PID. 

c. The numerical format (number of decimal places) that you want displayed. This format is 
used as the default precision when creating gauges and charts based on the PID. 

d. The expression that defines the calculated PID. 
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Example SLOT entry for {CALC.CYLAIR}: 

Units Low High Fmt Expression 
*CLC-01-1 
gpcyl 0.0 1.5 .2 "{SAE.MAF.gps}*15/{SAE.RPM}" 
lbpcyl 0.0 0.198 .2 "{SAE.MAF.lbpm}*1.98416/{SAE.RPM}" 

 

  

 
When using PIDs that have multiple units in expressions, you can add the units as a suffix 
to the PID name to specify which value (metric or imperial) to use. For example the 
{CALC.CYLAIR} PID expression specifies the gps (grams per second) units: 
{SAE.MAF.gps}*15/{SAE.RPM}. The {SAE.RPM} PID does not require a unit suffix 
because it only has one unit: RPM. 

The best way to understand how to create calculated PIDs is to study the way the default calculated 
PIDs have been defined in the file <install_folder>\Configuration\sae_generic.txt, and to follow that 
methodology. 

 

Nested PIDs 

Sometimes you may want to create calculated PIDs whose values rely on other calculated PIDs. When 
an expression contains other calculated PIDs, the order in which the calculated PIDs are evaluated is 
important: PIDs that rely on the value of other calculated PIDs must be evaluated after the PIDs on 
which they rely. 

The Scan Tool guarantees that calculated PIDs will be evaluated in the order of their PRN (Parameter 
Reference Numbers). The PRN is specified as part of the calculated PID’s definition in the 
<data_folder>\User Configuration\calc_pids.txt file. 
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Operators 

The Scan Tool provides a number of operators that you can use to construct calculated PID expressions. 
The operators are similar to the ‘C’ programming language operators. 

The operators are listed in precedence order. Operators closer to the top of the list will be evaluated 
before operators below. For example, in the expression 2+3*4 the * operator has a higher precedence 
than the + operator and will be evaluated first, as in 2+12=14, not as in 5*4=20. 

Use parenthesis to override operator precedence. For example (2+3)*4 will be evaluated as 5*4=20. 

When evaluating logical expressions, 0 indicates FALSE and non-zero indicates TRUE. 

 

Operator Description Example 

+ unary positive +2 = 2 

- Arithmetic negative -4 = -4 

! Logical negation !(5<10) = 0 

~ Bitwise negation ~00101101 = 11010010 

   

* Arithmetic multiplication 2*3 = 6 

/ Arithmetic division 10/5 = 2 

% Arithmetic modulus (remainder) 123%10 = 3 

   

+ Arithmetic addition 1+2 = 3 

- Arithmetic addition 5-4 = 1 

   

<< Bitwise shift left 00010110 << 2 = 01011000 

>> Bitwise shift right 00010110 >> 2 = 00000101 

   

> Greater than 10>5 = 1 

>= Greater than or equal to 10>=10 = 1 

< Less than 10<5 = 0 

<= Less than or equal to 10<=10 = 1 

   

= Equal to 10=10 = 1 

<> Not equal to 10<>10 = 0 

   

& Bitwise AND 00101101 & 00001111 = 00001101 

| Bitwise OR 00101101 | 00001111 = 00101111 

^ Bitwise XOR 00101101 ^ 00001111 = 00100010 

   

&& Logical AND (10>5) && (6>10) = 0 

|| Logical OR (10>5) || (6>10) = 1 
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Functions 

The Scan Tool provides a number of built in functions. These functions may be used in the calculated 
PIDs’ expressions. 

time() 
Syntax: time(frame) 
Arguments: frame (optional): the frame number. 
Return value: The specified frame’s time, in milliseconds since the first frame was logged. 

If the frame number is not specified the current frame number is used. 

frame() 
Syntax: frame() 
Arguments: None. 
Return value: The current frame number. 

value() 
Syntax: value({PID},frame) 
Arguments: {PID}: a PID name. 

frame (optional): an expression. 
Return value: The specified PID’s value for the specified frame. 

If the frame number is not specified the current frame number is used. 
If the frame number is less than 0 then frame 0 is used. 
If the frame number is greater than the last frame, then the last frame is used. 

raw() 
Syntax: raw({PID},frame) 
Arguments: {PID}: a PID name. 

frame (optional): an expression. 
Return value: The specified PID’s raw value for the specified frame. 

If the frame number is not specified the current frame number is used. 

iff() 
Syntax: iff(condition,true_value,false_value) 
Arguments: condition: an expression. 

true_value: an expression. 
false_value: an expression. 

Return value: true_value if condition evaluates to not zero 
false_value if condition evaluates to zero 

dx() 
Syntax: dx(PID,frame_count) 
Arguments: {PID}: a PID name. 

frame_count (optional): an expression. 
Return value: The rate of change of the value of {PID} from the current frame-frame_count to the 

current frame. 

damp() 
Syntax: damp({PID},frame_count) 
Arguments: {PID}: a PID name. 

frame_count (optional): an expression. 
Return value: The average value of {PID} from the current frame-frame_count to the current frame. 
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exp() 
Syntax: exp(x) 
Arguments: x: a numeric expression. 
Return value: e raised to the power x. 

log() 
Syntax: log(x) 
Arguments: x: a numeric expression. 
Return value: returns the natural logarithm of x. 

log10() 
Syntax: log10(x) 
Arguments: x: a numeric expression. 
Return value: the base 10 logarithm of x. 

pow() 
Syntax: pow(x,y) 
Arguments: x: a numeric expression. 

y: a numeric expression. 
Return value: x raised to the power y. 

sqrt() 
Syntax: sqrt(x) 
Arguments: x: a numeric expression. 
Return value: the square root of x. 

lookup() 
Syntax: lookup(x,a1,a2,b1,b2,…,c1,c2) 
Arguments: x: a numeric expression 

a1,a2,b1,b2,…c1,c2 is a list of pairs of values. 
Return value: The value of the second value of the pair whose first value is less than or equal to x. 

The list of value pairs must be sorted on the first value of each pair. 

gvmkg() 
Syntax: gvmkg () 
Arguments: None. 
Return value: The gross vehicle mass in kilograms, which is specified in the vehicle/customer data 

window. 

gvmlb() 
Syntax: gvmlb () 
Arguments: None. 
Return value: The gross vehicle mass in pounds, which is specified in the vehicle/customer data 

window. 

displacement() 
Syntax: displacement () 
Arguments: None. 
Return value: The engine’s cylinder displacement in liters, which is specified in the 

vehicle/customer data window. 
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VVEEHHIICCLLEE  AANNDD  CCUUSSTTOOMMEERR  DDAATTAA  

Most of this information is only for your own records, however the Scan Tool uses some fields: 

 The customer name and vehicle’s registration may be used by the Scan Tool to construct file 
names, and may be used to display in the printed report headers. 

 The Gross Vehicle Mass (G.V.M.), will be used by the Scan Tool when it is evaluating calculated 
PIDs’ expressions that contain the functions: gvmkg() and gvmlb(). 
 

 
Save the vehicle/customer details using the 17 character VIN as the filename with a .cus 
extension. That way when the Scan Tool connects to a vehicle and discovers the VIN, it 
will automatically search for and load the appropriate vehicle/customer details file. 

Customer details 

 

The following customer details can be recorded by the Scan Tool: Customer name, Address, Phone, Fax 
ane Email. 

 

 
If you intend to distribute logged data files and you do not want to expose the customer's 
name as part of the logged filename, then use a coded naming convention for the 
customer's name, or don’t select the <cn> tag for the filename template. Alternatively, 
rename the log file before you distribute it. 

NOTE: Customer details are NEVER stored in the (*.efi) logged data files. 
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VIN 

 

The following vehicle details can be saved as part of the vehicle/customer information: 

 Vehicle registration number. 

 The name is a free-form field and may be used as part of the auto-generated log file name. See 
Properties->Folders->Templates. 

 Vehicle identification number (VIN). 

The Scan Tool attempts to decode and display the information encoded in the VIN. 
 

 
If the Scan Tool does not display the VIN details correctly, you can edit the file called 
<install_folder>\Configuration\vin.ini. 
See Appendix-C - File Formats for the vin.ini file format. 

  

 
The VIN is stored, along with all vehicle information, in the logged data file. If you intend to 
distribute logged data files and do not wish to distribute the VIN sequence number, then 
check Properties->Options->General->Privatize VIN. 

For added privacy, you should not enter the vehicle’s registration number on the [Vehicle] 
tab page of the Vehicle/Customer Details window. 
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Vehicle Options 

 

The following vehicle details can be saved as part of the vehicle/customer information: 

 Induction, Differential ratio, Transmission type, Injection type. 

 Diff ratio. 

 Cylinder volume in cubic centimeters. 
 During calculated PID expression evaluation, this value is returned by the function: 
displacement(). 

 Transmission type. 

 Gross vehicle mass. 
The gross vehicle mass should include the driver, fuel and any extra equipment or luggage. 
During calculated PID expression evaluation, this value is returned by the functions: gvmkg() 
and gvmlb() in kilograms and pounds respectively. 

 Injection type. 

 Performance modifications. 

 Comments. 

Apart from cylinder volume and gross vehicle mass, the above data is descriptive only. It plays no part 
in the operation of the EFILive software. 
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DDAATTAA  LLOOGGGGIINNGG  AANNDD  PPLLAAYYBBAACCKK  

Logging data is probably the most important task that the Scan Tool performs. The data logging and 
playback toolbar controls most of the logging and playback features. 

Some toolbar buttons have a dual purpose and behave differently depending on whether you are 
recording data or playing back a previously recorded log file. 
 

 
Use the scroll bar above the record/playback toolbar to quickly scroll the charts to the 
desired location. 

 

Data Logging 

[ ] Start monitoring data 

 
Ctrl+M 

  

 [ ] Start recording data 

 
F3 

The Scan Tool requests the PCM to start sending the selected PIDs’ values. Unlike some scan tools; 
EFILive will not begin logging data until you activate this option. 
 

[ ] Pause recording. 

 
Ctrl+Space 

Pauses data recording but continues to monitor data from the vehicle. The [Data (F8)] tab page will 
continue to be updated with current data. The gauges and status dashboard items will continue to be 
updated with current data. 

Because the charts only display recorded data, they will pause until recording is resumed. The frame 
count and time stamp will pause. When recording resumes, the frame count will continue with the next 
frame, the timestamp will jump ahead to the current time. 
 

 
Pausing is useful when you are performing back-to-back logging runs, such as drag racing 
or dynamometer pulls. You can record multiple passes in a single log file. Just pause the 
recording between passes. You can even turn off the ignition between passes. 

During real-time playback, gaps in the timeline inserted due to pauses during recording will 
be skipped, the amount of time that the Scan Tool will wait for a pause in the log file is 
determined by the Properties->Playback->Frame times->Max pause value 
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[ ] Stop recording. 

 
F4 

The Scan Tool requests the PCM to stop sending data. 

If Properties->Logging->Log files->Automatically save log file is checked then you will be prompted 
for a filename with which to save the completed log file. 

If Properties->Logging->Log files->Clear log file after autosaving is also checked then the current 
log file will be cleared and the Scan Tool will ready to start recording a new file. 
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Playback 

[ ] Mute/Un-mute audible gauge alarms. 

 
Ctrl+Q 

Turns on/off all audible gauge alarms. 

 

[ ] Re-plot charts. 

 
Ctrl+R 

Making changes to the Scan Tool’s configuration may require the charts to be re-plotted. After most of 
these changes, such as selecting different PIDs to be displayed in the charts or changing from imperial 
to metric, the Scan Tool will automatically re-plot the charts. 

In cases where the Scan Tool does not automatically re-plot the charts, you can use this option to force 
the charts to be re-plotted. 
 

 
The Scan Tool will not automatically re-plot the charts if the logged data contains more 
frames then is specified in the Properties->Playback->Charts->Auto re-plot limit value. 

[ ] 
The Scan Tool will display the re-plot icon with a red background if/when the charts 
require manual re-plotting. 

 

[ ] Move chart inspector to first frame. 

 
Home 

Moves the chart inspector to the first frame in the log file and scrolls the charts to display the chart 
inspector. 

 

[ ] Move chart inspector back a large number of frames. 

 
Ctrl+Left 

The number of frames that the chart inspector moves is determined by the Properties->Playback-
Charts->Ctrl-arrow keys value. 

 

[ ] Move chart inspector backwards a small number of frames. 

 
Left 

The number of frames that the chart inspector moves is determined by the Properties->Playback-
Charts->Arrow keys value. 
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[ ] Search backward for previous note. 

 
PgUp 

 

[ ] Pause or resume Playback. 

 
Ctrl+space 

 

 [ ] Play current log file at real-time speed. 

 
Ctrl+L 

The Scan Tool attempts to playback the current log file at the speed specified by Properties->Playback-
Playback speed. If you have a slow PC and heavily populated virtual dashboards, it may not be 
possible for the Scan Tool to playback in real-time. In that case, it will playback as fast as it can. 
 

[ ] Stop Playback. 

 
F4 

Stops the current playback and re-plots the charts so the entire log file is plotted in the charts. 
 

[ ] Move chart inspector forward a small number of frames. 

 
Right 

The number of frames that the chart inspector moves is determined by the Properties->Playback-
Charts->Arrow keys value. 

 

[ ] 
Move chart inspector forward a large number of frames 
or 
When playing back, playback at full speed. 

 
Ctrl+Right 

The number of frames that the chart inspector moves is determined by the Properties->Playback-
Charts->Ctrl-arrow keys value. 

When playing back changes the playback speed to full speed, to change back to the selected speed, use 
the play button. 

 

[ ] Search forwards for next  note. 

 
PgDn 
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[ ] Move chart inspector to last frame. 

 
End 

Moves the chart inspector to the last frame in the log file and scrolls the charts to display the chart 
inspector. 

 

[ ] Delete selected frames from log file. 

 
Ctrl+Del 

This toolbar button will only be enabled when you have selected a range of frames by highlighting them 
in the charts. It will then delete the selected frames. You cannot undo this option. However, if you do not 
save this log file, then no changes will be made to the original log file. 

 

[ ] Crop non-selected frames from log file. 

 
Ctrl+Del 

This toolbar button will only be enabled when you have selected a range of frames by highlighting them 
in the charts. It will then delete the non-selected frames. You cannot undo this option. However, if you do 
not save this log file, then no changes will be made to the original log file. 
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FFLLAASSHHSSCCAANN  VV22  IINNTTEERRFFAACCEE  

[FlashScan LEDs]  
Status Information 

FlashScan V2 is equipped with 5 status LEDs (Light Emitting Diodes). 

 

These LEDs indicate the status of various operations being performed by the FlashScan interface. 

 

LED 
from left to right 

Status Meaning 

 
GREEN 

N/A Currently not used. 

 
ORANGE 

N/A Currently not used. 

 
BLUE 

FLASHING 
SLOWLY 

1. Keep alive message is being transmitted 
periodically to the PCM during bi-direction 
controls. 

2. High speed logging is in progress. 

 
ORANGE 

ON Data is being transmitted between FlashScan and 
the PCM. 

 
GREEN 

ON Data is being transmitted between FlashScan and 
the PC/laptop. 

When FlashScan powers up (or is reset from the EFILive Software) the 5 LEDs will flash sequentially, 
first one way then the other. This indicates that FlashScan has performed its internal self checks and is 
ready for use. It also allows you to determine is any of the LEDs are faulty. 

When you disconnect FlashScan from the PCM while power is still applied from the PC, FlashScan will 
reset and the LEDs will display the sequential pattern.  
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Logging external data using FlashScan V2 

The EFILive FlashScan interface is equipped with 8 separate inputs for capturing external data. 

 4 x 5.0V input terminals. Any of these analog inputs can be used to capture wide band O2 AFR 
data. 

 2 x 12V input switches. Either of these two inputs can be used to monitor 12V relays. 

 2 x K-Type thermocouple inputs. Either of these two inputs can be used to measure 
temperature. 

 

Each terminal has a screw-down attachment for easy connection of bare, stripped wires. 

FlashScan V2 Pin-outs 

Input (PID) Description 

A1 {EXT.AD1} Analog voltage input, 0 to 5 volts only. 

A2 {EXT.AD2} Analog voltage input, 0 to 5 volts only. 

A3 {EXT.AD3} Analog voltage input, 0 to 5 volts only. 

A4 {EXT.AD4} Analog voltage input, 0 to 5 volts only. 

S1 {EXT.SW1} 12V switch input. 

S2 {EXT.SW2} 12V switch input. 

T1 {EXT.TEMP1} K-Type thermocouple input 

T2 {EXT.TEMP2} K-Type thermocouple input 

The external PIDs can be found in the External system. You can isolate PID systems using the drop 
down list in the [PIDs (F8)] tab page of the Scan Tool. 

For Wide Band O2 integration, you may need to create your own calculated PID to suit the particular 
wide band O2 controller that you are using. 
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Calibrating FlashScan V2’s 5V A/D inputs 

The 5V analog voltage inputs are calibrated during the manufacturing process using precision 
electronics. You should never need to recalibrate the 5V A/D inputs. However, EFILive provides a 
method for recalibrating them if and when required. 

Open the FlashScan V2 Control Panel using any of the following options 

[ ] Display FlashScan V2 Control Panel 

  

 
FlashScan->FlashScan V2 Control Panel 

  

 
Ctrl+F11 

 

 

The 5V A/D inputs require the vehicle's 12V power source so you must connect FlashScan to the vehicle 
or another suitable 12V power supply. 

1. Check "Calibrate channel" for each 5V A/D channel that is connected to the calibration voltage. 
2. Uncheck "Calibrate channel" for each 5V A/D channel that is not connected to the calibration 

voltage. 
3. Supply a stable voltage between 500mV and 2000mV to the 5V A/D input(s). 
4. Indicate the exact millivolts supplied in "First voltage level (mV)". 
5. Click the [Initialize] button. 
6. Supply a stable voltage between 3000mV and 4500mV to the 5V A/D input(s). 
7. Indicate the exact millivolts supplied in "Second voltage level (mV)". 
8. Click the [Calibrate] button. 

The A/D inputs that were connected to the calibration voltage will now be calibrated to within +/-10mV 
(+/-0.01V). 
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FFLLAASSHHSSCCAANN  VV11  IINNTTEERRFFAACCEE  

[FlashScan LEDs]  
Status Information 

FlashScan is equipped with 5 status LEDs (Light Emitting Diodes). 

 

These LEDs indicate the status of various operations being performed by the FlashScan interface. 

 

LED Name Status Meaning 

 
GREEN 

LOG ON Black box logging is in progress. 

 
YELLOW 

MEM ON At least one log file has been recorded in FlashScan. 

FLASHING 
QUICKLY 

More than 90% of FlashScan’s memory capacity has been 
used. 

Note: Regardless of the state of the MEM LED, it will be 
extinguished while FlashScan is programming or reading the 
PCM. 

 
RED 

PGM ON PCM programming or reading is in progress. 

FLASHING 
SLOWLY 

3. Keep alive message is being transmitted periodically to the 
PCM during bi-direction controls. 

4. High speed logging is in progress. 

 
YELLOW 

OBD ON Data is being transmitted between FlashScan and the PCM. 

 
GREEN 

USB ON Data is being transmitted between FlashScan and the 
PC/laptop. 

When FlashScan powers up (or is reset from the EFILive Software) the 5 LEDs will flash sequentially, 
first one way then the other. This indicates that FlashScan has performed its internal self checks and is 
ready for use. It also allows you to determine is any of the LEDs are faulty. 

When you disconnect FlashScan from the PCM while power is still applied from the PC, FlashScan will 
reset and the LEDs will display the sequential pattern.  
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Logging external data using FlashScan V1 

The EFILive FlashScan interface is equipped with 3 separate inputs for capturing external data. The 2-
pin terminal is a dedicated cold junction compensated k-type thermocouple input. The 3-pin terminal can 
accept up to 2 analog, 0V to 4.8V signals. Either of these two analog inputs can be used to log wide 
band O2 AFR data. 

 

Each terminal has a screw-down attachment for easy connection of bare, stripped wires. 

FlashScan V1 Pin-outs 

 

Pin (PID) Description 

A {EXT.TEMP} Alumel lead of type-k thermocouple 

B  Chromel lead of type-k thermocouple 

C {EXT.AD2} Analog voltage 0 to 4.8 volts only 

D - Analog voltage common ground 

E {EXT.AD1} Analog voltage 0 to 4.8 volts only 

The external PIDs can be found in the External system. You can isolate PID systems using the drop 
down list in the [PIDs (F8)] tab page of the Scan Tool. 

For Wide Band O2 integration, you may need to create your own calculated PID to suit the particular 
wide band O2 controller that you are using. 
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Commonly used Wide band O2 settings 

The following table lists the pre-defined wide band O2 PIDs that ship with EFILive V7. If your wide band 
controller’s output does not match one of those below, then you will need to create your own calculated 
PID to display the correct AFR from your wide band O2 controller. 

 

WO2 
Controller 

Expression AFR 
0V 

AFR 
1V 

AFR 
2V 

AFR 
3V 

AFR 
4V 

AFR 
5V 

Use PIDs 

PLX AFR=V*2+10 10.0 12.0 14.0 16.0 18.0 20.0 {CALC.AFR_PLX1} 
{CALC.AFR_PLX2} 

LM-1 AFR=V*10 0.0 10.0 20.0 30.0 40.0 50.0 {CALC.AFR_LM11} 
{CALC.AFR_LM12} 

LC-1 AFR=V*3+7.35 7.35 10.35 14.35 16.35 19.35 22.35 {CALC.AFR_LC11} 
{CALC.AFR_LC12} 

Techedge AFR=V*2+9 9.0 11.0 13.0 15.0 17.0 19.0 {CALC.AFR_TE1} 
{CALC.AFR_TE2} 

Autronic AFR=V*4+10 10.0 14.0 18.0 22.0 26.0 30.0 {CALC.AFR_AUT1} 
{CALC.AFR_AUT2} 

Wideband 
Commander 

AFR=V*1.6+10 11.6 13.2 14.8 16.4 18.0 19.6 {CALC.AFR_WBC1} 
{CALC.AFR_WBC2} 
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Black Box Logging 

 
The initial release of FlashScan V2 does not support black box logging. Black box logging 
will be made available free of charge via Internet download, when it is available for 
FlashScan V2. 

FlashScan’s black-box logging capabilities give you the freedom to log data wherever and whenever you 
want. You can leave your laptop behind and log data directly into the FlashScan interface. FlashScan 
can hold over 20 minutes of high-speed data, however, if you choose a slower logging speed, or less 
data per frame, then FlashScan will log for many hours. 

Before you can use FlashScan as a “black-box” data logger, you must first complete two tasks. 

1. Validate PIDs 
 
The Scan Tool software needs to know some important information about the vehicle that you will be 
logging. It needs to know which PIDs are valid for the vehicle’s PCM and the PCM’s operating 
system number. Usually, when you connect the Scan Tool software to the vehicle, that information is 
obtained automatically. If you are not able to connect your computer to the vehicle, then you can 
configure FlashScan to collect that information. 
 

 
When EFILive is first shipped, your FlashScan interface is pre-configured to perform 
PID validation. 

To configure FlashScan to validate PIDs, use the following option: 
 

 
FlashScan->Program selected PIDs into FlashScan 

  

[ ] Program selected PIDs into FlashScan prior to “black box” logging 

  

 
Ctrl+PgDn 

Then, with the FlashScan interface connected to your PC, click on the [Validate] button. 

Disconnect FlashScan from your PC, turn on your vehicle’s ignition, connect FlashScan and press 
the Start/Stop data Logging button on the FlashScan interface. The validation process takes 
between 10 and 20 seconds. Once the green LED light has extinguished, disconnect FlashScan 
from your vehicle and turn off the ignition. 

Reconnect FlashScan to your PC and select the following option: 
 

 
FlashScan->Read logged data from FlashScan 

  

[ ] Read “black box” logged data from FlashScan 

  

 
Ctrl+PgUp 

Then click on the [Retrieve] button. Your PC will be updated with the validated PIDs. 

This process only needs to be performed once per unique VIN number that you intend to scan. 
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2. Select and program PIDs for black box logging 

Once the PIDs have been validated you can program the Select PIDs for logging. Go back to the 
following option: 
 

 
FlashScan->Program selected PIDs into FlashScan 

  

[ ] Program selected PIDs into FlashScan prior to “black box” logging 

  

 
Ctrl+PgDn 

And select the type of logging that you require. 

 

Dynamic will cause all data logs to be scanned using Dynamic Scan Mode. 

Fast (10fps) will cause all data logs to be scanned at 10 frames per second.  
 

 
This mode may not available on some model-years. Use Dynamic scan mode instead. 

Support for Fast (10fps) is indicated on the [OBDII (F7)] tab page on the [Summary] 
sub page. 
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Max frames per log can be set so that after a specified number of frames have been logged, 
FlashScan will automatically stop logging. This is useful for drag strip passes. You could set the 
number of frames to 600, which at 10 frames per second will log data for 1 minute. Setting this 
parameter to zero means FlashScan will not stop logging until it either runs out of memory or until 
you press the Start/Stop data Logging button on the FlashScan interface. 
 

 
The yellow LED labelled MEM on the FlashScan interface will illuminate if any logged 
data exists in the FlashScan interface. It will flash rapidly when more than 90% of the 
FlashScan memory has been used. 

Delay between dynamic frames is only available when Dynamic scan mode is selected. It 
determines the time in milliseconds between logging each frame of dynamic data. For fast logging 
set this to zero. For logging data over a long period of time, set this value to a high value. For 
example, setting it to 500 will cause FlashScan to log only 2 frames of data per second. This 
increases the length of time for which you can log data. The drawback is that the scan rate is 
reduced. 

[PIDs] programs the currently selected PIDs into the FlashScan cable. 
It will also erase all log files in the FlashScan interface. 

[Clear] will erase all log files in the FlashScan interface without disturbing the current PID selection 
that is programmed into tFlashScan. 

[Validate] programs the FlashScan interface so that next time it is connected to a vehicle it will scan 
the vehicle’s PCM for all supported PIDs and record them in FlashScan’s memory. When you next 
select FlashScan->Read logged data from FlashScan EFILive will read the validated PIDs from 
the FlashScan cable and validate or invalidate each PID in the Scan Tool accordingly. 
It will also erase all log files in the FlashScan interface. 

[Reset] clears the FlashScan memory and return it to its initial factory state. 
It will also erase all log files in the FlashScan interface. 

[Close] saves changes made to the current configuration and closes the window. 
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Verifying FlashScan V1’s memory 

 

[Test] writes, reads and verifies every byte of FlashScan’s 540,672 bytes of data logging memory. 
During the verification process the Scan Tool sends a known pattern of data to each byte, then reads 
back the data and compares it to the original data. 
 

 
This process erases all logged data and destroys the content and format of 
FlashScan’s memory. If the verification process does not complete, you may need to 
select [Reset] on the [Black box logging] tab page to clear out the verification data. 

If the verification process completes then the Scan Tool will automatically reset 
FlashScan’s memory to its original factory condition. 
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Retrieving logged data from FlashScan V1 

 
FlashScan->Read logged data from FlashScan 

  

[ ] Read “black box” logged data from FlashScan 

  

 
Ctrl+PgUp 

 

Click the [Retrieve] button to copy all log files from the FlashScan interface to your PC. The log files 
will be displayed in the [Log files] tab page. Each log file shows the VIN of the vehicle, the length, in 
hours, minutes and seconds of the log, the number of frames in the log and any Diagnostic Trouble 
Codes that were present after the last frame of the log was saved. 

Click the [Dump] button to copy the black-box memory contents of FlashScan to your PC. This 
option is useful for sending a memory image of FlashScan to EFILive support for diagnostic 
purposes in the event of a black-box log failure. 

Click the [Load] button to load a dumped file back into FlashScan’s black-box memory. 

Select [Preview] (or double click on log file) to display it in the Scan Tool. If you select preview when 
multiple log files are selected, the last log file will be displayed. 

Click [Save] to save all selected log files. They will be saved with the prefix “BB-Log“ according to 
the currently set filename template. You may select multiple log files by holding down the Ctrl or Shift 
keys while selecting. (See Filename Template on page 167) 

The [Status] tab page shows the current configuration of the FlashScan black box logger. 
The [PIDs] tab page shows the currently selected PIDs in the FlashScan black box logger. 

 
When you preview a log file, the PIDs are copied from FlashScan into your current PID 
selection. The Current PID selection file is “forgotten” by EFILive. That means next 
time you start EFILive, the PID selection will be one of the default PID files. 
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EEXXPPOORRTTIINNGG  DDAATTAA  

 

The Scan Tool provides flexible export options that allow you to select which data to export and how to 
format the exported data. The data is exported as a *.csv (Comma Separated Values) format file – 
suitable for loading directly into Microsoft Excel. 

You can save multiple export layouts in *.xpl (export layout) files. The Scan Tool remembers the most 
recently used export layout and automatically loads that layout when you open the export window. 

Use the [Save] and/or [Save As] buttons to save different export layout files. 

Select which PIDs you want to export by checking them in the left hand pane. If a PID has multiple units, 
then all units will be available for selection, so choose the units that you want. That means you can mix 
and match units (metric and imperial) in a single export file. 

The Checkboxes allow you to modify what data appears in the column headers. 
The [Selected] checkbox will only be enabled if you have selected a section of data in the charts. 
Checking the [Selected] check box will only export the frames that you have selected. 

The right hand pane has four tabs: 

1. The [Export] tab shows a sample of the exported data and how it would look when loaded into 
Microsoft Excel (or any similar spreadsheet type program). You can change the column order by 
clicking and dragging the column headers. 

2. The [DTC’s] tab shows any diagnostic trouble codes that have been stored in the log file. To include 
DTC’s in the exported file, check the DTC checkbox. 

3. The [Info] tab shows various details taken from the Customer/Vehicle window. To include the info in 
the exported file, check the info checkbox. 
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4. The [Captions] tab allows you to “rename” the PID captions to names that are useful in the 
destination application. For example you might want to export data to a Microsoft Excel spreadsheet 
that expects the vehicle speed data to be in a column headed “Wheel Speed”. By default, the Scan 
Tool exports the vehicle speed PID as VSS (Vehicle Speed Sensor). 
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CCOONNFFIIGGUURRIINNGG  TTHHEE  VVIIRRTTUUAALL  DDAASSHHBBOOAARRDDSS  AANNDD  DDAASSHHPPAAGGEESS  

About Themes 

The Scan Tool virtual dashboards are built around “themes”. A theme represents a collection of 
dashboard items that are usually of a similar “look and feel”. All items that belong to the same theme are 
stored in a folder called <data_folder>\VDash\<theme>, where <theme> is the name of the theme. 

Sharing a dashboard theme with other EFILive users is as easy as copying the *.vdb file, the three *.vdp 
files and the contents of the theme folder(s) used by that dashboard. 

A single dashboard may consist of items from more than one theme. Obviously, if you wish to share 
such a dashboard you would need to copy all the theme folders that are used by the dashboard. 
 

 
A default theme is pre-installed with EFILive, and we recommend not changing the default 
theme, or the default dashboards since there is no easy way to revert back to the original 
default dashboards. 
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Moving and Resizing Items 

Each item displayed on the virtual dashboard can be repositioned and resized. Normally the dashboard 
is locked, which prevents accidental moving or resizing of dashboard items. Before you can start 
repositioning or resizing the dashboard items, you must unlock the dashboard. 

Right click anywhere on the dashboard, select Dash settings, and uncheck Lock dashboard. Every 
time you start the Scan Tool, or load a new dashboard, this setting defaults back to locked. When the 
dashboard is unlocked, the mouse pointer will change shape depending on where it is positioned on a 
dashboard item. Imagine that each dashboard item has invisible borders and an invisible title bar. When 
you click on an item it will be displayed with an inverse border to indicate that it is the currently selected 
item. Lock the dashboard again to remove the border from the currently selected item 

The gauge below has been altered to show these invisible sections, called handles. The handles are 
positioned the same way on the status and chart dashboard items as well. 

 

The following table shows what the mouse pointer will look 
like when it is positioned over each of the different handles. 

Cursor Position within dashboard item 

 
Title bar handle. 

 
Top or bottom edge handle. 

 
Left or right edge handle. 

 
Top-left or bottom-right corner handle. 

 
Top-right or bottom-left corner handle. 

To resize the item, position the mouse so that it is over the 
handle you wish to affect (the mouse pointer will change 
shape). Then click and hold the left mouse button while 
moving the mouse. Release the mouse button when the 
handle is at the desired position and/or size. 

  

 
Changing the size of an item in its property editor will not change the size of the original 
item. 
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Dashboards 

The virtual dashboards (Dash-A, Dash-B and Dash-C) are available for you to build different views of the 
logged data. The Scan Tool provides a rich set of instrumentation that you can use to build the virtual 
dashboards. 

When you right-click on any of the dashboards you will see a pop-up menu with the following options: 

 Gauge/Chart/Status properties… (Disabled if you clicked on dashboard background) 
 
Opens the item’s property editor. The property editors do not change the item size. You can change 
the size for testing purposes and to see what it will look like at different sizes without altering the 
original item’s size. 

 Resize to square (disabled if you clicked on dashboard background) 
Resizes the current item to square. 

 Add gauge, chart or status: adds a new or existing gauge, chart or status to the dashpage. 

 Change Gauge/Chart/Status: allows you to replace the current item with a different, existing item. 

 Remove gauge, chart or status (disabled if you clicked on dashboard background) 
Removes a gauge, chart or status from the virtual dashboard. 

 Dash settings 

o Grid size sets the invisible grid’s size to 1 pixel, uncheck the Snap to grid menu option. 

o 2 pixels sets the invisible grid’s size to 2 pixels. 

o 4 pixels sets the invisible grid’s size to 4 pixels. 

o 8 pixels sets the invisible grid’s size to 8 pixels. 

o 16 pixels sets the invisible grid’s size to 8 pixels. 

o 32 pixels sets the invisible grid’s size to 8 pixels. 

o 64 pixels sets the invisible grid’s size to 8 pixels. 

o Lock dashboard locks or unlocks the dashboard. Each time the Scan Tool is started, and each 
time a new dashboard is loaded, this option defaults to checked. Before you can move or resize 
any items you must uncheck this option. See previous section: Moving and Resizing Items. 

o Snap to grid causes items to snap to the specified grid size when they are moved or resized. 

o Align all to grid moves all items to their nearest grid coordinates. 

o Size all to grid resizes all items to their nearest grid coordinates. 

o Tile charts will resize the charts so they are all the same size and distributed evenly in the 
dashboard display. 
The tile charts feature is enabled if the visible dashboard contains charts only. 

o Remove page background image: removes any bitmap image tha tis currently displayed in the 
dashpage. 

o Color… changes the background color of the visible dashboard. 
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Gauges 

 

 

 
The scroll bar at the bottom of the property editor window can be used to test the gauge’s 
operation. It is automatically configured to match the gauge’s scale. 

If the gauge has the min or max telltale needles visible, you can reset their positions by 
selecting the [Reset Min/Max] button on the [Needles] tab page. 

General 

Parameter: is a drop down list of PID descriptions from which to choose this gauge’s PID. 

Names: causes the PID names to be displayed in the drop down list along with the PID description. 

Selected: restricts the list of PIDs in the drop down list to selected PIDs only. 

Title: allows you to specify a title other than the PID’s caption. Clicking on the arrow button next to 
the title text box will revert the title back to the PID’s original caption. 

Labels: determines how many labels will be drawn on the gauge’s scale. The number of tick marks 
can be further customized in the [Metrics] tab page. 

Min: is the minimum display value for the gauge’s scale. 

Max: is the maximum display value for the gauge’s scale. 

Round to: causes the gauge to display the PID’s value rounded to a particular exponent of 10. 
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Multiplier: causes the gauge’s scale to be displayed as fractions of their actual value. A multiplier 
caption is added to the gauge. This is useful for implementing gauges such as “RPM x 100”, just set 
the multiplier to 100. 

Arc start: is the starting point for the gauge’s dial, specified in degrees, where 3 o’clock is 0 
degrees. This option is only available for dial shaped gauges. 

Sweep: is the number of degrees, through which the gauge sweeps. This option is only available for 
dial shaped gauges. 

Margin: is the number of degrees of empty space before the minimum value is displayed, and after 
the maximum value is displayed on the scale. 

The 6 shape buttons: select the gauge’s shape. 

Reset: will recall the default font sizes and positions for the current gauge shape 
 

Bar chart: will change “pie” shaped gauges into a bar-chart equivalent. 

Colors 

Select the item whose color you want to change and then select the color. You can also select fill 
patterns for certain items. 

[Custom…]: can be used to create custom colors that are not on the quick selector. 

Needles 

Value needle: hide/show the needle’s center pivot and to set its length and width and line weight. 
The X and Y offset specifies how far from the center of the gauge to display the all needles’ (value, 
min and max) pivot points. 
You cannot hide the value needle. 

Min needle: hide/show the minimum tell-tale needle and to set its length, width and line weight. 

Max needle: hide/show the minimum tell-tale needle and to set its length, width and line weight. 

Reset Min/Max: will reset the tell-tale values to the current gauge value – for testing purposes. 

Metrics 

Decoration: sets the number and length of small, medium and large tick marks and labels. 
Changing the “size” setting for labels determines how far from the center of the gauge the labels are 
positioned. Labels may be positioned outside the gauge’s dial. 

Position and shapr: control how far the scale is drawn from the gauge’s dial. Setting different 
left/right and top/bottom borders cause the gauge to skew. This is sometimes necessary to fit the 
gauge to a bitmapped background image. The face border setting controls the thickness of the dial’s 
border. 

Fonts 

Select the font item to be changed and then apply the required settings. 

[Custom…]: can be used to create custom colors that are not on the quick selector. 

 
This option is useful after you have just changed the gauge’s shape. The Scan Tool has 
been programmed with appropriate font sizes and positions for each gauge shape. 
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[Font…]: can be used to alter the font size, face and style. 

[Same]: will change all other fonts to match the currently selected font. 

H Justify and V Justify: align the text within the font boundaries. 

Digits: controls the auto size routines. It prevents values with different numbers of digits from being 
displayed with different font sizes. Set it to the maximum number of digits that will be displayed. See 
also Auto size. 

Format: specifies the format used to display the font’s data. Use “%s” for text values; use “%.pf” for 
numeric values, where “p” is the number of decimal places to display. 

Sample formats: 

Data Format Display 

RPM %s RPM 

RPM Engine Speed Engine Speed 

RPM The %s is The RPM is 

1234.56 %.0f 1235 

1234.56 Max: %.1f Max: 1234.6 

Visible: shows the font text. 

Auto size: causes the font size to be recalculated when the gauge is resized. This keeps the font 
size in proportion to the gauge size. The minimum font size is limited to 8; the maximum font size is 
limited by the font’s size setting. 
See also Digits. 

Left: is the percentage of gauge width where left edge of font boundary will be drawn. 

Top: is the percentage of gauge height where top edge of font boundary will be drawn. 

Width: is the percentage of gauge width for font width. 

Height: is the percentage of gauge height for font height. 

 
Font boundaries are specified as percentages of the gauge width and height so that 
they can be resized in proportion to the gauge when the gauge is resized. 

Show: displays all fonts’ boundaries to assist with font positioning. This option is only available in the 
property editor. 

Background 

Select the font item to be changed and then apply the required settings. 

[Custom…]: can be used to create custom colors that are not on the quick selector. 

Font is transparent: will make the font transparent so that the gauge shows through the text. 
Uncheck this to make the font’s background color visible. 

Background image: is a bitmap that will be displayed as the gauge’s background. The Scan Tool 
uses bitmaps with a bit-depth of 8 bits, which limits the image to 256 colors. 

Visible: shows the background bitmap image. 

Gauge is transparent: will make the gauge’s background transparent and allow the dashpage’s 
background image to show through. 

Show gauge border: hides/shows the gauge selection border. 
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Sections 

Specify the start and end values for each section. Sections may overlap. Use the checkboxes to 
hide/show individual sections. 

Apply: will quickly set all sections to the specified percentage of the scale. Sections 1 and 2 will be 
at the minimum end of the scale; sections 3,4 and 5 will be at the maximum end of the scale. 

Alarms 

You may specify two alarms: one to be sounded when the gauge’s value is too low and one to be 
sounded when the gauge’s value is too high. 

Value: is the minimum or maximum value for the alarm limit. 

Silent: prevents the alarm from being sounded. 

Continuous: will loop the specified wave file for as long as the gauge’s value remains above or 
below the alarm limit. 

Play: sounds the alarm for testing purposes. 
 

 
Only one alarm can be audible at any one time. If an alarm is currently sounding and 
another gauge’s alarm is tripped, the first alarm will be silenced and the second alarm 
will be sounded. Depending on how close together the alarms occur you may not hear 
the first alarm. 

  

 
Some vehicle’s audio systems are equipped with a line input jack. To provide an 
amplified alarm you could connect the laptop’s line output to the audio system’s line 
input. That way audible alarms will be played through the car’s stereo system.  Some 
cassette players can use a portable CD player’s cassette adaptor, too. 

 
Stop: stops playing a continuous sound. 
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Status 

 

 

 
The test values at the bottom of the property editor window can be used to enter test 
values for the status display. Up to four bytes can be entered; the numeric value of all 
four bytes is displayed on the left hand side. 

General 

Parameter: is a drop down list of PID descriptions from which to choose this gauge’s PID. 

Names: causes the PID names to be displayed in the drop down list along with the PID description. 

Selected: restricts the list of PIDs in the drop down list to selected PIDs only. 

Show grid: shows the grid lines between individual status items. 

Enumerated: will treat the PID as an enumerated rather than bitmapped PID. 
 

 
To determine if a PID is bitmapped or enumerated, right click on the PID in the [OBD II 
(F7)] tab page and select More info… 
Enumerated PIDs will display (Enumerated PID) and bitmapped PIDs will display 
(Bitmapped PID) immediately below the PID’s description. 

Colors 

Select the item whose color you want to change and then select the color. You can also select fill 
patterns for certain items. 

[Custom…]: can be used to create custom colors that are not on the quick selector. 
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Fonts 

Select the font item to be changed and then apply the required settings. 

 Text 0 specifies text properties when icon 0 is visible. 

 Text 1 specifies text properties when icon 1 is visible. 

 Text 2 specifies text properties when icon 2 is visible. 

[Custom…]: can be used to create custom colors that are not on the quick selector. 

[Font…]: can be used to alter the font size, face and style. 

H Justify and V Justify: align the text within the font boundaries. 

Chars: controls the auto size routines. It prevents text with different lengths from being displayed 
with different font sizes. Set it to the maximum number of characters displayed. See also Auto size. 

Auto size: causes the font size to be recalculated when the gauge is resized. This keeps the font 
size in proportion to the gauge size. The minimum font size is limited to 8, the maximum font size is 
limited by the font’s size setting. See also Chars. 

Background 

Select the font item to be changed and then apply the required settings. 

 Text 0 specifies text properties when icon 0 is visible. 

 Text 1 specifies text properties when icon 1 is visible. 

 Text 2 specifies text properties when icon 2 is visible. 

[Custom…]: can be used to create custom colors that are not on the quick selector. 

Font is transparent: will make the font transparent so that the gauge shows through the text. 
Uncheck this to make the font’s background color visible. 

Background image: is a bitmap that will be displayed as the gauge’s background. The Scan Tool 
uses bitmaps with a bit-depth of 8 bits, which limits the image to 256 colors. 

Visible: shows the background bitmap image. 

Status is transparent: will make the status’ background transparent and allow the dashpage’s 
background image to show through. 

Show status border: hides/shows the status’ selection border. 
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Icons 

Layout: changes the position of the icon image relative to descriptions. 

Stretch: stretches icons when the status is resized. 

Size: in pixels of the area reserved for the icon image. 

Icon images: are three bitmap files that will be used instead of the default icon images. Icons are 
displayed based on the PID value and the Icon index. 
 

Default icon images 

Icon 0 (green) 
 

Icon 1 (red) 
 

Icon 2 (gray)  

Icon index:  controls which icons are displayed for certain values. It is specified as a comma 
separated list of tag/icon pairs. The tag indicates the PIDs value and the icon specifies what icon to 
display. 

For example {SAE.FUELSYS} is an enumerated PID with 5 values: 
 1 Open Loop, Not ready for Closed. 
 2 Closed Loop, Using O2 Sensor. 
 4 Open Loop, Driving Conditions. 
 8 Open Loop, Detected Fault. 
 16 Closed Loop, Faulty O2 Sensor. 

To display icon 0 for closed loop, icon 1 for open loop and icon 0 for any other value, you would set 
up the Icon index as follows: 

1=1,2=0,4=1,8=1,16=1 

Which means: 

 When the PID’s value is 1, display icon 1. 

 When the PID’s value is 2, display icon 0. 

 When the PID’s value is 4, display icon 1. 

 When the PID’s value is 8, display icon 1. 

 When the PID’s value is 16, display icon 1. 

 When the PID’s value is anything else, display icon 2. 

Captions 

Specify alternate captions to be displayed for each item in the status display. 

Show default captions: Ignores any user defined captions and shows the default captions. 

Show user captions: Ignores any default captions and shows the user defined captions. 

Clear: Clears the user defined captions. 
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Charts 

 

Chart 

Select the item whose color you want to change and then select the color. You can also select fill 
patterns for certain items. 

[Custom…]: can be used to create custom colors that are not on the quick selector. 

Number: specifies the number of gridlines to be displayed. 

Style: specifies the line style used to draw the gridlines. 

X-Axis 

Size: specifies the height of the x-axis. 

Increment: specifies the label spacing in the X-axis. 

Visible: shows the x-axis. 
 

 
All charts will have the same x-axis values so it is only necessary to have one 
chart (usually the bottom one) on each display with its x-axis visible. 

[Font…]: sets the font for the x-axis. 

Y-Axis 

Size (left): specifies the width of the left y-axis. 

Size (right): specifies the width of the right y-axis. 

Visible: determines which of the two y-axes are visible. 
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Series 

Series colors 

Select the series whose color you want to change and then select the color. 

[Custom…]: can be used to create custom colors that are not on the quick selector. 

Scale 

Title: allows you to specify a title other than the series caption. Clicking on the arrow button 
next to the title text box will revert the title back to the series’ original caption. 

Min/Max: are the minimum and maximum display value for the series’ scale. 

Round to: causes the series to display the PID’s value, rounded to a particular multiple of 
10. 

Multiplier: causes the series’ scale to be displayed as fractions of their actual value. This is 
useful for implementing series such as “RPM x 100”, just set the multiplier to 100. 

Data Lines 

Width: sets the series’ line weight. Line styles are only available when width is 1. 

Style: specifies the line style used to draw the series. 

Font 

Digits: controls the auto size routines. It prevents values with different numbers of digits 
from being displayed with different font sizes. Set it to the maximum number of digits that will 
be displayed. See also Auto size. 

Format: specifies the format used to display the font’s data. Use %s for text values; use %pf 
for numeric values, where p is the number of decimal places to display. 

Sample formats: 

Data Format Display 

RPM %s RPM 

RPM The %s is The RPM is 

1234.56 %.0f 1235 

1234.56 Max: %.1f Max: 1234.6 

Auto size: causes the font size to be recalculated when the chart is resized. This keeps the 
font size in proportion to the chart size. The minimum font size is limited to 8, the maximum 
font size is limited the font’s size setting. See also Digits. 

Show units: shows the unit’s code. 

Split units: draws the units on the line below the title. 

[Font…]: can be used to alter the series’ font size, face and style. 

[Same]: will change all other series’ fonts to match the currently selected series’ font. 

Parameter: is a drop down list of PID descriptions from which to choose this series’ PID. 

Names: causes the PID names to be displayed in the drop down list along with the PID description. 

Selected: restricts the list of PIDs in the drop down list to selected PIDs only. 
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CCOONNFFIIGGUURRIINNGG  TTHHEE  MMAAPPSS  

 

Data 

Parameter: is a drop down list of PID descriptions from which to choose this map’s data PID. 

Names: causes the PID names to be displayed in the drop down list along with the PID description. 

Selected: restricts the list of PIDs in the drop down list to selected PIDs only. 

Title: replace the PID name with your own description; click the [<-] button to restore the original PID 
name. 

Show units: hides/displays the units. 

Precision: determines the number of decimal places to display. 

Minimum cell width: limits the minimum size (in pixels) to which the Scan Tool will shrink the cells 
in order to display the cell values. 

Display type: hides/displays the display type in the map title. The display type is one of: (Minimum), 
(Maximum), (Average) or (Cell Count). 
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Column 

Column: is a drop down list of PID descriptions from which to choose this map’s column PID. 

Names: causes the PID names to be displayed in the drop down list along with the PID description. 

Selected: restricts the list of PIDs in the drop down list to selected PIDs only. 

Title: replace the PID name with your own description; click the [<-] button to restore the original PID 
name. 

Show units: hides/displays the units. 

Columns: is the number of columns to display 

[Create labels]: opens a dialog box that allows you to select labels from EFILive’s presets, or create 
custom labels by specifying start, end and step values. 

[Paste labels]: will paste the column labels that were “Copied with labels” from a map in the Tuning 
Tool. 

Col labels: is a comma-separated list of numeric column values. A comma must be placed at the 
head of the list to prevent column labels appearing in the top left (blank) cell. 
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Row 

Row: is a drop down list of PID descriptions from which to choose this map’s row PID. 

Names: causes the PID names to be displayed in the drop down list along with the PID description. 

Selected: restricts the list of PIDs in the drop down list to selected PIDs only. 

Title: replace the PID name with your own description; click the [<-] button to restore the original PID 
name. 

Show units: hides/displays the units. 

Rows: is the number of rows to display. 

[Create labels]: opens a dialog box that allows you to select labels from EFILive’s presets, or create 
custom labels by specifying start, end and step values. 

 [Paste labels]: will paste the row labels that were “Copied with labels” from a map in the Tuning 
Tool. 

Row labels: is a comma-separated list of numeric row values. A comma must be placed at the head 
of the list to prevent row labels appearing in the top left (blank) cell. 

Cells 

Constrain cell size: Check this box to force the cell sizes to remain within the limits defined. 

Color 

Select the map element whose color you want to change and then select the color. 

[Custom…]: can be used to create custom colors that are not on the quick selector. 

Colored: Uncheck this to display the map without any min/medium/max color scale. 

High contrast font colors: Check this box to force font color to black or white so that the cell values 
can been seen on varying background colors. 
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Creating labels 

 

In this example, the RPM labels are specified as two ranges: the first from 400 to 2200 in increments 
of 200 rpm, and the second from 2400 to 8000 in increments of 400 rpm. This set of rpm labels 
matches the rpm range of the high and low octane spark maps in a typical file from the EFILive 
Tuning Tool. 

Preset labels: is a drop down list of preset labels that match common tuning table labels. 

Custom: allows you to specify up to three independent ranges of labels, each with its own start, end 
and step values. 

Start: is the first label in the range. 

End: is the last label in the range. 

Step: is the increment between labels. 

Precision: determines the number of decimal places in each label. 

[Clear]: clears the label preview. 

[Preview]: generates all labels and displays them down the right side of the window. 
 

 
If you select ranges that overlap, EFILive will not display the map data correctly. 
Each label must be greater than the previous label. 
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PPRRIINNTTIINNGG  RREEPPOORRTTSS  

Generating 

There are two ways to generate a report: 

[ ] Print currently displayed data. 

 
Ctrl+P 

If no data exists then the following message will be displayed and no report will be generated. 

 

 

[ ] Print multiple reports. 

The checkboxes in Properties->Printing->Diagnostic information control which data is included in the 
report. See Printing in the Properties Configuration section. 
 

 
When you select Print or Print all the Scan Tool will always display the report on the 
screen. This provides an opportunity for you to review the report before sending it on to the 
printer or saving it to disk for printing at a later stage. 
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Viewing 

[ ] Open report viewer 

 
File->Display/Print saved reports… 

 

[ ] Open and display existing report. 

 
Ctrl+O 

Reports may be loaded from *.rpt files which have been saved using the “Save current report to disk” 
option. 

[ ] Save current report to disk. 

 
Ctrl+S 

Reports are saved as *.rpt files which may be opened and viewed using the “Open and display 
existing report” option. 
 

[ ] Export current report to a series of *.wmf (Windows Meta File) files. 

 
Ctrl+E 

The Scan Tool uses *.wmf files because they are much smaller then either *.jpg or *.bmp files. Because 
printed data is at a much higher resolution than screen displays, the image files would be prohibitively 
large in *.bmp or *.jpg format. A single page of a report in *.bmp format may take up to 24 MB of disk 
space. 
 

 
If you want to email a report to a colleague, you could export the report to a series of 
images and then attach those images to an email. 

Many graphic utilities exist to view *.wmf files – or even convert them into more 
commonly used image formats such as *.jpg or *.bmp. 

 

[ ] Send the report to the printer. 

 
Ctrl+P 

 

[ ] Show first page of report. 

 
Home 

 

[ ] Show previous page of report. 

 
Left 

 

[ ] Show next page of report. 

 
Right 
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[ ] Show last page of report. 

 
End 

 

[ ] Zoom in. 

 
Ctrl+Alt+I 

You may also left click the report window to zoom in. 
 

[ ] Zoom out. 

 
Ctrl+Alt+O 

You may also right click the report window to zoom out. 
 

[ ] Resize window to fit report. 

 
Ctrl+F 
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Customizing Reports. 

Changing the logo displayed on reports 

By default, the printed reports will include the EFILive logo in the top right hand corner of the first page. 
You can change the logo to one of your own as long as it is in the *.jpg format. Just replace the 
<data_folder>\images\report_logo.jpg file with one of your own. EFILive’s report generator will 
automatically resize the image to fit in the report header. 

Changing the report descriptions 

Most reports that the Scan Tool prints can be printed with or without a narrative. The narrative is a 
description that explains what information the report contains. The narratives are stored in plain text files 
called <install_folder>\Configuration\header_*.txt. You may edit these files to change the text that is 
printed on the reports. 

The first line in each text file is the report title, subsequent lines are the narrative. 

If you want to suppress the titles and/or narratives completely, uncheck one or both of the following: 
Properties->Printing->Diagnostic information->Titles 
Properties->Printing->Diagnostic information->Descriptions 
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VVEEHHIICCLLEE  CCAALLIIBBRRAATTIIOONN  DDAATTAA  

 
LS1/LS6 and Allison transmission specific data is only available for a subset of LS1/LS6 
PCMs and Duramax diesel ECMs. If your PCM or ECM does not report it’s operating 
system calibration part number correctly, or does not report it at all, then the Scan Tool 
may not be able to display this information correctly. 

 

 
To print the data contained in the calibration data windows, use the print option on the 
main window. 

[ ] The Scan Tool will print the calibration data window that is currently displayed. If more 

than one calibration data window is open, it will print the first one that it “finds”. To make 
sure the one you want to print is printed, only have one calibration data window open when 
you select this option. 

[ ] The Scan Tool will print all calibration data windows that are checked in Properties-

>Printing->Diagnostic information whether they are currently displayed or not. 

 

Long Term Fuel Trim Cells 

The long-term fuel trim cells are learned by the PCM over many ignition cycles and driving conditions. 
There are 48 cells, 24 for each bank of injectors. 

The red numbers (in parenthesis) indicate the Fuel Trim Cell Number. 

 

This sample data does not 
necessarily represent ideal 
Long Term Fuel Trims. 

The red numbers indicate 
the fuel trim cell number. 
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The first 16 cells (0 to 15) are arranged in a 4x4 matrix, indexed by MAP and RPM. The PCM uses a 
2kPa and 100rpm hysteresis to prevent borderline MAP and RPM values from causing the cell number 
to change rapidly between neighboring cells. 

This 4x4 matrix can be found in most GM OBD II (and OBD I) fuel control systems. 

The last 8 cells have been added to meet stricter OBD II, EPA emissions regulations and to provide 
more accurate fuel delivery under a wider range of idle conditions, deceleration and wide-open throttle. 

Only one bank is displayed at a time, click either [Bank-1] or [Bank-2] to see the fuel trims associated 
with each bank. 

Use the [Copy] button to copy the fuel trim cell values for both banks to the clipboard. The data is in 
Microsoft Excel format and may be pasted directly into a Microsoft Excel spread sheet. 

Use the [Save] button to save the fuel trim cell values for both banks to a file. 

The [Reset] button will reset all fuel trims for both banks to 0%. 

Check the [Metric] checkbox to display the MAP as kPa, uncheck it to display the MAP as inHg. 

Click on [Refresh] to update the display with the most current fuel trim values. [Refresh] fetches both 
banks’ fuel trim values at the same time. [Refresh] may also be used to update the display with the 
appropriate units (if you have changed the system units). 

[Close] closes the window. 
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Miscellaneous calibration details 

Displays static calibration information from the connected PCM. 

Use the [Copy] button to copy the calibration data to the clipboard. The data is in Microsoft Excel format 
and may be pasted directly into a Microsoft Excel spread sheet. 

Use the [Save] button to save the calibration data to a file. 

Check the [Metric] checkbox to display values in metric, uncheck it to display values in Imperial. 

Click on [Refresh] to update the display with the appropriate units (if you have changed the system 
units). 
 

 
Long description or short descriptions will be displayed depending on the setting of the 
Properties->Options->General->Display short parameter descriptions setting. 

Calibrations 

 

 

Engine size displays the total engine cylinder displacement. 

Transmission displays the transmission type. 

Diff ratio shows the differential ratio. This may not be accurate for corvettes that have a transaxle. 

4WD displays if the vehicle is four-wheel drive. 

Speed limiter is the maximum speed at which the PCM will allow the vehicle to travel. 
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OBD shows the OBD compliance level and should be one of: 

 OBD II (California ARB). 

 OBD (Federal EPA). 

 OBD and OBD II. 

 OBD I. 

 Not OBD compliant. 

 EOBD (Europe). 

 EOBD and OBD II. 

 EOBD and OBD. 

 EOBD, OBD and OBD II. 

 JOBD. 

 JOBD and OBD II. 

 JOBD and EOBD. 

 JOBD, EOBD and OBD II. 
 

 
An interesting side-note is, for vehicles that are not OBD II compliant; there is no 
requirement to report this value correctly. Some non-OBD II compliant vehicles report 
as OBD II compliant when in fact they are not. Obviously these non-compliant vehicles 
cannot be registered in the USA. 

O2 sensors will display the names of the O2 sensors fitted to the vehicle and will be none, one, two 
or more of: 

 O2S11: Bank 1 Sensor 1 (upstream of catalytic converter). 

 O2S12: Bank 1 Sensor 2 (downstream of catalytic converter). 

 O2S13: Bank 1 Sensor 3. 

 O2S14: Bank 1 Sensor 4. 

 O2S21: Bank 2 Sensor 1 (upstream of catalytic converter). 

 O2S22: Bank 2 Sensor 2 (downstream of catalytic converter). 

 O2S23: Bank 2 Sensor 3. 

 O2S24: Bank 2 Sensor 4. 
 

 
Bank 1 is the bank containing cylinder #1. 

For left hand drive vehicles (i.e. USA) that is the driver’s side. 
For right hand drive vehicles (i.e. Australia) that is the passenger’s side. 
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Component Tests 

 

MAF high frequency failures is the number of times the PCM has detected the MAF sensor output 
frequency above an acceptable limit. The PCM will set the MIL once this value is greater than a 
defined limit. Normally only 5 - 10 failures will set the MIL. 

MAF low frequency failures is the number of times the PCM has detected the MAF sensor output 
frequency below an acceptable limit. The PCM will set the MIL once this value is greater than a 
defined limit. Normally only 5 - 10 failures will set the MIL. 

MAF rational tests complete shows the number of times the PCM has tested the MAF sensor. The 
PCM calculates what it would expect the frequency of the MAF sensor to be for a given load. If the 
MAF is off by more than 50%, then the PCM assumes the MAF sensor has failed. 

MAF rational tests failed is the number of times that the MAF failed the rational test. Normally 
about 50 failures per 100 tests will set a MAF related DTC, for example P0101. 

ESC circuit failures is the number of times the knock sensor circuitry has not behaved as expected. 
Eventually a knock sensor related DTC would be set. 
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Fans 

 

Fan type shows the type of fans fitted to the vehicle and should be one of: 

 Series/Parallel Fans. 

 Auxiliary Fan. 

 No Electric Fans. 

Fan1 off/on shows the engine coolant temperatures at which the low-speed fan turns off and on. 

Fan2 off/on shows the engine coolant temperatures at which the high-speed fan turns off and on. 
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PCM Memory 

 

RAM failures is the number of times the RAM in the PCM has failed. 

ROM failures is the number of times the flash ROM checksums (any segment) has failed. 

ROM checksums will fail if any segment in the flash ROM has an incorrect checksum, which may 
also set DTC P0601. An incorrect checksum can be caused by: 

 The PCM being reflashed incorrectly. 

 The PCM being reflashed and the programmer not calculating the correct checksum(s). 

 A real (and potentially dangerous) failure of the flash ROM. 
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Miscellaneous calibration details 

Displays TAP cells from the connected Allison transmission. 

Use the [Copy] button to copy the calibration data to the clipboard. The data is in Microsoft Excel format 
and may be pasted directly into a Microsoft Excel spread sheet. 

Use the [Save] button to save the calibration data to a file. 

Check the [Metric] checkbox to display values in metric, uncheck it to display values in Imperial. 

Click on [Refresh] to update the display with the appropriate units (if you have changed the system 
units). 

TAP Cells 

 

The values displayed are for display purposes only and are not valid TAP cell values 
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BBIIDDIIRREECCTTIIOONNAALL  CCOONNTTRROOLLSS  ––  LLSS11//LLSS66  

LS1/LS6 Control Panel 

 
The control panel is for use by experienced EFI technicians. 

It temporarily overrides the normal operation of the PCM and, if used incorrectly, can 
permanently damage the powertrain and/or the vehicle. 

The auxiliary control panel allows you to take control of various auxiliary systems that are normally 
controlled by the PCM. 
 

 
Do not attempt to use any of these controls to command settings that exceed the 
capabilities of the vehicle! It is possible to destroy vehicle components and cause 
injury to yourself and others if misused! 

 

 

 
Not all overrides are available on all vehicles. Different model years support different 
combinations of override commands. For example, you cannot use Gear and TCC on 
vehicles with manual gearboxes. 

 MIL - Malfunction Indicator Lamp, (also know as Check Engine Light) 
May be used to test if the MIL bulb has burned out. 

 Skip shift lamp – Skip shift  lamp 
May be used to test if the skip shift lamp has burned out. 
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 CC Inhibit - Cruise control inhibit 
Prevent or allow operation of the cruise control system. 

 A/C clutch - Air conditioner clutch 
Manually control the air conditioner clutch regardless of the instrument panel A/C request switch. 

 Fan low – Low-speed electric cooling fan 
Command the electric fan(s) to low speed, unless the "Fan high" control has been set to Y in which 
case the fan(s) will be commanded to high speed. 

 Fan high - High-speed electric cooling fan 
Command the electric fan(s) to high speed. 
 

 
Turning off the fans for an extended period while stationary, will cause your engine 
coolant to overheat. 

 AIR sol - Air injection reaction solenoid 
Commands the air injection reaction solenoid duty cycle to N=0% or Y=100%. 

 AIR pump - Air injection reaction pump 
Command the air injection reaction pump to Y=on, N=off. 

 Fuel pump - Fuel pump 
Command the fuel pump to Y=on, N=off. 
 

 
Turning off the fuel pump will eventually stall the engine due to lack of fuel pressure. 

 Purge sol - Evaporative canister purge solenoid 
Commands the evaporative purge canister's purge solenoid duty cycle to Y=100%, N=0%. 

 Vent sol - Evaporative canister vent solenoid 
Commands the evaporative purge canister's vent solenoid to Y=Open, N-Closed. 

 Closed loop - Closed loop fuel mode 
Commands the PCM's fuel mode to Y=Closed loop, N=Open loop. 

 Fuel learn - Fuel trim learn mode 
Y=Enable fuel learn mode, N=Disable fuel learn mode. 

 Zero fuel trims 
Clears all learned fuel trim cells. It may take multiple driving cycles to relearn the fuel trims. 

For controls with a checkbox and a selection button 

If the checkbox is NOT checked then the Scan Tool will NOT attempt to override the PCM's 
operation of this control. When the checkbox is NOT checked the control is displayed in grey and the 
button text is set to N/A. 

If the checkbox IS checked then the Scan Tool will send the appropriate command to the PCM, 
requesting that the control be commanded according to the button selection – either Yes or No. 

When the checkbox IS checked the control is displayed in red if the button is showing Yes and in 
green if the button is showing No. 
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 Gear - Gear selection 
For automatic transmissions only, selects the desired gear. 

When the Gear checkbox is checked, the Scan Tool sends a command to the PCM to set the 
automatic transmission to the indicated gear. 
 

Gear 
Shift Solenoids 

1-2 (A) 2-3 (B) 

1 On On 

2 Off On 

3 Off Off 

4 On Off 

 

 TCC PWM – Torque converter clutch pulse width modulation solenoid. 
Commands the torque converter clutch PWM solenoid to Y=100%, N=0% duty cycle. The TCC PWM 
solenoid is also known as the TCC apply solenoid. 

 TCC solenoid – Torque converter clutch enable solenoid. 
Enables or disables the TCC PWM solenoid. The TCC solenoid is also known as the TCC enable 
solenoid. 

 3-2 solenoid – 3-2 control solenoid.  
Engages or disengages the 3-2 control solenoid. 
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 PCS current – Pressure control solenoid current.  
Specify the pressure control solenoid current in 10 milliamp (0.01 amp) steps. The PCS solenoid is 
also known as the Trans Force Motor. 
 

 
Use +/- keys to change the desired current in increments of 10 milliamps (0.01 amps) 
Use Ctrl +/- keys to change the desired current in increments of 100 milliamps (0.1 
amps). 

 

PCS Current 
Line Pressure (approx) 

PSI KPa 

0.0A (0mA)  200  to 230 1379  to1586 

0.5A (500mA)  155  to 195 1069  to1344 

1.0A (1000mA)  55  to 85  379  to 586 

 Reverse lockout - Reverse lockout.  
For manual gearboxes only, engages or disengages the reverse lockout solenoid. 

 Skip shift solenoid – Skip shift solenoid.  
For manual gearboxes only, engages or disengages the 1

st
 to 4

th
 skip shift solenoid. The skip shift 

solenoid is also known as the 1-4 solenoid. 



EFILive V7 Scan Tool for GM Vehicles 

support@efilive.com - 148 - www.efilive.com 

 

 Delta spark – Advance or retard spark advance  
The indicated value is added to the PCM’s calculated spark advance. 

 Absolute spark – Command the spark advance  
The indicated value overrides the PCM’s calculated spark advance. 

 
Excessive spark advance may cause destructive knocking. 

 Fuel– Set Air Fuel Ratio  
The Indicated value overrides the PCM’s commanded Air Fuel Ratio. 

 
Changing the PCMs AFR may damage your engine. If the engine is operated too lean 
for too long, excessive combustion temperatures will cause damage to your engine. 

 

 
Use +/- keys to change the selected value by 0.1 
Use Ctrl +/- keys to change the selected value by 1.0 

The “selected” value is the value that has focus. 

 Uncheck all 
Uncheck all is a quick way to release ALL overrides and return full control to the PCM. 
 

 
You may also close the control panel window (F4) to clear and disable bidirectional 
controls. 
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Idle Control 

 

The idle speed settings may be used to find the optimum idle speed for the vehicle. 

Please take the following precautions: 

 Apply the vehicle's parking brake. 

 Close hood. 

 Place transmission in park (auto) or neutral (manual).  

 Keep foot firmly on brake pedal when testing idle speed while in-gear. 

The four monitors will display the following values from the vehicle: 

 Engine Speed - the current engine speed. 

 Desired Idle - the engine speed at which the PCM wants to idle. 

 Throttle Position - the throttle position. 

 IAC Position - the Idle Air Control position. 

 ECT – the Engine Coolant Temperature. 

The four buttons allow you to select the way you want to control the idle speed, they are: 

 RPM (F9) you can adjust the engine's idle speed directly. 

 IAC (F10) you can adjust the Idle Air Control motor position on 1999 and later vehicles. 

 ETC (F11) you can adjust the throttle position on a drive-by-wire vehicle. 

 IAC/98 (F12) you can adjust the Idle Air Control motor position on 1998 and earlier vehicles. 

The two buttons [IAC (F10)] and [ETC (F11)] adjust the same setting in the PCM. 
 

 
Changing the IAC from 0 to 127 has the same effect as changing the ETC from 0 to 
100, except that EFILive limits the maximum ETC override to 15%. 
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Cylinder Balance Test 

 

Sample cylinder balance test showing all cylinders equal 

 

 

Sample cylinder balance test showing potential problem at cylinder 4 
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Please take the following precautions: NOTE: the fans WILL turn ON during this test. 

 Apply the vehicle's parking brake. 

 Close hood. 

 Place transmission in park (auto) or neutral (manual).  

 Keep foot on brake during the test procedure. 

The three monitors will display the following values from the vehicle: 

 RPM - Engine speed must be between 900rpm and 1000rpm. 

 ECT - Engine coolant temperature must be between 150°F and 230°F (65°C and 110°C). 

 IAC/ETC - Idle Air Control or Electronic Throttle Control position. 

The three buttons allow you to select the way you want to control the idle speed, they are: 

 IAC (F10) you can adjust the Idle Air Control motor position on 1999 and later vehicles. 

 ETC (F11) you can adjust the throttle position on a drive-by-wire vehicle. 

 IAC/98 (F12) you can adjust the Idle Air Control motor position on 1998 and earlier vehicles. 

The two buttons [IAC (F10)] and [ETC (F11)] adjust the same setting in the PCM. 
 

 
Changing the IAC from 0 to 127 has the same effect as changing the ETC from 0 to 
100. Except that EFILive limits the maximum ETC override to 15%. 

Click on the [Start test (F3)] button to start the injector balance test. The relative workload of each 
cylinder will be calculated and shown in the horizontal bar chart. 

At any time, click the same button (which will be labeled: [Stop test (F4)] while the test is running) to 
stop the test. 
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Crank Position Sensor Relearn 

 

Please take the following precautions: 

 Apply the vehicle's parking brake. 

 Close hood. 

 Turn off all accessories (including A/C). 

 Place transmission in park (auto) or neutral (manual).  

 Keep foot on brake during the learn procedure. 

 Only one successful learn procedure per ignition cycle is learnt. 

 Once the learn procedure is started, you have 10 seconds in which to complete the test. 

The four monitors will display the following values from the vehicle: 

 ECT - Engine coolant temperature must be between 150°F and 220°F (65°C and 105°C). 

 RPM - Engine speed should be below 2400rpm prior to starting the learn procedure. 

 TPS - Throttle position sensor. 

 VSS - Vehicle speed sensor. 

None of the following diagnostic trouble codes must be set - or the CKP learn procedure will not run: 

 P0335 Crankshaft Position (CKP) Sensor A Circuit 

 P0336 Crankshaft Position (CKP) Sensor A Performance 

 P0341 Camshaft Position (CMP) Sensor Performance Bank 1 Sensor A 

 P0342 Camshaft Position (CMP) Sensor Circuit Low Bank 1 Sensor A 

 P0343 Camshaft Position (CMP) Sensor Circuit High Bank 1 Sensor A 

 P0117 Engine Coolant Temperature (ECT) Sensor Circuit Low 

 P0118 Engine Coolant Temperature (ECT) Sensor Circuit High 

 P1539 Air Conditioning (A/C) Clutch Feedback Circuit High Voltage 

 P1546 Air Conditioning (A/C) Clutch Feedback Circuit Open 

 P0705 Transmission Range (TR) Switch Circuit 

 P0706 Transmission Range (TR) Switch Performance 

 P1810 Transmission Fluid Pressure (TFP) Position Switch Circuit 

 P1825 Internal Mode Switch-Invalid Range 
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Configuration settings 

Delay specifies the delay, in seconds, after the [CKP Learn] button is pressed and before the learn 
procedure is initiated by the Scan Tool. When the specified number of seconds has elapsed the alarm is 
sounded. This lets the operator know to start increasing the engine speed. The delay is useful in cases 
where the computer keyboard and/or mouse are not accessible from inside the vehicle. The learn 
procedure can be started and then the operator has time to enter the vehicle and prepare for the learn 
procedure to begin. If the delay is 0 then no alarm will be sounded and the Scan Tool will initiate the 
learn procedure immediately.  

 The alarm field contains the name of a *.wav file that contains the alarm sound. 

 The [...] button allows the operator to browse for *.wav files. 

 The [Play] button sounds the alarm for testing purposes. 

Relearn Procedure: 

Start the engine and allow it to idle until it has reached operating temperature: 
150°F or 65°C. Once all four monitors have turned green the [CKP Learn] button will be enabled. During 
the learn procedure the four monitors will not be updated. 

 Click on the [CKP Learn (F3)] button - or press the F3 hotkey. 

 If you have configured a delayed start, wait for the delay to elapse. When the delay has elapsed 
the alarm sound will be played and EFILive will initiate the learn procedure. 

 Using the vehicle's accelerator pedal, raise the engine speed to 5,000rpm. The PCM will cut fuel to 
the fuel injectors once the engine reaches the required speed, which may be prior to 5,000rpm. 

 When the fuel injectors are cut, the engine will stumble momentarily, release the throttle 
immediately. The PCM will only cut the injectors for about 1/2 second. 

 Allow the engine speed to drop back to idle. 

 Turn the ignition OFF for at least 15 seconds to allow the PCM to "save" the learned info.
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BBIIDDIIRREECCTTIIOONNAALL  CCOONNTTRROOLLSS  --  AALLLLIISSOONN  

Allison Control Panel 

 
The control panel is for use by experienced EFI technicians. 

It temporarily overrides the normal operation of the Allison TCM and, if used incorrectly, 
can permanently damage the transmission and/or the vehicle. 

The auxiliary control panel allows you to take control of various auxiliary systems that are normally 
controlled by the PCM. 
 

 
Do not attempt to use any of these controls to command settings that exceed the 
capabilities of the transmission or vehicle! It is possible to destroy transmission and 
vehicle components and cause injury to yourself and others if misused! 

 

 

 MIL - Malfunction Indicator Lamp. May be used to test if the transmission controller can successfully 
command the PCM to illuminate the MIL. 



EFILive V7 Scan Tool for GM Vehicles 

support@efilive.com - 155 - www.efilive.com 

 TCC Engage – Engages or disengages the Torque Converter Clutch. 

 Gear - Gear selection 
Selects the desired gear. 

When the Gear checkbox is checked, the Scan Tool sends a command to the TCM to set the 
automatic transmission to the indicated gear. 
 

Gear 
Shift Solenoids 

(C) (D) (E) 

1 Off On Off 

2 Off Off Off 

3 On Off Off 

4 On Off On 

5 Off Off On 

 

TAP Cells 
Clear all TAP cells: Selects all TAP cells to be cleared when [Clear selected cells] is clicked. 
Clear all Garage TAP cells: Selects all Garage TAP cells to be cleared when [Clear selected cells] 
is clicked. 
1->2 TAP: 1->2 upshift TAP cell values will be cleared when [Clear selected cells] is clicked. 
2->3 TAP: 2->3 upshift TAP cell values will be cleared when [Clear selected cells] is clicked. 
3->4 TAP: 3->4 upshift TAP cell values will be cleared when [Clear selected cells] is clicked. 
4->5 TAP: 4->5 upshift TAP cell values will be cleared when [Clear selected cells] is clicked. 
2->1 TAP: 2->1 downshift TAP cell values will be cleared when [Clear selected cells] is clicked. 
3->2 TAP: 3->2 downshift TAP cell values will be cleared when [Clear selected cells] is clicked. 
4->3 TAP: 4->3 downshift TAP cell values will be cleared when [Clear selected cells] is clicked. 
5->4 TAP: 5->4 downshift TAP cell values will be cleared when [Clear selected cells] is clicked. 
Select all: Selects all checkboxes. 
Unselect all: Unselects all checkboxes. 
Clear selected cells: Clears all cells that are selected by the checkboxes above. 
Preset all TAP cells: Presets the TAP cell values to the values specified in the TAP Presets section 
of the EFILive Tuning Tool. 

 

For controls with a checkbox and a selection button 

If the checkbox is NOT checked then the Scan Tool will NOT attempt to override the TCM's 
operation of this control. When the checkbox is NOT checked the control is displayed in grey and the 
button text is set to N/A. 

If the checkbox IS checked then the Scan Tool will send the appropriate command to the TCM, 
requesting that the control be commanded according to the button selection – either Yes or No. 

When the checkbox IS checked the control is displayed in red if the button is showing Yes and in 
green if the button is showing No. 

 
Uncheck all 

Uncheck all is a quick way to release ALL overrides and return full control to the TCM. 
 

 
You may also close the control panel window (F4) to clear and disable bidirectional 
controls. 
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PPRROOPPEERRTTIIEESS  CCOONNFFIIGGUURRAATTIIOONN  

 
At any time, you may revert the property settings to installation defaults. 

Revert the current tab page by clicking on [Recall] or all tab pages by clicking on [Recall 
all]. 

Alternatively, to revert ALL settings to their installation default settings, exit from the Scan 
Tool and delete the entire \\HKEY_CURRENT_USER\Software\EFILive\V7 registry key. 
 

 
Deleting the registry entries will also affect the EFILive Tuning Tool. Do 
not modify the registry entries directly if you are unsure of the 
consequences. 

EFILive will recreate the registry entries with default values the next time it is started. 

 

Connection 

Preferred interface cable type 

Select the preferred cable type. 

If Scan all cable types is checked and the preferred cable cannot be detected then the Scan Tool will 
attempt to detect all other compatible cables. 

Check the Select controller check box to force EFILive to prompt for the controller type prior to 
connecting. 

Preferred COM port 

This option will be hidden whenever the selected cable type is FlashScan and the Scan all cable types 
check box is not checked. Settings in this section are only required for non-FlashScan interface cables. 

Select the preferred COM port from any of COM 1 through COM 9. 

Select the highest baud rate that both the AutoTap interface and the PC support. AutoTap V2 and 
ATUSB interfaces support up to 115200 baud, AutoTap V1 interfaces only support 19200 baud. Some 
older PC’s do not support 115200 baud. Consult the PC’s technical specifications to find out the 
maximum baud rate the PC supports. 

If Scan all COM ports is checked and no cable is detected on the preferred COM port, then all COM 
ports, from COM 1 to Highest COM Port are checked for connected interface cables. 
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Startup 

Startup tasks 

Try to establish an OBD II connection to a vehicle will automatically attempt to connect to a vehicle 
when the Scan Tool is started. We do not recommend checking this option since many times you may be 
starting the Scan Tool simply to load previously recorded log files and do not want to attempt a 
connection to a vehicle. The option was included in the Scan Tool to comply with the auto-connect 
requirement of SAE J1978 for scan tools. 

Warn if vehicle/customer details have not been entered will cause the Scan Tool to display the 
following message if, when it retrieves the VIN, it cannot find a matching <VIN>.cus file containing the 
vehicle/customer details for the connected vehicle. 

 

Collect all OBD II information from vehicle will cause the Scan Tool to execute the equivalent of menu 
option Info->Retrieve all test results. 

Exclude history search when no DTCs are detected will cause the Scan Tool to skip the freeze frame 
history search if no DTCs were detected. There is no apparent reason to search for history data when 
there are no DTCs. 

Always load dashboard file will load the named dashboard. If this option is not checked, EFILive will try 
to load the most recently used dashboard. If EFILive cannot load the required dashboard, it will load the 
appropriate default dashboard (metric or imperial based on your PC’s international settings). If the 
default dashboard cannot be loaded then the dashboard display will remain blank. 

Always load PID file will load the named PID selection file. If this option is not checked, EFILive will try 
to load the most recently used PID file. If the most recently used PID file cannot be loaded, then EFILive 
will load the appropriate default PID selection file (metric or imperial based on your PC’s international 
settings). If the default PID selection file cannot be loaded then the PID selection will remain blank. 
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Logging 

Log files 

Automatically save log file will display a “save file” dialog box when logging is stopped. You may elect 
to save the file or not. 

Prompt for file name will cause a dialog box to be displayed requiring you to accept the default file 
name or enter a new filename. 

Clear log file after auto-saving will clear the log file if you elected to save it. If you do not save the log 
file, the Scan Tool will not clear it. 

Frames allows you to specify how many frames of data you want to reserve for the log file. The Scan 
Tool pre-allocates the log file space prior to logging any data. Log file size is limited only by available 
memory and disk space.  
 

 
Each frame uses “channels”+8 bytes of hard disk space in the logged data file, and 
“charts”*16+8 bytes of the PC’s RAM. 

That means, for example, that 100,000 frames of data (at 24 channels per frame) will take 
approximately: (24+8)*100,000 = 3.2 Mb of disk. 
If you had 4 charts of data it would also take approximately: (4*16+8)*100,000 = 7.2 Mb of 
RAM. 

NOTE: 100,000 frames, at 10 frames per second will log over 2.5 hours of data. 

Priority 2 dynamic packets 

Packets specifies the number of packets reserved for priority 2 PIDs. 

Every [   ] priority 1 frames will cause the Scan Tool to fetch all the priority 2 PIDs after each set of this 
many priority 1 frames. 

Priority 3 dynamic packets 

Packets specifies the number of packets reserved for priority 3 PIDs. 

Every [   ] priority 2 frames will cause the Scan Tool to fetch all the priority 3 PIDs after each set of this 
many priority 2 frames. 

Scan mode 

General. Use general scan mode when you are scanning only one or two PIDs. General scan mode is 
compatible with most OBDII GM vehicles. 

Dynamic will cause the Scan Tool to use dynamic packets to transfer PID data up to 6 times faster than 
scanning single PIDs. 

Steam-Slow if supported will cause the Scan Tool to use the Stream-Slow scan mode. 

Steam-Fast if supported will cause the Scan Tool to use the Stream-Fast scan mode. 
 

 
Stream-Fast is the default-scanning mode when the Scan Tool is installed. 
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Auto-save meta data 

DTC’s when checked, any detected DTCs will be automatically saved in the log file. 

LTFT cells when checked, LTFT cells (if retrieved) will be automatically saved in the log file. 

Miscellaneous info when checked, miscellaneous info (if retrieved) will be automatically saved in the 
log file. 

Auto adaptive shift cells when checked, LS1/LS6 auto adaptive shift cells (if retrieved) will be 
automatically saved in the log file. 

Allison adaptive shift cells when checked, Allison adaptive shift cells (if retrieved) will be automatically 
saved in the log file. 



EFILive V7 Scan Tool for GM Vehicles 

support@efilive.com - 160 - www.efilive.com 

Options 

General 

Display short parameter descriptions will force the Scan Tool to display the PID’s caption (from the 
[Data (F8)] tab page) instead of the description. 

Strikeout non-selected PIDs will cause the Scan Tool to draw a line through the PID name and units 
(on the dashboard items) of any PID that is not currently selected. No data will be displayed for such 
PIDs. If this option is unchecked, then the Scan Tool will display unselected PIDs as XXX. 

Privatize VIN and registration will prevent VIN sequence numbers from being stored in the log files. 
The sequence number is the last 6 digits of the VIN and can be used to uniquely identify the vehicle. 
 

 
The VIN sequence number will be replaced by xxxxxx. 

For example the VIN 6H8VTK69FYL123456 has a sequence number of 123456. With 
this option checked the VIN would be stored in the logged data files as 
6H8VTK69FYLxxxxxx. 

When searching for a matching customer (*.cus) file, the Scan Tool will search in this 
order: 

1. 6H8VTK69FYL123456.cus 
2. 6H8VTK69FYLxxxxxx.cus 

Active module detection will cause the Scan Tool to issue a module “reset” command when attempting 
to detect on board modules. Some modules may perform pre-determined "reset" functions when probed. 
(i.e. radio volume and/or climate control settings may be reset). 
Normally, the Scan Tool will only issue a “request DTCs” command when attempting to detect on board 
modules. Usually a module will respond with DTC P0000 if no trouble codes are set, which means the 
Scan Tool will detect the module as being present. However, it is also acceptable for a module to ignore 
a DTC request if no DTCs are set, which means the Scan Tool may not detect that module as being 
present. 

Disable confirmation dialogs turns off confirmation dialog boxes. This makes it faster to navigate 
through the Scan Tool, but easier to lose data because… 
 

 
You will not be warned that you may have forgotten to save data. The data will be silently 
and permanently discarded. 

Link PIDs and dashboards Automatically search for and load the dashboard whose name matches the 
loaded PID file. 

Menu height limits the vertical size of popup menus. Sometimes popup menus are too big vertically to fit 
on the screen. This option lets you specify the maximum number of menu entries that the Scan Tool will 
allow before splitting the menu into multiple columns. 

Charts 

Link to maps will cause the maps to be re-plotted each time a range of data is selected or unselected in 
the charts. This process can be time consuming for large data files. If you uncheck this option, use the 
re-plot toolbar icon on the Map Toolbar to manually re-plot the maps after any change to the data 
selection. 

Scroll bar moves chart inspector will cause the chart inspector to move with the scroll bar. If this 
option is not checked the chart inspector remains on the current frame even when that frame is scrolled 
out of view. 
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Scan tool startup options 

Resize scan and tune windows will cause the Scan Tool window to resize so that it and the Tuning 
Tool window are both visible when the Tuning tool is started from within the Scan Tool. 

Size determines the vertical percentage of the screen occupied by the Scan Tool. 

Preferred unit system 

Imperial will cause the Scan Tool to default to Imperial units where applicable. 

Metric will cause the Scan Tool to default to Metric units where applicable. 

Dashboards 

Autosize dashboard items will cause all dashboar ditems to be automatically resized whenever the 
dashpage changes size. On slow PC’s this can be distracting. If this option is disabled, you can manually 
resize all dashboard items using the Ctrl+F hotkey. 

CTRL keeps aspect ratio means you can hold the CTRL key down while resizing dashboard items to 
preserve the item’s aspect ratio. 

Dashboard aspect ratio specifies the aspect ratio that the Scan Tool will use to resize all the items on 
each dashboard regardless of the screen resolution or window size. 
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Display 

Application font 

Change the application wide font by clicking on the [Font] button. Do not select font sizes larger than 
about 12 points. 

Tab pages 

Allow tab pages to be undocked from the main window. 
If this option is checked then dash pages F8 through F12 can be dragged off of the main window. 
Sometimes, when using laptops with touch pads tab pages can be accidentally undocked. Uncheck this 
option to prevent unwanted tab page docking. 

Onboard information 

Select which OBDII tab pages will automatically retrieve the onboard information when you select its sub 
page on the [OBD II (F7)] tab page. To manually retrieve onboard information use the Info menu, the 
appropriate hotkeys or toolbar buttons. 
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Console 

Text colors and fonts 

Select the type of text (from the list box) and then set its font and color. 

Message display 

Buffer size sets the number of lines of history that the console retains. The larger the number, the more 
memory the Scan Tool uses to store the history. 

Console display enabled enables the console display. On very slow PC’s it may be necessary to 
disable the console to free up some CPU cycles to help keep data logging speeds up. 

Pop-up error messages will cause the Scan Tool to display a dialog box whenever an error is detected 
that will require you to click [Ok] before proceeding. Only check this option when you need to see an 
error that would otherwise scroll off the console display too quickly to see. It should be unchecked (not 
enabled) for general use. 

Include timestamp on messages causes each message written to the console to be stamped with a 
timestamp that is accurate to 10ms on Win2K/WinXP and accurate to about 50ms on Win95/98/Me. 

Display warning messages will cause the Scan Tool to display warnings that it would otherwise 
suppress. For example if a message collision occurred on the class-2 network, the Scan Tool may need 
to resend the message. Usually no warning would be displayed to the user because message collision 
arbitration is part of the normal class-2 network design. If this option were checked the Scan Tool would 
display a warning if it had to resend the request. 
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Playback 

Playback speed 

Sets the default playback speed. The center position attempts to playback the same speed at which the 
log file was recorded. Left of the center is slower than real time; right of the center is faster than real 
time. 

Loop playback causes the log file to be replayed continuously. 

Frame times 

Max pause is the number of milliseconds to pause, when a large time gap is detected in the log file’s 
timeline. For example: while recording, the log may have been paused for 5 minutes. If the Scan Tool 
were attempting to reproduce the exact playback speed that was recorded, then playback would also 
pause for 5 minutes. Instead, the Scan Tool only pauses for this many milliseconds. 

Show frame times in hh:mm:ss displays the absolute time each frame was recorded. If this option is 
unchecked, the Scan Tool displays the frame time in elapsed seconds since the start of the log file. This 
does not affect how the time is recorded in the log file, only how it is displayed during recording and 
playback. 

Display update frequency 

Update display every: n frames, determines how often the charts are visually updated. The lower you 
set this value, the more often they are updated and the more load is placed on the CPU, which may 
cause data frames to be dropped on slower PCs. Setting this value to a larger value will place less load 
on the CPU, but the charts will not scroll as smoothly. 

When checked, Automatic will cause the display update frequency to be adjusted when EFILive detects 
that the PC is not keeping up with the incoming data. You can monitor the automatic adjustments in the 
Display value in the Profile window (Ctrl+Y).  

Charts: 

Auto re-plot limit specifies the maximum number of frames that a log file may have and still be 
automatically redrawn by the Scan Tool. This is to prevent time consuming chart re-plots for large log 
files. 

Arrow key scrolls specifies the number of frames that the Arrow keys will move the chart inspector. 

Ctrl+Arrow key scrolls specifies the number of frames that the Ctrl+Arrow keys will move the chart 
inspector. 
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Printing 

Diagnostic information 

Titles will cause each report’s title to be included in the printout. 

Description will cause each report’s description to be included in the printout. 

When the following options are checked, the corresponding data from the [OBD II (F7)] tab page is 
included when the Print all reports option is selected. 

 Summary will include the [Summary] sub page details. 

 PCM Info will include the [PCM] sub page details. 

 Parameters will include the [PIDs] sub page details. 

 Modules will include the [MODs] sub page details. 

 SRT (EPA) will include the [SRT] sub page details. 

 SMS will include the [SMS] sub page details. 

 O2 will include the [O2] sub page details. 

 S1 only will only include the O2 sensor 1 details. (Because the second set of O2 sensors (where 
fitted) are only used to monitor cat efficiency, their test results are not particularly useful.) 

 DTC will include the [DTC] sub page details. 

 History will include the [FF] sub page details. 

OBD II data will include the current frame’s data from the [Data (F8)] tab page. 

Console will include the entire console text display. 

LTFT will include the LS1/LS6->Long term fuel trim cells data. 

Calibrations will include the LS1/LS6->Miscellaneous calibration information. 

Images 

Dash-A will include a snapshot of Dash-A. 

Dash-B will include a snapshot of Dash-B. 

Dash-C will include a snapshot of Dash-C. 

White background will process the dashboard images and perform the following: 

 Any pixel whose RGB components add up to 200 or less will be converted to white. 

 Any pixel whose RGB components add up to more than 565 will be converted to black. 

Increase contrast will cause all pixels not changed to black or white to be reduced in brightness by 
17%, this has the effect of making bright colors less vivid, but easier to see on white paper.  

Cylinder balance test will print the cylinder balance test results (if one has been completed). The 
cylinders, along with their associated RPM values, are listed in order of weakest to strongest. 
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 Folders 

Use this tab page to specify the folders where you would like to store different configuration and data 
files used by the Scan Tool. If you do change a folder, you may need to copy the files from the old folder 
to the new one. 

To change a folder, click on the [Browse] button and select the new folder. 

Some folders can be marked with the following icon: [ ]. Folders so marked will “remember” the folder 

where the most recently saved or loaded file was from, and will return to that folder next time you wish to 
load or save a file of the same type. 

Folders that cannot be configured to “remember” are: 

 Temporary cache 

 Configuration 

 Export layout 

 PIDs 

 Vdash 

 Calibrations 
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Template for auto-generated folder can be set up to force EFILive to create subdirectories in which to 
store logged data. If a template is specified then the “remember last used” folder option for logged data 
files will be disabled. Otherwise EFILive would create subfolders within subfolder while attempting to 
save successive log files in the “last used folder”. 
 

 
The folder template is ONLY used when saving logged data. It has no effect on other types 
of saved data. 

Template for auto-generated filenames is used to instruct the Scan Tool how to format automatically 
generated filenames. The Scan Tool will automatically generate a filename in the following 
circumstances: 

 When saving a logged data file. 

 When saving a report. 

 When saving miscellaneous calibrations. 

 When saving long term fuel trim cell values. 

Whatever text you enter will be used to construct the filenames. The Scan Tool provides tags that can be 
embedded in the template. These tags will be replaced with the appropriate value when the filename is 
generated. Once all substitutions have been made, the Scan Tool will collapse multiple underscore 
characters to single underscores. 

 

Tag Will be replaced by 

<id>  Log – when saving a log file. 

 Prt – when saving a report. 

 CalLtft – when saving long term fuel trim cell values. 

 CalMisc – when saving miscellaneous calibrations. 

<seq> An automatically generated sequence number that guarantees the file 
will have a unique name. 

<cn> The customer name as specified in the Vehicle/Customer details 
window. If the customer name is blank, then the <cn> tag is ignored. 

<reg> The vehicle registration as specified in the Vehicle/Customer details 
window. If the vehicle registration is blank, then the <reg> tag is 
ignored. 

<vin> The vehicle identification number. 

<name> The name specified in the customer details window. 

<cc> 
<yy>, <mm> and <dd> 

The current century which will be “20”. 
The current year, month and day. 

<hh>, <mi> and <ss> The current hour, minute and second. 

 

Example Templates Generated filename 

If saving a logged data file and customer name=”John Smith” and vehicle registration=”ABC123” 

<id><cn><reg><seq> Log_John Smith_ABC123_0001.efi 

DynoRun_<yy><mm><dd><seq> DynoRun_030928_0001.efi 
You may include plain text, like “DynoRun” and it will be 
included as part of the filename. 

<cn>_FuelTrimTest_<seq> John Smith_FuelTrimTest_0001.efi 

If saving a report file and customer name is blank and vehicle registration is ABC123 

<id><cn><reg><seq> Prt_ABC123_0001.rpt 

 

 
Do not include a three-character filename extension in the template. The Scan Tool will 
automatically add the appropriate extension. 

Insert tag is used to insert the selected tag into the Filename template field. 
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Notes 

Notes 

Specify the description for each of the 10 possible notes that can be attached to any frame in the log 
files. 

The note description will appear in the “Frame” display at the bottom left of the Scan Tool window. 
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Advanced 

Comms 

Error retries is the number of times the Scan Tool will retry sending a command to the PCM after it has 
exhausted all other means to communicate with the vehicle. 

Retry delay is the number of milliseconds to wait before retrying a failed message. 

Throttle is the number of milliseconds that must elapse between consecutive messages sent by the 
Scan Tool onto the class-2 data bus. Previously the SAE recommended value was always 100ms. With 
the release of the OBD II, 2003 update the SAE have changed that recommendation to: 
 
SAE J1979 Section 4.1.3.2  

SAE J1850 – Minimum Time Between Requests from External Test Equipment – For SAE J1850 
network interfaces, [the] external test equipment shall always wait for a response message from the 
previous request, or a “no response” time-out [of 100ms] before sending another request message. If 
the number of response messages is known and all responses have been received then the external 
test equipment is permitted to send the next request immediately. 
Reprinted with permission from SAE HS 3000/2003 © 2003 SAE International. 

Which means that it is now acceptable to set the message throttle to zero (in the appropriate 
circumstances) and still be SAE J1979 compliant. 

Poll priority sets the “keep alive” message priority for Steam scan modes and bidirectional controls. We 
recommend leaving this at 3, unless advised to change it by EFILive support. 

Diagnostic trouble codes 

Exclude is a comma-separated list of DTCs that you do not want to consider as malfunctions. The Scan 
Tool will ignore any DTC that is listed here. 

Check/Clear DTCs for all modules will cause the Scan Tool to check and clear trouble codes from all 
modules listed in the [OBD II (F7)] tab page [MODs] sub page. 

Display DTCs allows you to select which type of DTCs you want the Scan Tool to retrieve and which 
type of DTCs you want to ignore. 

If you select Old and/or Immature codes then you will likely see a lot of trouble codes. Do not be 
alarmed; they are not “real” trouble codes. 
On Old trouble code is a code that was once responsible for illuminating the MIL but is no longer. 
An Immature trouble code is one that has not met ALL the criteria to be classed as a current, nor 
pending trouble code. 
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AAPPPPEENNDDIIXX--AA  

GGLLOOSSSSAARRYY  

ABS 
Antiskid/Antilock Braking System. 

AKA 
Also Known As. 

ALDL 
Assembly Line Diagnostic Link. This connector was GM ’s predecessor to OBD-II. It operates at 8192 
baud and uses a pseudo serial RS232 protocol. It is not compatible with OBD-II. 

BCC 
Broadcast Code. 

BCM 
Body Control Module. 

Bidirectional 
Bidirectional is the ability of the scan tool to send commands to the PCM that override the PCM’s normal 
operating parameters. 
 
Non-bidirectional scan tools are passive, displaying data and trouble codes. 

Bit 
A bit is the smallest unit of storage used by digital computer systems. A bit can be on or off, representing 
a numeric 1 or a numeric 0. 

Bitmap image 
A bitmap image is a popular image encoding strategy. Bitmap images are usually stored in files ending 
with a .bmp extension. 

Byte 
Byte is a measure of storage used by digital computer systems. It is a group of 8 bits, and can store one 
value from a set of 256 possible values. The range is from 0 to 255 inclusive. 

Calculated PIDs 
Calculated PIDs are derived from existing PIDs by evaluating user supplied mathematical equations. 

CAA 
U.S. Federal Clean Air Act which was amended in 1990 to include all California (and other state)  
requirements, as well as other non vehicle environmental regulations. 

CAN 
Controller Area Network is the new standard for automotive communications protocols. GM will begin 
fully implementing CAN in some of its 2004 models. The EFILive Scan Tool will implement the CAN 
protocol in second half of 2005. 
The CAN specification is ISO 15765-4. 
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CARB 
California Air Resources Board. Created to control air pollution in the US state of California. Assisted the 
US Government in creating the Clean Air Act, which controls air pollution over the entire USA. 

Chart 
Charts are a graphical representation of the data logged by the Scan Tool, with respect to time. 

Chart inspector 
The chart inspector is the vertical line that moves over the charts, under the control of mouse or 
keyboard. The current frame is defined by the chart inspector’s position on the charts. 

Class-2 
GM’s implementation of Class B networking. 

Class A network 
Low speed data link, <10K bits/second. 
Often used for convenience features (entertainment, audio, trip computer, etc.). 
 
Most Class A functions require inexpensive, low-speed communication and typically utilize generic 
UARTs. These functions are proprietary and have not been standardized by the international 
organizations. 

Class B network 
Medium speed data link, (10K bits/second to 125K bits/second). 
Often used for general information transfer (instrument cluster, vehicle speed, legislated emissions data, 
etc.) 
SAE J1850 and ISO 9141-2 are used to implement Class B networks. 

Class C network 
High Speed (125K b/s to 1M b/s or greater). 
 
Often used for real time control (powertrain control, vehicle dynamics, brake by wire, etc.), 
CAN is used to implement class C networks. 

Connect 
To connect to a vehicle means that the Scan Tool has sent a message to the vehicle and successfully 
determined which OBD II protocol is in use. 

COMx 
Windows serial RS232 communications port x. 

Console 
The console is a tab page on the main window on which the Scan Tool displays text messages. 

CSV 
Comma Separated Values. It is the file format that the Scan Tool uses to export data to Microsoft Excel. 
Many other applications can also accept *.csv format files. 

CPU 
Central Processing Unit. This is the hardware chip that controls and processes the information in a 
microcomputer such as a vehicle’s PCM and a Windows PC. 

DB9 
Describes the shape of the 9 pin serial RS232 connector. 
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DMA PIDs 
The Scan Tool extracts DMA PIDs directly from the PCM’s operating RAM. Not all DMA PIDs are 
available on all PCMs. 

Drive-by-wire 
A throttle actuation system that is controlled electronically rather than mechanically.  There is no throttle 
cable or direct connection from the accelerator pedal to the throttle blade in this system. 

Dropped frame 
A dropped frame may occur when you are using the Stream scan modes. These two scan modes send 
data at a fixed rate, determined by the PCM. The OBD II protocol does not provide for any flow control 
between vehicles and scan tools. If the PC cannot “keep up” with the data arriving from the PCM then 
frames will be dropped (discarded by the Scan Tool) to prevent buffer overflows that would result in 
corrupt data. 

DTC 
Diagnostic Trouble Code. There are literally thousands of different trouble codes. Whenever a 
malfunction is detected by the PCM, it is usually recorded, and if the fault is emissions related, it will 
illuminate the MIL (or check engine light) on the vehicle’s dashboard. 

ECM 
Engine Control Module. The main computer that controls the engine’s electronic fuel injection system. 

Enhanced PIDs 
PIDs provided by the manufacturer, in addition to the legislated, diagnostic PIDs (generic PIDs). 

EOBD 
European On Board Diagnostics. 

FAQ 
Frequently Asked Questions. 

FFTC 
Freeze Frame Trouble Codes. Sometimes when a fault is detected the ECM / PCM will record tens of 
other parameter values at the time the fault was detected. These parameter values can be useful in 
diagnosing the cause of the fault. 

Frame 
Data is logged as a series of frames. Each frame contains one item of data for each selected PID. 

Gauge 
Gauges are the analog/digital dials that appear on the Scan Tool’s virtual dashboard. Sometimes all of 
the items that can be placed on the virtual dashboard: gauges, charts and status items are collectively 
referred to as gauges. 

Generic PIDs 
USFCAA legislated PIDs that must be provided by all OBD II compliant PCMs. 

GM 
General Motors. www.gm.com 

GM-H 
General Motors Holden (Australia). www.holden.com 

http://www.gm.com/
http://www.holden.com/
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HVAC 
Heating, Ventilation and Air Conditioning. 

IAC 
Idle Air Control. The idle air control is an electronically controlled valve that opens and closes to allow 
more or less air to bypass the throttle blade. The ECM / PCM uses the idle air control to (obviously) 
control the idle speed of the engine. 

Icon  
An icon is a small picture, usually no bigger than 16x16 or 32x32 pixels. It is used as a visual cue for 
some action. Normally you either click or double click an icon to execute the action that it represents. 

ISO 
International Standards Organization. www.iso.org 

ISO 14230-4 
Keyword 2000 protocol. 

ISO 9141-2 
An OBD-II protocol that uses a signal similar to RS232. 

ISO 15765-4 
High speed CAN. 

KW2000 
Keyword 2000 protocol. 

LS1 
GM’s identification code for for one of its new GENIII 5.7-liter V8 engines. It was introduced with the 
1997 Corvette.  For the 2001 Corvette application this engine featured 345HP @ 5,600 rpm and (SAE 
net) 350 lb.ft. @ 4400 rpm. 

LS6 
GM’s identification code for one of it’s newer GENIII 5.7-liter V8 engines. It is similar to the LS1, but has 
minor enhancements for additional power.  It was introduced in 2001, for the ZO6 Corvette at  385 @ 
6,000 rpm  385 lb.ft. @ 4,800 rpm.  For the newer Corvettes, performance has been increased to 405HP 
@ 6000 rpm and (SAE net) 400 lb.ft. @ 4800 rpm. 

MAF 
Mass Air Flow. 

MAP 
Manifold Absolute Pressure. 

MHz 
Megahertz (millions of cycles per second). 

MIL 
Malfunction Indicator Lamp. This lamp is illuminated whenever an emission related DTC is detected. 
Note that a FLASHING MIL indicates a potential dangerous condition, and must be attended to 
IMMEDIATELY. See your owner’s manual for more information. 

http://www.iso.org/
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Millisecond 
1 millisecond is 1/1000

th
 of 1 second; 500 milliseconds is ½ of 1 second; 1000 milliseconds is 1 second. 

The abbreviation for millisecond is ms. 

OBD 
On Board Diagnostics. 

OBD I 
On Board Diagnostics level I. 

OBD II 
On Board Diagnostics level II. 

PID/PRN 
Parameter Identifier or Parameter Reference Number. A single unit of information that may be retrieved 
from the ECM/PCM. 

PCM 
Powertrain Control Module. The main computer that controls the engine’s electronic fuel injection system 
AND the electronic automatic transmission. 

Properties 
The properties editor window that can be opened using: 

 
File->Properties 

[ ] Properties 

 
Alt+Enter 

Profiler 
The profiler window that displays the current scan mode, the current scan speed, the time remaining in 
the log file and the amount of CPU idle time. It can be displayed using: 

 
View->Profile window 

 
Ctrl+Y 

PTC 
Pending Trouble Code. 

PWM 
Pulse Width Modulation. An OBD II protocol used by Ford. The waveform differentiates between binary 
0’s and 1’s by altering the state (active or passive) of each pulse. 

RAM 
Read/write, random access memory used to store constantly changing data. 

ROM 
Read only memory, used to store programs and preset information. 



EFILive V7 Scan Tool for GM Vehicles 

support@efilive.com - 175 - www.efilive.com 

RPM 
Revolutions Per Minute. Used to measure engine speed. 

RS232 
Serial communications protocol available on most PC’s and laptops. 

SAE 
Society of Automotive Engineers. www.sae.org 

SAE J1850 
Standard definition of the frame structure for the VPW and PWM communications protocols. 

SAE J1930 
Terms and definitions. 

SAE J1962 
Diagnostic connector. 

SAE J1978 
Standard definition of an OBD-II scan tool. 

SAE J1979 
Standard definition of diagnostic test modes – functional addressing. 

SAE J2012 
Diagnostic trouble codes. 

SAE J2190 
Standard definition of diagnostic text modes – physical addressing. 

SAE J2284 
High speed CAN. Superceded by ISO 15765-4. 

Scan mode Stream-Slow  
Streaming, dynamic packet transfer method where the PCM continuously sends 4 or 5 frames, each of 4 
dynamic packets (24 channels) per second. 

Scan mode Stream-Fast  
Streaming, dynamic packet transfer method where the PCM continuously sends 8 or 10 frames, each of 
4 dynamic packets (24 channels) per second. 

SLOT 
SLOT is an acronym for Scaling, Limit(s), Offset and Transfer function. SLOT is explained in SAE J2178-
2 section 9. It collectively refers to the information required to convert raw PID data from the PCM’s 
internal binary representation into engineering (real world) units. 
EFILive’s PID definition file is built on the SAE J2178-2 SLOT concept. The generic SLOTs defined in 
SAE J2178-2 are used verbatim in the <install_folder>\Configuration\sae_generic.txt configuration file. 

SRS 
Supplemental Restraint System. Includes air bags, seatbelt pretensioners and other restraint systems. 

http://www.sae.org/
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Status 
A status display is a special dashboard item that can display certain types of PIDs. Status items display 
on/off or enumerated values. For example air conditioner clutch “engaged” or “disengaged”.  

Tab page 
Tab pages are used extensively in the Scan Tool. 

 

In this image the tab pages are [OBD II (F7)], [PIDs (F8)], [Data (F9)], [Dashboard (F10)], [Maps 
(F11)] and [Console (F12)]. 
The [OBD II (F7)] tab page has eight sub pages: [Summary] through [FF]. 

TPS 
Throttle Position Sensor. 

USB 
Universal Serial Bus. A new serial protocol that is replacing RS232 on many PCs and laptops. If the 
laptop does not have a serial RS232 connector and is only fitted with USB connectors then you will need 
to use a USB to serial RS232 converter for VIA and AutoTap serial interfaces only. 

USFCAA 
See CAA. 

VIN 
Vehicle Identification Number. 

VPW 
Variable Pulse Width is an OBD-II protocol used by GM. The waveform differentiates between binary 0’s 
and 1’s by altering the width (or the length) of each pulse as well as the state (active or passive) of the 
pulse. 

X-Axis  
The horizontal axis of the charts, that displays frame numbers. Each chart has only one x-axis, however 
since all charts x-axis are synchronized, it is only necessary for one chart per dashboard tab page to 
display an x-axis. 

Y-Axis 
The vertical axis of the charts, that displays each PID’s range of values. Each chart can have up to 4 y-
axis. 

ZIP 
Compressed computer file. www.winzip.com

http://www.winzip.com/
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AAPPPPEENNDDIIXX--BB  

SSAAEE  CCOOMMPPLLIIAANNCCEE  

SAE J1978 OBD II Scan Tool 

The SAE J1978 specification defines what features an OBD-II scan tool should have, the following table 
lists the feature set of the Scan Tool. 
 

Feature EFILive 

Automatic, hands-off determination of the communications interface used. 
 

Obtaining and displaying the status and results of on-board vehicle diagnostic 
evaluations.  

Obtaining and displaying OBD II emissions related DTC. 
 

Obtaining and displaying OBD II emissions related current data. 
 

Obtaining and displaying OBD II emissions related FFTC. 
 

Clearing the storage of OBD II emissions related DTC and FFTC and tests' status. 
 

Obtaining and displaying OBD II emissions related test parameters and results as 
described in SAE J1979.  

Provide a user manual or help system. 
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SAE J1979 Generic Parameters 

The Scan Tool supports all of the SAE J1979 emissions related parameters; they are listed in the 
following table. 
 

SAE J1979 - 1999 

EFILive PID Name PID Description 

SAE.PIDs PIDs Supported ($01..$20) 

SAE.MONDTC Monitor status since DTCs cleared 

SAE.DTCFRZF DTC that caused required freeze frame data storage 

SAE.FUELSYS Fuel system status 

SAE.LOAD_PCT Calculated LOAD Value 

SAE.ECT Engine Coolant Temperature 

SAE.SHRTFT1 Short Term Fuel Trim - Bank 1 

SAE.LONGFT1 Long Term Fuel Trim - Bank 1 

SAE.SHRTFT2 Short Term Fuel Trim - Bank 2 

SAE.LONGFT2 Long Term Fuel Trim - Bank 2 

SAE.FRP Fuel Rail Pressure (Gauge), GM’s LS1 does not support this PID 

SAE.MAP Intake Manifold Absolute Pressure 

SAE.RPM Engine RPM 

SAE.VSS Vehicle Speed Sensor 

SAE.SPARKADV Ignition Timing Advance for #1 Cylinder 

SAE.IAT Intake Air Temperature 

SAE.MAF Air Flow Rate from Mass Air Flow Sensor 

SAE.TP Absolute Throttle Position 

SAE.AIR_STAT Commanded Secondary Air Status 

SAE.O2SLOC Location of Oxygen Sensors 

SAE.O2S11 Oxygen Sensor Bank 1 - Sensor 1 

SAE.O2S12 Oxygen Sensor Bank 1 - Sensor 2 

SAE.O2S13 Oxygen Sensor Bank 1 - Sensor 3 

SAE.O2S14 Oxygen Sensor Bank 1 - Sensor 4 

SAE.O2S21 Oxygen Sensor Bank 2 - Sensor 1 

SAE.O2S22 Oxygen Sensor Bank 2 - Sensor 2 

SAE.O2S23 Oxygen Sensor Bank 2 - Sensor 3 

SAE.O2S24 Oxygen Sensor Bank 2 - Sensor 4 

SAE.OBDSUP OBD Requirements to which vehicle is designed 

SAE.O2SLOC_B Location of Oxygen Sensors (B) 

SAE.AUXIS Auxiliary Input Status 
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SAE J1979 parameters added - 2003 

EFILive PID Name PID Description 

SAE.RUNTM Time Since Engine Start 

SAE.MIL_DIST Distance Traveled While MIL is Activated 

SAE.FRP_B Fuel Rail Pressure Relative to Manifold Vacuum 

SAE.FRP_C Fuel Rail Pressure 

SAE.WO2S11 Oxygen Sensor (Linear or Wideband) Bank 1 - Sensor 1 

SAE.WO2S12 Oxygen Sensor (Linear or Wideband) Bank 1 - Sensor 2 

SAE.WO2S13 Oxygen Sensor (Linear or Wideband) Bank 1 - Sensor 3 

SAE.WO2S14 Oxygen Sensor (Linear or Wideband) Bank 1 - Sensor 4 

SAE.WO2S21 Oxygen Sensor (Linear or Wideband) Bank 2 - Sensor 1 

SAE.WO2S22 Oxygen Sensor (Linear or Wideband) Bank 2 - Sensor 2 

SAE.WO2S23 Oxygen Sensor (Linear or Wideband) Bank 2 - Sensor 3 

SAE.WO2S24 Oxygen Sensor (Linear or Wideband) Bank 2 - Sensor 4 

SAE.EGR_PCT Commanded EGR 

SAE.EGR_ERR EGR Error 

SAE.EVAP_PCT Commanded Evaporative Purge 

SAE.FLI Fuel Level Input 

SAE.WARM_UPS Number of warm-ups since DTCs cleared 

SAE.CLR_DIST Distance traveled since DTCs cleared 

SAE.EVAP_VP Evap System Vapor Pressure 

SAE.BARO Barometric Pressure 

SAE.WO2S11_B Oxygen Sensor (Wideband) Bank 1 - Sensor 1 

SAE.WO2S12_B Oxygen Sensor (Wideband) Bank 1 - Sensor 2 

SAE.WO2S13_B Oxygen Sensor (Wideband) Bank 1 - Sensor 3 

SAE.WO2S14_B Oxygen Sensor (Wideband) Bank 1 - Sensor 4 

SAE.WO2S21_B Oxygen Sensor (Wideband) Bank 2 - Sensor 1 

SAE.WO2S22_B Oxygen Sensor (Wideband) Bank 2 - Sensor 2 

SAE.WO2S23_B Oxygen Sensor (Wideband) Bank 2 - Sensor 3 

SAE.WO2S24_B Oxygen Sensor (Wideband) Bank 2 - Sensor 4 

SAE.CATEMP11 Catalyst Temperature Bank 1 - Sensor 1 

SAE.CATEMP21 Catalyst Temperature Bank 2 - Sensor 1 

SAE.CATEMP12 Catalyst Temperature Bank 1 - Sensor 2 

SAE.CATEMP22 Catalyst Temperature Bank 2 - Sensor 2 

SAE.MONDRIVE Monitor status this driving cycle 

SAE.VPWR Control Module Voltage 

SAE.LOAD_ABS Absolute Load Value 

SAE.EQ_RAT Commanded Equivalence Ratio 

SAE.TP_R Relative Throttle Position 

SAE.AAT Ambient Air Temperature 

SAE.TP_B Absolute Throttle Position (B) 

SAE.TP_C Absolute Throttle Position (C) 

SAE.APP_D Accelerator Pedal Position (D) 

SAE.APP_E Accelerator Pedal Position (E) 

SAE.APP_F Accelerator Pedal Position (F) 

SAE.TAC_PCT Commanded Throttle Actuator Control 

SAE.MIL_TIME Minutes run by engine while MIL activated 

SAE.CLR_TIME Time since DTCs Cleared 
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SAE J1979 E/E Diagnostic Test Modes 

Mode Description   

$01 Request Current Powertrain Diagnostic Data 
   

$02 Request Powertrain Freeze Frame Data  
 

$03 Request Powertrain Diagnostic Trouble Codes 
   

$04 Request to Clear/Reset Diagnostic Trouble Codes 
   

$05 Request O2 Sensor Monitoring Test Results 
 

 

$06 Request On-Board monitoring Test Results 
 

 

$07 Request Pending Powertrain Diagnostic Trouble Codes 
   

$08 Request Device Control  
 

$09 Request Vehicle Information  
 

  EFILive uses the standard SAE J1979 diagnostic mode. 

  EFILive uses the manufacturer’s enhanced mode. 
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SAE J1962 OBD II connector 

 

OBD II pin out specification 

Pin Description 

1 Single wire CAN* 

2 Bus positive Line of SAE-J1850 

3 Discretionary* 

4 Chassis ground 

5 Signal ground 

6 CAN_H line of ISO 15765-4 

7 K line of ISO 9141-2 and ISO 14230-4 

8 Discretionary* 

9 Discretionary* 

10 Bus negative Line of SAE-J1850 

11 Discretionary* 

12 Discretionary* 

13 Discretionary* 

14 CAN_L of ISO 15765-4 

15 L line of ISO 9141-2 and ISO 14230-4 

16 Permanent positive voltage 

* The assignment of these pins is left to the discretion of the vehicle manufacturer. 
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AAPPPPEENNDDIIXX--CC  

FFIILLEE  FFOORRMMAATTSS  

Configuration files 

sae_generic.txt 

The format of this file is explained in the file itself. Use a text file editor to load the file and read the inline 
comments. 

calc_pids.txt 

The format of this file is explained in the file itself. Use a text file editor to load the file and read the inline 
comments. 

vin.ini 

The format of this file is explained in the file itself. Use a text file editor to to load the file and read the 
inline comments. Vin.ini is a standard Windows ini file. 

gm_enhanced.prn 

Encrypted data – this file cannot be modified. 
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AAPPPPEENNDDIIXX--DD  

RREECCOOVVEERRIINNGG  AA  LLOOGG  FFIILLEE  AAFFTTEERR  CCOOMMPPUUTTEERR  FFAAIILLUURREE  

If the PC experiences a catastrophic failure (such as a power failure) while data logging, The Scan Tool 
will not be able to save the currently recording log file. 
 

 
Do NOT restart the Scan Tool. Doing so will erase the temporary cache file containing the 
data that you are trying to recover. 

Once you have rectified the problem that caused the failure, and restarted the PC, you need to locate 
EFILive’s temporary cache folder. By default it is <data_folder>\Temporary cache. In that folder will be a 
file called efi_cache.n, where n will be a digit between 0 and 9. If there is more than one efi_cache file in 
the folder then use the efi_cache files’ creation times to determine the correct file. 

Assuming the efi_cach file you want to recover is called efi_cache.0 
1. Right click on the efi_cache.0 file and select Rename. 
2. Type in a new name for the file, ending with *.efi 
3. Copy the file from the Temporary cache folder to the Logged data folder. 
4. Restart the Scan Tool and load the renamed file – file should be recovered to the point at which 

the failure occurred! 
 

 
If the PC is using a FAT16 or FAT32 file-system (normally used on Win95, Win98 and 
WinMe), then the efi_cache file may be corrupted. If the efi_cache file has been corrupted 
then you will probably not be able to recover it. 

If the PC is using an NTFS file system (normally used on WinNT, Win2K and WinXP), then 
there is a much less chance of corruption of the efi_cache file. 

To determine what file-system type the PC is using right click on the disk drive (that hosts 
the <data_folder>\Temporary cache folder) in Windows Explorer and select Properties. 
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AAPPPPEENNDDIIXX--EE  

SSCCAANN  MMOODDEESS  

PIDs and Channels 

PID data values are transmitted from the PCM to the Scan Tool in messages. Messages are made up of 
between 4 and 12 bytes. (In computer terms, a byte is a number between 0 and 255.) Some PIDs’ 
values cannot be represented by a value in the range 0 to 255, so some PIDs require two bytes in which 
to transmit their value. 

EFILive calls these bytes: channels. Different scan modes impose different limits of the number of 
channels of data that can be transmitted. 

 

General  

General-purpose scan mode logs single PIDs and is supported by all OBD II compliant vehicles. Use this 
mode if you want to scan data from a vehicle that does not support the other, faster scan modes. 

All selected PIDs are requested sequentially, using a request/response strategy. 

In all but a few cases, this scan mode will be the slowest. However, if you have only one or two PIDs 
selected, then Single PID scanning will be faster than any other method. 
 

 
The maximum number of channels that can be requested per frame, using Single PID scan 
mode, is 96 channels. 

 

Dynamic 

Dynamic scan mode uses a compression strategy that packs 6 channels of PID data into a single 
request/response pair of messages, called a dynamic packet. This makes the dynamic scan mode up to 
6 times faster than Single PID scanning when multiple (or more than 6) channels are selected. 

The Scan Tool takes this compression one step further and can request up to 6 dynamic packets per 
request (giving a total of 36 channels). 
 

 
The maximum number of channels that can be requested per frame, using Dynamic scan 
mode is: 

 36 channels of priority 1 PIDs. 

 Plus, between 6 and 30 channels of priority 2 PIDs. 

 Plus, between 6 and 30 channels of priority 3 PIDs. 

The maximum number of priority 2 and 3 channels is determined by how many dynamic 
packets the PCM supports and how you have allocated those dynamic packets here: 

Properties->Logging->Priority 2 dynamic packets->Packets 
Properties->Logging->Priority 3 dynamic packets->Packets 

 

Streaming (Slow and Fast) 

These modes are defined in the SAE J2190 specification but are implemented by the GM PCMs in a 
manufacturer specific manner. (That is why, in previous versions of EFILive, this scan mode was called 
GM Fast Dynamic.) 
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When using Stream-Slow scan mode the PCM transmits 24 channels of PID data at 4 or 5 frames per 
second. 

When using Stream-Fast scan mode the PCM transmits 24 channels of PID data at 8 or 10 frames per 
second. 

These modes have been specifically designed into the PCM, to provide the best compromise between 
logging speed, and class-2 network bandwidth usage. 
 

 
The maximum number of channels that can be requested per frame, using the Stream 
scan modes is 24 channels. 
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Data Logging Speed 

Depending on the number of channels and the scan mode selected, the Scan Tool will log data at 
different speeds.  

The following two charts show the logging speed difference between different types of computers. Both 
tests used the AT1 V2.x interface at 115200 baud. The PCM was not attached to a class-2 network. 

 

Windows 2000, 1.5 GHz Pentium III 

 

Windows 98, 133MHz Pentium MMX 
(These figures were obtained while viewing the [OBD II (F7)] tab page while data logging) 

 Slower baud rates will produce slower scan speeds. 

 AutoTap V1.x interface only supports 19200 baud rate and will be slower. 

 Slower PC’s may not be able to achieve these scan speeds. 

 PC’s faster than 1GHz will not produce noticeably faster scan rates than those shown in the first 
chart. 

 Single PID and Dynamic scan modes may experience a slight slow-down, due to other nodes’ traffic 
on the class-2 network. 
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AAPPPPEENNDDIIXX--FF  

GGMM  DDRRIIVVEE  CCYYCCLLEE  

General Motors' OBD-II driving cycle  

A complete driving cycle should perform diagnostics on all systems. A complete driving cycle can be 
done in under fifteen minutes.  

To perform a GM OBD II driving cycle, do the following: 

 Cold Start. In order to be classified as a cold start, the engine coolant temperature must be 
below 50°C (122°F) and within 6°C (11°F) of the ambient air temperature at start-up. Do not 
leave the key on prior to the cold start or the heated oxygen sensor diagnostic may not run. 

 Idle. The engine must be run for two and a half minutes with the air conditioner on and rear 
defroster on. The more electrical load you can apply the better. This will test the O2 heater, 
Passive Air, Purge "No Flow", Misfire and if closed loop is achieved, Fuel Trim. 

 Accelerate. Turn off the air conditioner and all the other loads and apply half throttle until 
88km/hr (55mph) is reached. During this time the Misfire, Fuel Trim, and Purge Flow diagnostics 
will be performed. 

 Hold Steady Speed. Hold a steady speed of 88km/hr (55mph) for 3 minutes. During this time 
the O2 response, air Intrusive, EGR, Purge, Misfire, and Fuel Trim diagnostics will be performed. 

 Decelerate. Let off the accelerator pedal. Do not shift or touch the brake or clutch. It is important 
to let the vehicle coast along gradually slowing down to 32km/hr (20 mph). During this time the 
EGR, Purge and Fuel Trim diagnostics will be performed. 

 Accelerate. Accelerate at 3/4 throttle until 88-96 km/hr (55-60mph). This will perform the same 
diagnostics as in step 3. 

 Hold Steady Speed. Hold a steady speed of 88km/hr (55mph) for five minutes. During this time, 
in addition to the diagnostics performed in step 4, the catalyst monitor diagnostics will be 
performed. If the catalyst is marginal or the battery has been disconnected, it may take 5 
complete driving cycles to determine the state of the catalyst. 

 Decelerate. This will perform the same diagnostics as in step 5. Again, don't press the clutch or 
brakes or shift gears. 

© General Motors Corporation 
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AAPPPPEENNDDIIXX--GG  

HHOOWW  TTOO  OOPPTTIIMMIIZZEE  DDAATTAA  LLOOGGGGIINNGG    

If you have a slow PC (less than 500MHz) you may need to optimize the Scan Tool to obtain the best 
scan speeds. The following is a list of settings that you can configure to help speed up data logging. 

1. Display the [OBD II (F7)] tab page while logging data. 
By not displaying data, dashboards or the console during data logging, the load on the PC’s CPU is 
greatly reduced. This is by far the best way to speed up data logging. 
 

2. If you need to watch the data while recording, then display the [Data (F8)] tab page, or 
a. Only have three or four gauges visible in the virtual dashboard. 
b. Configure gauges as digital gauges instead of analog. 
c. Don’t use auto size fonts in dashboard items. 
d. Only have one or two charts visible in the virtual dashboard. 
e. Zoom charts in so that less data points are plotted on the screen. 
f. Increase the following settings: 

Properties->Playback->Charts->Update frequency. 
Properties->Playback->Gauges->Update frequency. 
 

3. Turn off console display by unchecking: 
Properties->Console->Message display->Console display enabled. 
 

4. Unselect calculated PIDs while data logging. Calculated PIDs may be added and/or removed once 
data logging is complete. 
 

5. Use Stream scan modes where supported. 
 

 
Display the Profiler window, which shows the scan speed and dropped frame counts to 
measure the effectiveness of different settings. 

 
View->Profile window 

 
Ctrl+Y 

 

See also: Appendix-E Scan mode
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INDEX 

3 

3-2 control solenoid, 146 

4 

4wd, 138 

5 

5V A/D input voltages, 53 

A 

ABS, 170 
adaptive spark, 14 
Adobe Acrobat, 55 
advanced, 169 
AIR, 145 
air conditioner clutch, 145 
Air Fuel Ratio, 148 
air injection reaction. See AIR 
AKA, 170 
ALDL, 170 
Allison calibration data 

miscellaneous calibration details, 143 
Allison control panel, 154 
Appendix-A, 170 
Appendix-B, 177 
Appendix-C, 182 
Appendix-D, 183 
Appendix-E, 184 
Appendix-F, 187 
Appendix-G, 188 
aspect ratio, 161 
ATU. See requirements:OBD II cable 
ATUSB, 156 
auto size, 161 
AutoTap, 21, 156, 186 

B 

bidirectional controls 
Allison, 154 

bidirectional controls, 10, 16, 30, 32, 52, 170 
disable, 148, 155 
LS1/LS6, 144 

bit, 170 
bitmap image, 170 
Black box logging, 109 
black-box logging, 53 
bmp, 133 
body controllers, 63 
byte, 170 

C 

CAA, 170 

calibrate, 53 
Calibrating, 105 
California 

Air Resources Board, 9 
Clean Air Act, 9 
Highway Patrol, 9 
Motor Vehicle Pollution Control Board, 9 

CAN, 170 
CARB, 70, 171. See California Air Resources 

Board 
carburettor, 11 
channels, 73, 75, 78, 79, 158, 175, 184, 185, 186 
chart inspector, 50, 100, 171 
charts, 126, 171 

re-plot, 100 
chassis controllers, 63 
choke, 11 
Chrysler. See DaimlerChrysler 
class A network, 171 
class B network, 171 
class C network, 171 
class-2, 171 
closed loop, 11, 145 
cold starts, 11 
COM, 171 

port, 156 
combustion, 12 
comma separated values. See csv 
component ID's, 67 
configuration. See properties 
connect, 171 

automatic, 157 
connect to vehicle, 30 
connected, 28 
console, 84, 171 

saving text, 84 
Console (F12), 84 
conventions, 17 
corrupt, 183 
CPU, 171 
crank 

position sensor, 52 
crank position sensor relearn, 152 
crop, 102 
cruise control inhibit, 145 
csv, 114, 171 
customer data. See vehicle and customer data 
cylinder balance test, 150 

D 

DaimlerChrysler, 74 
damp(). See PIDs:functions 
dashboard, 118 

aspect ratio, 49, 161 
configuring, 116 
lock, 49, 118 
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locked, 117 
moving and resizing items, 117 
notes, 49 
overlapping items, 80 
Page-A, 80 
Page-B, 81 
Page-C, 82 
resize, 49 
theme, 116 
tile charts, 50 

Dashboard (F10), 80 
dashpage 

configuring, 116 
Data (F9, 77 
data logging 

pause, 98 
stop, 99 

data logging and playback, 98 
DB9, 171 
delete, 102 
desktop PC, 74 
diagnostic trouble codes, 61. See DTC 
dialogs, 160 
diff ratio, 138 
disconnect from vehicle, 32 
disconnected, 28 
displacement(). See PIDs:functions 
DMA parameters, 16 
drive cycle 

GM, 187 
drive-by-wire, 172 
DTC, 70, 169, 172 

freeze frame, 70 
immature, 169 
old, 169 
pending, 70 
understanding, 72 

duty cycle, 12 
dx(). See PIDs:functions 
dynamic packets 

maximum, 62, 79 
priority 2, 158 
priority 3, 158 

E 

ECM, 172 
EFILive 

starting, 28, 29 
what is, 10 

Electric Vehicle Energy Transfer System, 63 
emissions, 14 

rural acid rain, 9 
stratospheric ozone, 9 
toxic air pollutant, 9 
urban ozone, 9 

emissions controls 
catalytic converter, 15, 68 
evaporative system, 68 
on-board computer systems, 9 
positive crankcase ventilation, 9 

engine size, 138 
enhanced 

parameters, 16 
EOBD, 172 
error report 

how to generate, 18, 43 
errors, 84 
evaporative canister purge, 145 
exit from the Scan Tool, 32 
exp(). See PIDs:functions 
export 

data, 114 
layout, 114 
rename PIDs, 115 

F 

fan type, 141 
fan1 on/off, 141 
fan2 on/off, 141 
FAQ, 172 
FF, 172 
file formats, 182 
filename template, 167 
filters, 85 
Filters 

properties, 86 
FlashScan, 21, 103, 106 
flicker, 80 
folders, 166 
font 

application wide, 162 
Ford, 74 
forum, 55 
frame, 172 
frame(). See PIDs:functions 
frames 

crop, 102 
delete, 102 
dropped, 172 
per second, 47 
selected, 102 

freeze frame. See FF 
fuel injectors, 12 
fuel pump, 145 
fuel trim, 145 

clearing learned, 145 

G 

gauge, 172 
gauges, 119 
gear selection, 146, 155 
GM, 172 
GM-H, 172 
gvmkg(). See PIDs:functions 
gvmlb(). See PIDs:functions 

H 

high-speed fan, 145 
Histograms, 83 
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history data. See FF 
history freeze frames, 62 
History of Automotive Emissions Controls, 9 
home page, 55 
hotkeys, 33 

Allison control panel, 39 
crank position sensor relearn, 40 
cylinder balance test, 40 
dashboard, 35 
idle air control, 40 
LS1 control panel, 37, 38 
main display, 33 
map, 35 
record/playback, 36 

hysteresis, 137 

I 

IAC, 173 
icon, 173 
idle control, 149 
iff(). See PIDs:functions 
imperial, 75 
information and warnings, 84 
injector pulse width, 12 
introduction, 9 
ISO, 173 
Issue date, 57 

J 

jpg, 133 

K 

Key, 57 
knock sensor 

failures, 140 

L 

LEDs, 103, 106 
license, 56 
license key, 57 
log(). See PIDs:functions 
log10(). See PIDs:functions 
logging 

monitor, 31 
optimizing, 188 
pause, 31 
recording, 31 
speed, 186 
stop, 31 

Logging external data, 104, 107 
long term fuel trim, 12 
lookup(). See PIDs:functions 
low-speed fan, 145 
LS1, 173 
LS1/LS6 calibration data 

long term fuel trim cells, 136 
miscellaneous calibration details, 138 

LS1/LS6 control panel, 144 

LS6, 173 
luxury, 63 

M 

MAF, 173 
failures, 140 
rational tests, 140 

main window, 58 
manufacturer enhanced 

LS1, 16 
LS6, 16 

MAP, 173 
maps 

configuring, 128 
Maps, 83 
Maps (F11), 83 
menu, 41 

Allison bidirectional, 52 
charting, 50 
edit, 45 
file, 41 
FlashScan, 53 
help, 55 
info, 48 
LS1, 51 
LS1/LS6 bidirectional, 52 
view, 75 
window, 54 

menu and toolbars, 58 
message 

poll priority, 169 
throttle, 169 

meta data, 159 
metric, 75 
MHz, 173 
Microsoft Excel, 43, 114, 115, 137, 138, 143, 171 
MIL, 144, 154, 173 
Millisecond, 174 
modifications, 14 
MODs. See modules 
modules, 63 

ID, 63 
undetected, 64 

N 

non-continuously monitored systems. See 
specifically monitored systems 

notes, 168 

O 

O2 
sample output, 69 
test results, 69 

O2 sensor tests, 61 
o2 sensors, 139 
OBD, 139, 174 
OBD I, 15, 174 

problems, 15 
what is, 15 
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OBD II, 15, 174 
goals, 15 
location of connector, 23 
standards, 16 
warranty, 15 
what is, 15 

OBD II (F7), 61 
octane, 14 
on board diagnostics, 61 
onboard computer systems, 63 
open loop, 11 
operating system software number, 65 
oxygen sensors, 12 

P 

parameters. See PIDs 
PCM, 65, 174 
performance, 63 
PIDs, 73, 89, 174, 184 

calculated, 41, 90, 170 
Common, 73 
current data values, 77 
DMA, 89, 172 
enhanced, 89, 172 
finding, 75 
functions, 93 
generic, 89, 172 
invalid, 74 
linked to dashboards, 160 
N/A, 78 
naming convention, 74 
nested, 91 
Operators, 92 
priority, 77, 78 
saving, 76 
selecting, 73, 75 
short descriptions, 160 
show or hide unsupported, 74 
strikeout, 160 
supported, 61 
unsupported, 74 
validated, 74 

PIDs (F8), 73 
pivot tables, 83 
playback, 100. See data logging and playback 

gauges, 164 
pause or resume, 101 
realtime, 98 
speed, 164 

pow(). See PIDs:functions 
power failure, 183 
powertrain control module. See PCM 
powertrain controllers, 63 
pressure control solenoid, 147 
printing, 165 

white background, 165 
privacy, 96 
profiler, 174 
profiler window, 47 
properties, 156, 174 

revert to default, 156 
PTC, 174 
PWM, 174 

R 

RAM 
failures, 142 

raw(). See PIDs:functions 
recovering a log file, 183 
registering the interface, 30 
Registering Your Interface Cable, 56 
reports 

customizing, 135 
generating, 132 
printing, 132 
viewing, 133 

requirements, 19 
OBD II cable, 21 
pc/laptop, 19 
vehicle, 22 

reverse inhibit, 147 
ROM 

checksums, 142 
failures, 142 

RPM, 174, 175 
RS232, 175 

S 

SAE, 175 
SAE compliance, 177 

SAE J1962, 181 
SAE J1978, 177 
SAE J1979, 178 

safety, 63 
scan mode, 77, 78, 158, 184 

dynamic, 184 
Fast, 184 
general, 184 
GM Fast Dynamic, 184 
Slow, 184 
Steam-Fast, 158 
Stream, 73 
Stream-Fast, 62 
Stream-Fast, 175 
Stream-Slow, 62 
Stream-Slow, 175 
Stream-Slow, 158 

scan tool 
generic, 10 

screen displays, 58 
Serial number, 56 
setup guide, 23 
short term fuel trim, 12 
SI. See metric 
skip shift, 144, 147 
SLOT, 175 
SMS, 61, 67 
snapshot. See FF 
spark advance 



EFILive V7 Scan Tool for GM Vehicles 

support@efilive.com - 193 - www.efilive.com 

absolute, 148 
delta, 148 

spark knock, 13 
specifically monitored systems. See SMS 
speed limiter, 138 
sqrt(). See PIDs:functions 
SRS, 175 
SRT, 66 

not ready, 66 
ready, 66 

standards 
ISO 14230-4, 173 
ISO 15765-4, 173 
ISO 9241-2, 173 
KW2000, 173 
SAE J1850, 175 
SAE J1930, 175 
SAE J1962, 175 
SAE J1978, 175 
SAE J1979, 175 
SAE J2012, 175 
SAE J2190, 175 
SAE J2284, 175 

status, 123, 176 
status bar, 60, 78 
Status Information, 103, 106 
summary, 61, 79 
support 

contacting EFILive, 18 
EFILive user’s forum, 18 

system readiness test, 61 
system readiness tests. See SRT 

T 

tab page, 59, 176 
test ID's, 67 
time(). See PIDs:functions 
toolbars, 47 
torque converter clutch, 146 
TP, 176 
transmission, 138 

automatic or manual, 29 
tuning tool, 10 
Tutorials, 20 

U 

units, 78 
USB, 27, 176 
USFCAA, 176 

V 

value(). See PIDs:functions 
vehicle and customer data, 95 
Vehicle Calibration data, 136 
verification, 112 
Verifying FlashScan V1’s memory, 112 
version 

displaying, 18 
downloading the latest, 18 

VIN, 176 
privatize, 160 

VPW, 176 

W 

Wide band O2, 108 
Window sizing, 54 
wmf, 133 

X 

X-Axis, 126, 176 

Y 

Y-Axis, 176 
Y-Axis, 126 

Z 

ZIP, 176 

 


